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Executive Summary

Increasingly, healthcare delivery organizations (HDOs) are relying on telehealth and remote patient
monitoring (RPM) capabilities to treat patients at home. RPM is convenient and cost-effective, and since
the onset of the COVID-19 pandemic, its adoption rate has rapidly increased. Without adequate
privacy and cybersecurity measures, however, unauthorized individuals may expose sensitive data or
disrupt patient monitoring services. In collaboration with industry partners, the National Cybersecurity
Center of Excellence (NCCoE) built a laboratory environment to demonstrate how HDOs can implement
cybersecurity and privacy controls to enhance telehealth RPM resiliency.

RPM solutions engage multiple actors as participants in a patient’s clinical care-HDOs, telehealth
platform providers, and the patients themselves. Each participant uses, manages, and maintains
different technology components within an interconnected ecosystem. Each actor must be responsible
for safeguarding against unique threats and risks associated with RPM technologies within their
purview.

This practice guide assumes that the HDO engages with a telehealth platform provider that is a separate
entity from the HDO and patient. The telehealth platform provider manages a distinct infrastructure,
applications, and set of services. The telehealth platform provider coordinates with the HDO to
provision, configure, and deploy the RPM components to the patient home and assures secure
communication between the patient and clinician.

Patients and patient families are involved in this ecosystem. The patient will receive equipment that may
include biometric devices, a communications device (tablet or mobile phone), or workstations from the
telehealth platform provider. While the telehealth platform provider manages the equipment, the
patient may need to provide internet connectivity and be responsible for physical management of the
provided equipment.

The NCCoE collaborated with healthcare, technology, and telehealth partners to build a distributed RPM
solution. The RPM solution implemented controls that safeguard the HDO environment and
documented approaches that the telehealth platform provider addresses. Telehealth platform providers
assure that RPM components are isolated within the patient home environment. The telehealth
platform provider assures end-to-end data security between the patient and the HDO.

Technology solutions alone may not be sufficient to maintain privacy and security controls on external
environments. This practice guide notes the involvement of people, process, and technology as
necessary to implement a holistic risk mitigation strategy.

This practice guide can help your organization:

= assure confidentiality, integrity, and availability of an RPM solution

NIST SP 1800-30A: Securing Telehealth Remote Patient Monitoring Ecosystem 1
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= enhance patient privacy
=  |imit HDO risk when implementing an RPM solution

While the NCCoE used a suite of commercial products to address this challenge, this guide does not
endorse these particular products, nor does it guarantee compliance with any regulatory initiatives. Your
organization’s information security experts should identify the products that will best integrate with
your existing tools and IT system infrastructure. Your organization can adopt this solution or one that
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and
implementing parts of a solution.

This guide contains three volumes:

e NIST SP 1800-30A: Executive Summary—-why we wrote this guide, the challenge we address, why
it could be important to your organization, and our approach to solving this challenge

e NIST SP 1800-30B: Approach, Architecture, and Security Characteristics—what we built and why,
including the risk analysis performed and the security/privacy control map

e NIST SP 1800-30C: How-To Guides—instructions for building the example implementation,
including all the details that would allow one to replicate all or parts of this project

You can view or download the guide at https://www.nccoe.nist.gov/projects/use-cases/health-
it/telehealth. Help the NCCoE make this guide better by sharing your thoughts with us as you read the
guide. If you adopt this solution for your own organization, please share your experience and advice
with us. We recognize that technical solutions alone will not fully enable the benefits of our solution, so
we encourage organizations to share lessons learned and best practices for transforming the processes
associated with implementing this guide.

To provide comments or to learn more by arranging a demonstration of this example implementation,
contact the NCCoE at hit_nccoe@nist.gov.

Collaborators participating in this project submitted their capabilities in response to an open call in the
Federal Register for all sources of relevant security capabilities from academia and industry (vendors
and integrators). Those respondents with relevant capabilities or product components signed a
Cooperative Research and Development Agreement (CRADA) to collaborate with NIST in a consortium to
build this example solution.

uhealth .Iclllslélc;' INOVA  s#logRhythm  medcrypt

EE’ Med=e 0nCIave C:) tenable () MEDICAL CENTER Vivifyhealth

Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an

NIST SP 1800-30A: Securing Telehealth Remote Patient Monitoring Ecosystem 2
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experimental procedure or concept adequately. Such identification is not intended to imply special
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it
intended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

The NCCoE, a part of NIST, is a collaborative hub where industry

organizations, government agencies, and academic institutions work Visit https://www.nccoe.nist.gov
together to address businesses’” most pressing cybersecurity challenges. nccoe@nist.gov
Through this collaboration, the NCCoE develops modular, adaptable 301-975-0200

example cybersecurity solutions demonstrating how to apply standards
and best practices by using commercially available technology.
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Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it
intended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

National Institute of Standards and Technology Special Publication 1800-30B, Natl. Inst. Stand. Technol.
Spec. Publ. 1800-30B, 129 pages, (November 2020), CODEN: NSPUE2

You can improve this guide by contributing feedback. As you review and adopt this solution for your
own organization, we ask you and your colleagues to share your experience and advice with us.

Comments on this publication may be submitted to: hit nccoe@nist.gov.

Public comment period: November 16, 2020 through December 18, 2020

As a private-public partnership, we are always seeking feedback on our practice guides. We are
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you
have implemented the reference design, or have questions about applying it in your environment,
please email us at hit_nccoe@nist.gov.

All comments are subject to release under the Freedom of Information Act.

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
100 Bureau Drive
Mailstop 2002
Gaithersburg, MD 20899

Email: nccoe@nist.gov
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The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and
academic institutions work together to address businesses’ most pressing cybersecurity issues. This
public-private partnership enables the creation of practical cybersecurity solutions for specific
industries, as well as for broad, cross-sector technology challenges. Through consortia under
Cooperative Research and Development Agreements (CRADAs), including technology partners—from
Fortune 50 market leaders to smaller companies specializing in information technology security—the
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity
solutions using commercially available technology. The NCCoE documents these example solutions in
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework
and details the steps needed for another entity to re-create the example solution. The NCCoE was
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County,
Maryland.

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit
https://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the
adoption of standards-based approaches to cybersecurity. They show members of the information
security community how to implement example solutions that help them align with relevant standards
and best practices, and provide users with the materials lists, configuration files, and other information
they need to implement a similar approach.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. These documents do not describe regulations
or mandatory practices, nor do they carry statutory authority.

Increasingly, healthcare delivery organizations (HDOs) are relying on telehealth and remote patient
monitoring (RPM) capabilities to treat patients at home. RPM is convenient and cost-effective, and its
adoption rate has increased. However, without adequate privacy and cybersecurity measures,
unauthorized individuals may expose sensitive data or disrupt patient monitoring services.

RPM solutions engage multiple actors as participants in a patient’s clinical care. These actors include
HDOs, telehealth platform providers, and the patients themselves. Each participant uses, manages, and
maintains different technology components within an interconnected ecosystem, and each is

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem ii
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responsible for safeguarding their piece against unique threats and risks associated with RPM
technologies.

This practice guide assumes that the HDO engages with a telehealth platform provider that is a separate

entity from the HDO and patient. The telehealth platform provider manages a distinct infrastructure,
applications, and set of services. The telehealth platform provider coordinates with the HDO to
provision, configure, and deploy the RPM components to the patient home and assures secure
communication between the patient and clinician.

The NCCoE analyzed risk factors regarding an RPM ecosystem by using risk assessment based on the

NIST Risk Management Framework. The NCCoE also leveraged the NIST Cybersecurity Framework, NIST
Privacy Framework, and other relevant standards to identify measures to safeguard the ecosystem. In
collaboration with healthcare, technology, and telehealth partners, the NCCoE built an RPM ecosystem
in a laboratory environment to explore methods to improve the cybersecurity of an RPM.

Technology solutions alone may not be sufficient to maintain privacy and security controls on external

environments. This practice guide notes the application of people, process, and technology as necessary
to implement a holistic risk mitigation strategy.

This practice guide’s capabilities include helping organizations assure the confidentiality, integrity, and

availability of an RPM solution, enhancing patient privacy, and limiting HDO risk when implementing an
RPM solution.

access control; authentication; authorization; behavioral analytics; cloud storage; data privacy; data

security; encryption; HDO; healthcare; healthcare delivery organization; remote patient monitoring;

RPM; telehealth

We are grateful to the following individuals for their generous contributions of expertise and time.
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The collaborators who participated in this build submitted their capabilities in response to a notice in

the Federal Register. Respondents with relevant capabilities or product components were invited to sign

a Cooperative Research and Development Agreement (CRADA) with NIST, allowing them to participate

in a consortium to build this example solution. We worked with:

Technology Partner/Collaborator
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This practice guide demonstrates how healthcare delivery organizations (HDOs) can implement
cybersecurity and privacy controls to enhance the resiliency of telehealth services. In collaboration with
industry partners, the National Cybersecurity Center of Excellence (NCCoE) at the National Institute of
Standards and Technology (NIST) built a laboratory environment to simulate the telehealth ecosystem
and enable remote patient monitoring (RPM) services for patients.

RPM is convenient, cost-effective, and growing, but it comes with security and privacy risks. Patient
monitoring systems are often found in healthcare facilities, in controlled environments. RPM is different
in that monitoring equipment is deployed in the patient’s home, which may not offer the same level of
cybersecurity or physical-security control to prevent misuse or compromise. Without privacy or
cybersecurity controls in place within the RPM ecosystem, patient data and the ability to communicate
with the care providers may be compromised.

This practice guide explores a situation in which a care provider prescribes deploying an RPM device to
the patient home. The RPM device captures biometric data on regular intervals, conveys the data to the
clinical care team and allows patient-clinician communication without the patient making an in-person
visit to the HDO. RPM enables care based on the patient’s needs, regardless of geographic constraints.

Capturing biometric data at regular intervals allow clinicians to have broader insight into a patient’s
condition. With larger data sets, clinicians can monitor the patient’s condition and make diagnosis and
treatment decisions with more robust information. RPM solutions allow audio and video communication
in addition to utilizing biometric data and supports the patient-clinician relationship.

Implementing an RPM ecosystem involves multiple parties and environments. In developing the
reference architecture for this practice guide, the NCCoE considered components that would be
deployed in three distinct domains that encompass the RPM ecosystem: the patient home environment,
the telehealth platform provider, and the HDO. The practice guide engaged with a telehealth platform
provider that leveraged cloud services and facilitated audio- and videoconferencing between the patient
home and the HDO. The telehealth platform provider provisioned and managed biometric devices that
were deployed in the patient home, and routed data and communication between the patient home
and the HDO.

The NCCoE built a laboratory environment to simulate the telehealth ecosystem, performed a risk
assessment, and developed an example implementation that demonstrates how HDOs can use
standards-based, commercially available cybersecurity technologies and collaborate with telehealth
platform providers to assure privacy and security biometric devices that are deployed to the patient
home.

For ease of use, the following paragraphs provide a short description of each section of this volume.

Section 1, Summary, presents the challenge addressed by the NCCoE project, with an in-depth look at
our approach, the architecture, and the security characteristics we used; the solution demonstrated to
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address the challenge; benefits of the solution; and the collaborators who participated in building,
demonstrating, and documenting the solution.

Section 2, How to Use This Guide, explains how business decision makers, program managers,
information technology (IT) professionals (e.g., systems administrators), and biometric engineers might
use each volume of the guide.

Section 3, Approach, offers a detailed treatment of the scope of the project, the risk assessment that
informed platform development, and the technologies and components that industry collaborators gave
us to enable platform development.

Section 4, Architecture, specifies the components within the RPM ecosystem from business, security,
and infrastructure perspectives and details how data and processes flow throughout the ecosystem. This
section also describes the security capabilities and controls referenced in the NIST Cybersecurity
Framework through tools provided by the project collaborators.

Section 5, Security and Privacy Characteristic Analysis, provides details about the tools and techniques
used to perform risk assessments pertaining to RPM.

Section 6, Functional Evaluation, summarizes the test sequences employed to demonstrate security
platform services, the NIST Cybersecurity Framework Functions to which each test sequence is relevant,
and the NIST Special Publication (SP) 800-53 Revision 4 controls demonstrated in the example
implementation.

Section 7, Future Build Considerations, is a brief treatment of other applications that NIST might explore
in the future to further protect a telehealth environment.

The appendixes provide acronym translations, references, a deeper dive into the threats and risks
associated with RPM, the review of the NIST Privacy Risk Assessment Methodology (PRAM), and a list of
additional informative security references cited in the framework. Acronyms used in figures and tables
are in the List of Acronyms appendix.

1.1 Challenge

A remote patient monitoring system involves deploying biometric monitoring devices in the patient
home, transmitting the biometric data collected back to the clinical team, often via a third-party
telehealth platform provider. The reliance of external entities and the interaction of devices and data
through multiple domains for the effective function of telehealth may expose the HDO and patient to
security and privacy risks.

This practice guide addresses a scenario in which the HDO engages with a telehealth platform provider,
which manages a distinct infrastructure, applications, and set of services. The telehealth platform
provider coordinates with the HDO to provision, configure, and deploy the RPM components to the
patient home and assures secure communication between the patient and clinician.

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 2
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RPM devices are deployed in a networked patient home environment. The patient may have broadband
internet connectivity, including Wi-Fi. RPM devices deployed in the patient home may include the
biometric monitoring devices, a gateway interface device (tablet or mobile phone), or workstations from
the telehealth platform provider. While the telehealth platform provider manages RPM devices, they do
not manage other communications infrastructure.

Without privacy or cybersecurity controls in place, patient data and the ability to communicate with the
care providers may be compromised.

1.2 Solution

This NIST Cybersecurity Practice Guide, Securing Telehealth Remote Patient Monitoring Ecosystem,
shows how biomedical engineers, networking engineers, security engineers, and IT professionals can
help securely configure and deploy an RPM ecosystem by using commercially available tools and
technologies that are consistent with cybersecurity standards.

The NCCoE worked with healthcare, technology, and telehealth collaborators to build a distributed RPM
solution. This practice guide implemented controls, based on the NIST Cybersecurity and Privacy
Frameworks, to safeguard the HDO, telehealth platform provider, and patient home environments. This
practice guide also documents approaches that the telehealth platform provider should address,
including assuring end-to-end data security between the patient and the HDO and that RPM biometric
components are isolated within the patient home environment.

Any organization that deploys RPM can use the example implementation, which represents one of many
possible solutions and architectures, but those organizations should perform their own risk assessment
and implement controls based on their risk posture.

Technology solutions alone may not be sufficient to maintain privacy and security controls on external
environments. This practice guide notes the application of people, process, and technology as necessary
to implement a holistic risk mitigation strategy.

1.3 Benefits

The NCCoE’s practice guide to Securing Telehealth Remote Patient Monitoring Ecosystem can help your
organization:

= assure the confidentiality, integrity, and availability of an RPM solution
= enhance patient privacy

= |imit HDO risk when implementing an RPM solution

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 3
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This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides
users with the information they need to replicate an RPM environment. This reference design is modular
and can be deployed in whole or in part.

This guide contains three volumes:

= NIST SP 1800-30A: Executive Summary

= NIST SP 1800-30B: Approach, Architecture, and Security Characteristics — what we built and why
(you are here)

= NIST SP 1800-30C: How-To Guides — instructions for building the example solution
Depending on your role in your organization, you might use this guide in different ways:
Business decision makers, including chief security and technology officers, will be interested in the
Executive Summary, NIST SP 1800-30A, which describes the following topics:

= challenges that enterprises face in securing the RPM ecosystem

= example solution built at the NCCoE

= benefits of adopting the example solution

Technology or security program managers who are concerned with how to identify, understand, assess,
and mitigate risk will be interested in this part of the guide, NIST SP 1800-30B, which describes what we
did and why. The following sections will be of particular interest:

= Section 3.4, Risk Assessment, provides a description of the risk analysis we performed

=  Section 3.5, Security Control Map, maps the security characteristics of this example solution to
cybersecurity standards and best practices

You might share the Executive Summary, NIST SP 1800-30A, with your leadership team members to help
them understand the importance of adopting standards-based commercially available technologies that
can help secure the RPM ecosystem.

IT professionals who want to implement an approach like this will find the whole practice guide useful.
You can use the how-to portion of the guide, NIST SP 1800-30C, to replicate all or parts of the build
created in our lab. The how-to portion of the guide provides specific product installation, configuration,
and integration instructions for implementing the example solution. We do not re-create the product
manufacturers’ documentation, which is generally widely available. Rather, we show how we
incorporated the products together in our environment to create an example solution.

This guide assumes that IT professionals have experience implementing security products within the
enterprise. While we have used a suite of commercial products to address this challenge, this guide does

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 4
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not endorse these particular products. Your organization can adopt this solution or one that adheres to
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing
parts of the NCCoE’s risk assessment and deployment of a defense-in-depth strategy in a distributed
RPM solution. Your organization’s security experts should identify the products that will best integrate
with your existing tools and IT system infrastructure. We hope that you will seek products that are
congruent with applicable standards and best practices. Section 3.6, Technologies, lists the products we
used and maps them to the cybersecurity controls provided by this reference solution.

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and
success stories will improve subsequent versions of this guide. Please contribute your thoughts to

hit _nccoe@nist.gov.

Acronyms used in figures are in the List of Acronyms appendix.

2.1 Typographic Conventions

The following table presents typographic conventions used in this volume.

Typeface/Symbol Meaning Example

Italics file names and path names; For language use and style guidance,
references to documents that | see the NCCoE Style Guide.

are not hyperlinks; new
terms; and placeholders

Bold names of menus, options, Choose File > Edit.
command buttons, and fields
Monospace command-line input, mkdir

onscreen computer output,
sample code examples, and
status codes

Monospace Bold command-line user input service sshd start
contrasted with computer
output
blue text link to other parts of the All publications from NIST’s NCCoE
document, a web URL, or an are available at
email address https://www.nccoe.nist.gov.

RPM is a telehealth use case wherein healthcare providers can use internet-based technologies to track
biometric data from the patient’s home. Patients may have chronic or recurring health conditions that
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require regular clinical monitoring; however, in-person visitation is impractical or undesirable.
Technology enables capturing biometric data, having that data relayed to systems that clinicians may
use to evaluate a patient; and allows bidirectional communication between the patient and clinician.
RPM may be an appropriate means for performing healthcare in pandemic scenarios or to address
patients who may live in parts of the country where healthcare settings or practitioners are scarce.

The NCCoE collaborated with a healthcare Community of Interest (COIl) that included technology and
cybersecurity vendors, healthcare cybersecurity subject matter experts, and healthcare systems to
identify RPM use cases, data workflows, actor participants, and general deployment architecture.
Further, with the assistance of the COIl and external cybersecurity subject matter experts, a risk
assessment was performed and reviewed, assuring the measures and outcomes that were determined
from the risk assessment activity.

Additionally, this project reviewed NIST SP 800-171 Rev. 1, Protecting Controlled Unclassified
Information in Nonfederal Systems and Organizations [1] , as well as NIST SP 800-181, National Initiative
for Cybersecurity Education (NICE) Cybersecurity Workforce Framework [2], for further guidance.
Organizations may refer to these documents in expanding their safeguarding environment as
appropriate. These documents serve as background for this project, with primary emphasis on the NIST
Cybersecurity Framework [3], the NIST Risk Management Framework [4] and the NIST Privacy
Framework [5].

3.1 Audience

This guide is intended for professionals implementing an RPM ecosystem for HDOs that use third-party
telehealth platform providers. This guide examines scenarios where HDOs partner with a third-party
telehealth platform provider where that telehealth platform provider manages devices that are used by
the patient in their home setting. The telehealth platform provider implements technology that collects
and makes biometric data available to clinicians, thus allowing the HDO to focus on patient care
delivery. Approaches and controls focus on securing end-to-end communications, safeguarding assets
and data that reside at HDO facilities; and discuss measures that HDOs and telehealth platform
providers should implement in the patient home.

3.2 Scope

This RPM practice guide focuses on scenarios where patients with chronic or recurring conditions have
biometric devices in their home and enables clinicians to regularly receive biometric data. Patients and
clinicians can use audio- and videoconferencing. The solution includes a third-party telehealth platform
provider that provisions and manages biometric devices and provides communications means.

3.3 Assumptions

This practice guide makes the following assumptions:

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 6
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= RPM architecture includes deploying components to three distinct domains: the patient home,
= the telehealth platform provider, and the HDO.

= HDOs are regulated entities and must comply with federal, state, and local laws and regulations.
In complying with laws and regulations, HDOs have implemented adequate privacy and security
programs that include activities to address risk to both the organization and individuals when
deploying an RPM architecture. Controls that have been implemented in accordance with laws
and regulations provide an enterprise scope that this document refers to as pervasive controls.

= The telehealth platform provider maintains an adequate privacy and security control
environment.

= The telehealth platform provider manages the configuration of patient home-deployed
equipment

= The patient home may have different communications options such as cellular data connectivity
or broadband internet.

= RPM solutions emphasize collaboration. An RPM program’s efficacy depends on the patient, the
telehealth platform provider, and the HDO to participate in the program and apply adequate
privacy and security practices. The HDO does not define the control environments for the
telehealth platform provider or the patient home. Each participant needs sufficient awareness
and exercises appropriate control over components that operate in their domain.

= Patient engagement activities provide the patient a clear understanding of privacy practices and
expectations that address the specifics of the RPM architecture.

For this practice guide, telehealth platform providers deployed biometric devices that had cellular data
capabilities and were not configured for broadband (e.g., Wi-Fi or wired networking).

3.4 Risk Assessment

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments, states that risk is “a measure of the
extent to which an entity is threatened by a potential circumstance or event, and typically a function of:
(i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of
occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and
prioritizing risks to organizational operations (including mission, functions, image, reputation),
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of
an information system. Part of risk management incorporates threat and vulnerability analyses, and
considers mitigations provided by security controls planned or in place.”

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level,
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for
Information Systems and Organizations—material that is available to the public.
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423  The Risk Management Framework (RMF) guidance, as a whole, proved to be invaluable in giving us a
424 baseline to assess risks, from which we developed the project, the security characteristics of the build,
425  and this guide.

426 In this practice guide, the NCCoE implements multiple approaches in assessing risk. An RPM

427  environment is composed of multiple domains, with different constituents managing each domain.
428  When analyzing risk, this practice guide contextualizes that risk and selects mitigating controls by

429 disrupting threats. A description of how this practice guide addresses these concepts is in Appendix C,
430  Threats and Risks.

431  3.4.1 Threats

432 NIST SP 800-30 Revision 1 defines a threat as, “... any circumstance or event with the potential to

433  adversely impact organizational operations and assets, individuals, other organizations, or the Nation
434 through an information system via unauthorized access, destruction, disclosure, or modification of
435 information, and/or denial of service.” Threats are actions that may compromise a system’s

436  confidentiality, integrity, or availability [6]. The following table describes threats that have been

437 evaluated for this project. Threats evolve, and organizations need to perform their own analysis when
438  evaluating threats and risk that the organization faces.

439  Table 3-1 below is a sample threat taxonomy as it applies across the entire RPM ecosystem. The threat
440  taxonomy uses a confidentiality (C), integrity (1), and availability (A) categorization, the threat event

441 considered, and a description of the threat event. While the threat taxonomy provides a landscape view
442 of threats, organizations may want to perform threat modeling to determine contextual application of
443  threats. Threats and Risks in Appendix C describes concepts on how to examine contextualized threats.

444  Table 3-1 Threat Taxonomy

G LA Threat Event Description

C phishing Phishing attacks are a form of social engineering, where
the attacker presents themselves as a trusted party to
gain the confidence of the victim.

I, A malicious software Malicious software (malware) is unauthorized code that
may be introduced to a system. It performs unintended
actions that may disrupt normal system function.
Malware may masquerade as desirable apps or
applications.

I, A command and control | Command and control attacks may begin with
deployment of malware. Malware may allow a system
to be operated remotely by unauthorized entities.
Should a system fall victim to a command and control
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C LA Threat Event Description

attack, that system may then be used as a pivot point
to attack other components, either within the
organization’s infrastructure or as a point where
attacks may be launched against other organizations.

A ransomware Ransomware is a form of malware that disrupts access
to system resources. A typical form of ransomware
involves the malware employing encryption that
disables a legitimate system user from accessing files.
Ransomware attacks generally involve a demand for
payment to restore files. Payment does not ensure that
the attacker will decrypt files, however.

C credential escalation | Credential escalation attacks seek to take user account
capabilities and extend those to a privileged level of
capability.

I, A operating system or The operating system or application may be adversely

application disruption | affected by malicious actors that successfully
implement malware on the target device. Data may be
altered, or the device or application may not function
properly.

C data exfiltration Malicious actors may be able to retrieve sensitive
information from vulnerable devices. Malware may be
used for this purpose.

A denial of Service Flooding network connections with high-volume traffic
Attack to disrupt communication in patient home, between
home and telehealth platform, or between telehealth
platform provider and HDO. Such type of attack could
also be used to damage a device, e.g., though
accelerated battery depletion.

I transmitted data Unauthorized individuals may intercept and alter data
manipulation transmissions.

3.4.2 Vulnerabilities

This practice guide uses a customized application for identifying vulnerabilities, which aggregates
vulnerabilities identified in NIST SP 800-30 Revision 1. As noted in this special publication, a vulnerability
is a deficiency or weakness that a threat source may exploit, resulting in a threat event. The document
further describes how vulnerabilities may exist in a broader context, i.e., that they may be found in
organizational governance structures, external relationships, and mission/business processes. The table
in Section C-6 of Appendix C, Threats and Risks, enumerates those vulnerabilities using a holistic

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 9
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452  approach and represents those vulnerabilities that this project identified and for which it offers
453 guidance.

454  3.4.3 Problematic Data Actions for Privacy

455  This build considered operational activities of the example solution that interact with patient data
456  during RPM processes (“data actions”) and identified those that potentially cause problematic data
457 actions.

458  The NIST Privacy Framework defines a problematic data action as “a data action that could cause an
459  adverse effect for individuals” [5]. Problematic data actions can result in privacy risk to individuals and
460  prevent an organization from developing a solution that meets the privacy engineering objectives of
461 predictability, manageability, and disassociability. Table 3-2 below describes problematic data actions
462  that have been evaluated for this project. Organizations need to perform their own analysis when
463 evaluating problematic data actions and risk that the organization and patients face.

464  Table 3-2 below demonstrates the problematic data action taxonomy identified for the entire RPM

465  ecosystem. This Problematic Data Action Taxonomy uses a predictability (P), manageability (M), and

466  disassociability (D) designation; the problematic data action considered; and the description of the

467  problematic data action. While the Problematic Data Action Taxonomy provides a landscape view of
468 problematic data action, an organization may want to perform a risk assessment to determine

469  contextual application of the problematic data action. The Problematic Data Actions and Risks discussion
470 in Appendix D introduces the PRAM [7] and provides a more detailed analysis.

471  Table 3-2 Problematic Data Action Taxonomy

Problematic Data Description

Action

P, M distortion Inaccurate or misleadingly incomplete data are used or
disseminated. Distortion can present users in an
inaccurate, unflattering, or disparaging manner,
opening the door for stigmatization, discrimination, or
loss of liberty.

RPM context: Incorrect or unintended use of biometric

devices may introduce data quality issues into the RPM

environment, resulting in inaccurate or incomplete data
being used to make decisions regarding patient care.

M insecurity Lapses in data security can result in various problems,
including loss of trust, exposure to economic loss and
other identity theft-related harms, and dignity losses.

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 10
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Problematic Data Description

Action

RPM context: Biometric data and patient health
information flows through various entities in the RPM
solution, each of which plays a role in protecting the
information.

D, M reidentification De-identified data, or data otherwise disassociated
from specific individuals, becomes identifiable or
associated with specific individuals again. It can lead to
problems such as discrimination, loss of trust, or dignity
losses.

RPM context: Disassociated processing is intentionally
used during some dataflows within the RPM solution to
mitigate the risk of exposing identifiable patient
information to vendors, administrators, and other
practitioners that are outside of the patient’s care

team.
P, M unanticipated Data reveals or exposes an individual or facets of an
revelation individual in unexpected ways. Unanticipated

revelation can arise from aggregation and analysis of
large and/or diverse data sets. Unanticipated revelation
can give rise to dignity losses, discrimination, and loss
of trust and autonomy.

RPM context: Using one or more biometric devices can
indicate potential health problems for which a patient
is being monitored to others beyond the patient’s
healthcare provider.

472  This build considered operational activities of the example solution that interact with patient data
473  during RPM processes (“data actions”) and identified those that potentially cause Problematic Data
474 Actions.

475  This practice guide used the NIST PRAM [7] and accompanying Catalog of Problematic Data Actions and
476 Problems [8] to conduct this analysis. Table 3-2, Problematic Data Action Taxonomy, provides the results
477  of this analysis. See Appendix D for additional considerations regarding examples of problematic data
478  actions for RPM solutions.

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 11
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3.4.4 Risk

As noted in Section 3.4, NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments, defines risk
as “a measure of the extent to which an entity is threatened by potential circumstance or event, and is
typically a function of: (i) the adverse impacts that would arise if the circumstance or event occurs; and
(i) the likelihood of occurrence” [9].

Risk is the adverse impact; that is, risk is the result when a threat (attack) successfully leverages one or
more vulnerabilities. As organizations consider risk, they should note that risk is not discrete; that is, one
may realize multiple risks based on a successful attack. Notwithstanding, we consider those risks
identified below. In reviewing these risks, please note that we consider unique scenarios that presume
certain attack types for the two risks categorized as availability risks, those being ransomware and pivot
point attacks.

Table 3-3, Cybersecurity Risk Taxonomy describes high-level cybersecurity risks that affect the RPM
environment. The risk taxonomy table captures key risks, assigning where the risk may impact the
organization across a confidentiality, integrity, and availability (CIA) [6] dimension.

Table 3-3 Cybersecurity Risk Taxonomy

Description Risk Level
C fraudulent use | Health-related information may be used for medium
of health- several different fraudulent means, such as
related identity theft, insurance fraud, or extortion.
information
I patient Unavailability or significant delay in delivering medium
diagnoses biometric data may negate the benefits of
disrupted remote patient monitoring. Clinicians may not
based on be able to provide appropriate care should
timeliness biometric data transmission be disrupted.
disruption,
leading to
patient safety
concerns
I incorrect A critical patient event is missed due to changes | high
patient in the data stream between device and HDO.
diagnosis due
to change of
data

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 12
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Description Risk Level

A process Ransomware may prevent normal device high
disruption due | operations. Data may be irretrievable and
to ransomware | therefore, may prevent clinical care.

I, A systemic Disruptions to the system that affect its high
disruption due | availability or integrity may compromise the
to component | benefits derived from remote patient

compromise monitoring.
I clinician If data are altered inappropriately, clinicians high
misdiagnosis may make inaccurate diagnoses, resulting in

patient safety issues.

494

495  Table 3-4, Privacy Risk Taxonomy, describes high-level privacy risks that affect the RPM environment.
496  Table 3-4 captures key risks, assigning where the risk may impact individuals, in the areas of

497  predictability, manageability, and disassociability [5]. Privacy risk levels to individuals depend on the
498 context of specific RPM solution deployment and are not included.

499  Table 3-4 Privacy Risk Taxonomy

Problematic Data Action

M Unauthorized individuals | Insecurity: Data not protected at rest or in transit.
may access data on
devices

P,M Biometric device types Unanticipated revelation: Biometric device types can indicate
can indicate patient patient health problems individuals would prefer not to
health problems that disclose beyond their healthcare provider.

individuals would prefer
not to disclose beyond
their healthcare provider

P, M Incorrect data capture of | Distortion: Device misuse may cause failure to monitor
readings by devices may | patients in accordance with their healthcare plan.
impact quality of patient

care

D, M Aggregated data may Re-identification: Associating biometric data with patient
expose patient identifiers can expose health conditions.
information

P, M Exposure of patient Unanticipated Revelation: Data sharing across parties can
information through increase the risk of exposure due to confidentiality-related

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 13
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Problematic Data Action

multiple providers of incidents, which can reveal patient health information in ways
system components or to parties that the individual may not expect.

3.4.5 Mitigating Risk

As noted above, risk is the adverse outcome when a threat successfully leverages a vulnerability.
Mitigating risk may take many different forms. This practice guide addresses risk by performing a threat
modeling exercise and by mitigating threats. The previous sections discussed threat from a holistic
perspective. That is, the noted threats enumerate a broad survey of attack types that may adversely
affect the RPM ecosystem. RPM decomposes to the following three distinct domains: patient home,
telehealth platform provider, and HDO. As organizations consider measures to disrupt threats and
adverse actions made against the ecosystem, an opportunity exists where organizations examine threats
to identify controls that mitigate adverse actions identified by threat modeling.

3.5 Security Control Map

As this practice guide considered RPM ecosystem risks, the team performed a mapping to the NIST
Cybersecurity Framework [3]. This mapping established an initial set of appropriate control Functions,
Categories, and Subcategories, demonstrating how selected Cybersecurity Framework Subcategories
map to controls in NIST SP 800-53 Revision 4 [10], as well as to the NIST NICE Framework, NIST SP 800-
181 [2]. The table also lists sector-specific standards and best practices from other standards bodies
(e.g., the International Electrotechnical Commission [IEC], International Organization for Standardization
[1SO]), as well as the Health Insurance Portability and Accountability Act (HIPAA) [11], [12], [13]. The
security control map, shown in Table 3-5, identifies a set of controls, including those specifically
implemented in the lab build, as well as the pervasive set of controls as described in Section 5.2,
Pervasive Controls, that HDOs should deploy. Practitioners should refer to NIST SP 1800-24, Securing
Picture Archiving and Communication System (PACS), Appendix C for further description of pervasive
controls [14].

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 14
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522  Table 3-5 Security Characteristics and Controls Mapping—NIST Cybersecurity Framework

Function Category

Asset
Management
(ID.AM)

IDENTIFY
(ID)

NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices
NIST SP Framework .
Revision4 800-181) 80001-2-2 | Rule 27001
45 C.F.R. §§
ID.AM-1: Physical 164.308(a)(1)(ii)(A)
devices and systems CM-8 N/A 12223:82;‘;2::;23 A8.1.1
within the organization PM-5 164.308(b) A.8.1.2
are inventoried 164.310(d)
164.310(d)(2)(iii)
ID.AM-2: Software
platforms and CM-8 45 C.F.R. 8§ A8.1.1
applications within the PVLLS 164.308(a)(1)(ii)(A) | A.8.1.2
organization are 164.308(a)(7)(ii)(E) | A.12.5.1
inventoried
45 C.F.R. §§
164.308(a)(4)(ii)(A)
ID.AM-4: External 164.308(b)
information systems are | AC-20 164.314(a)(1) A11.2.6

catalogued SA-9

164.314(a)(2)(i)(B)
164.314(a)(2)(ii)
164.316(b)(2)

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem
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NIST Cybersecurity Framework v1.1

Function

Sector-Specific Standards and Best Practices

NIST NICE
NIST SP Framework .
Category Subcategory 800-53 (NIST sP :i)((:);l:_ . ::::eAA Security IZS7C()){)I:ILEC
Revision 4 800-181)
ID.AM-5: Resources (e.g.,
’ L RA-2 45 C.F.R. §§
software) arg prioritized SA-14 CO-0PL-001 164.308(2)(7)(ii)(E) A8.2.1
based on their SC-6
classification, criticality,
and business value
CA-2
MLDP
CA-7 AN-ASA-001 | oo 45 C.F.R. §§
ID.RA-1: Asset Eﬁ:i AN-ASA002 | sGup 164.308(a)(1)(i)

A AN-TWA- 164.308(a)(1)(ii)(A)
vulnerabilities are RA-5 001 164.308(a)(1)(ii)(B) A.12.6.1
identified and SA-5 ' .. A.18.2.3

CO-CLO-002 164.308(a)(7)(ii)(E)
) documented SA-11 164.308(2)(8)

Risk SI-2 CO-0PS-001 164.310 .

Assessment Sl-4 SP-ARC-001 .310(a)(1)

(ID.RA) SIS

RA-2 AN-ASA-001 45 C.FR. §§

ID.RA-4: Potential RA-3 AN-ASA-002 | 164.308(a)(1)(i) A.16.1.6
business impacts and SA-14 AN-EXP-001 SGUD 164.308(a)(1)(ii)(A) | Clause
likelihoods are identified | PM-9 AN-LNG-001 164.308(a)(1)(ii)(B) | 6.1.2

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem
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NIST Cybersecurity Framework v1.1

Function

Category

Sector-Specific Standards and Best Practices

NIST NICE
Slsera :(I)ZTSS: ::m:-\resv:l)ork IECTR HIPAA Security ISO/IEC
Revision 4 800-181) 80001-2-2 | Rule 27001
AN-TGT-002 164.308(a)(7)(ii)(E)
AN-TWA- 164.308(a)(8)
001
CO-CLO-001
CO-CLO-002
CO-OPL-001
CO-OPL-002
45 C.F.R. §§
ID.RA-5: Threats, 164.308(a)(1)(ii)(A)
vulnerabilities, RA-2 164.308(a)(1)(ii)(B)
likelihoods, and impacts | RA-3 SP-SYS-001 SGUD 164.308(a)(1)(ii)(D) | A.12.6.1
are used to determine PM-16 164.308(a)(7)(ii)(D)
risk 164.308(a)(7)(ii)(E)
164.316(a)
. 45 C.F.R. §§
e et | P4 sP-sys-001 | DTOK 164.308(a)(1)(ii}(B) | Clause
PM-9 SGUD 164.314(a)(2)(i)(C) 6.1.3

prioritized

164.314(b)(2)(iv)

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem

17



DRAFT

NIST Cybersecurity Framework v1.1

Function Category

Identity
Management,
HNONIIgIN Authentication
(PR) and Access
Control
(PR.AC)

Sector-Specific Standards and Best Practices

NIST NICE
NIST SP Framework .
gy oovn s (R
Revision4 800-181)
A9.2.1
) .. IA-2 45 C.F.R. §§
Credontiols e ooved, | 143 ALOF | 164.308(I3IE) | 307
i ! IA-4 AUTH 164.308(a)(3)(ii)(C) DN
managed, verified, OM-ADM- . A9.2.4
. IA-5 EMRG 164.308(a)(4)(i)
revoked, and audited for 001 . A.9.2.6
authorized devices, users IA-6 NAUT 164.308(a)(4)(ii)(B) A9.3.1
and brocesses ! IA-7 PAUT 164.308(a)(4)(ii)(C) A.9.4.2
P IA-8 164.312(a)(2)(i) o
A9.4.3
IA-9
IA-10
IA-11
A11.1.1
PE-2 45 C.F.R. §§ 2111;
PE-3 164.308(a)(1)(ii)(B) A.11.1.4
PR.AC-2: Physical access PE-4 PLOK 164.308(a)(7)(i) A'11.1.5
to assets is managed and PE-S OM-ADM- TXCF 164.308(a)(7)(ii)(A) A'11.1.6
protected 001 TXIG 164.310(a)(1) e
PE-6 . A11.2.1
PE-S 164.310(a)(2)(i) A1123
164.310(a)(2)(ii) e
A.11.2.5
A.11.2.6

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem

18



DRAFT

NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices
NIST SP Framework .
Function Category Subcategory 800-53 (NIST sP ISEOi)le‘ . ::LAA Security IZS7C()){)I:ILEC
Revision 4 800-181) -
A.11.2.7
A.11.2.8
45 C.F.R. §§
A | 16a308@)a)) | A621
) AC-17 164.308(b)(1) A.6.2.2
iF; Rrﬁ;j':;m"te aceess 1 ac19 OM-ADM- (E:iAURPG 164.308(b)(3) A11.2.6
8 AC-20 001 NAUT 164.310(b) A13.1.1
SC-15 PAUT 164.312(e)(1) A.13.2.1
164.312(e)(2)(ii)
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NIST Cybersecurity Framework v1.1

Sector-Specific Standards and Best Practices

NIST NICE
Framework
Subcategory zégsip (NIST SP IECTR | HIPAA Security ISO/IEC
Revision4 800-181) 80001-2-2 | Rule 27001
AC-1
PR.AC-4: Access 45 C.F.R. §§
permissions and 28; OM-ADM.- QIL-JC'I)'L 164.308(a)(3) 281;
authorizations are AC.S 001 CNES 164.308(a)(4) A'9'2'3
managed, incorporating ACE OM-KMG- EMRG 164.310(a)(2)(iii) A.9.4.1
the principles of least AC-14 001 NAUT 164.310(b) A.9.4.4
privilege and separation AC-16 PAUT 164.312(a)(1) A.9.4.5
of duties nC24 PR-INF-001 164.312(a)(2)(i) .
45 C.F.R. §§
PR.AC-5: Network 164.308(a)(4)(i))(B) | A.13.1.1
integrity is protected AC-4 MLDP 164.310(a)(1) A.13.1.3
(e.g., network AC-10 NAUT 164.310(b) A13.2.1
segregation, network SC-7 164.312(a)(1) A.14.1.2
segmentation) 164.312(b) A.14.1.3
164.312(c)
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NIST Cybersecurity Framework v1.1

Function Category

Subcategory

PR.AC-6: Identities are
proofed and bound to
credentials and asserted
in interactions

NIST SP
800-53
Revision 4

AC-19
AC-24
IA-1
IA-2
IA-4
IA-5
IA-8
PE-2
PS-3

NIST NICE
Framework
(NIST SP
800-181)

SP-RSK-002
OV-PMA-
003

Sector-Specific Standards and Best Practices

IECTR HIPAA Security ISO/IEC
80001-2-2 | Rule 27001
AUTH

CNFS

EMRG A7.1.1
NAUT N/A A9.1.2
PLOK

SGUD
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NIST Cybersecurity Framework v1.1

Function Category Subcategory

and other assets are
authenticated (e.g.,
single-factor, multi-
factor) commensurate
with the risk of the
transaction (e.g.,

privacy risks and other
organizational risks)

PR.AC-7: Users, devices,

NIST SP
800-53

Revision 4

AC-12
AC-14
IA-1
IA-2
IA-3

individuals’ security and | |A-4

IA-5
IA-8
IA-9
IA-10
A-11

NIST NICE
Framework
(NIST SP
800-181)

Sector-Specific Standards and Best Practices

IECTR HIPAA Security ISO/IEC
80001-2-2 | Rule 27001
A9.2.1
ALOF AS.2.4
AUTH A93.1
NAUT A9.4.2
PAUT A943
A.18.1.4
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NIST Cybersecurity Framework v1.1

Function

Category

Data Security
(PR.DS)

Sector-Specific Standards and Best Practices

NIST NICE
NIST SP Framework .
SOV el sy | s
Revision 4 800-181)
45 C.F.R. §§
:\jfé’P 164.308(a)(1)(ii)(D)
. | mp-8 164.308(b)(1)
Pfcf:ctlé dData atrestis | o1y 2'::; 164.310(d) A.8.2.3
P sC-28 il 164.312(a)(1)
ol 164.312(a)(2)(Gii)
164.312(a)(2)(iv)
45 C.F.R. §§
IGAU 164.308(b)(1) 2'?52'131
, . . |scs OM-DTA- NAUT 164.308(b)(2) S
iz R'?jtjc'tzzta n-transit | g 19 002 STCF 164.312(e)(1) 212;;
P SC-12 PR-CDA-001 | TXCF 164.312(e)(2)(i) 1419
TXIG 164.312(e)(2)(ii) 1413
164.314(b)(2) i) S
45 C.F.R. §§
) A.8.2.3
PR.DS-3: Assets are 164.308(a)(1)(i)(A) |, g 3
formally managed M-8 164.310(a)(2)(ii) A.8.3.2
y g MP-6 N/A 164.310(a)(2)(iii) ©.2
throughout removal, . A.8.3.3
. . PE-16 164.310(a)(2)(iv)
transfers, and disposition A.11.2.5
164.310(d)(1) 119
164.310(d)(2) s

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem

23



DRAFT

NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices
NIST SP Framework .
Function Category Subcategory 800-53 (NIST sP Isli;);l: . :LLAA Security Izs;z){)l fc
Revision 4 800-181) -
45 C.F.R. §§

164.308(a)(1)(ii)(A)
PR.DS-4: Adequate AUDT 164.308(a)(1)(ii)(B)
capacity to ensure CP-2 DTBK 164.308(a)(7)
availability is maintained | SC-5 164.310(a)(2)(i)
164.310(d)(2)(iv)
164.312(a)(2)(ii)

A12.1.3
Al17.21
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NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices

NIST SP Framework

Function Category Subcategory 800-53
Revision 4 800-181)

(NIST SP IECTR | HIPAA Security ISO/IEC
80001-2-2 | Rule 27001

A6.1.2
A7.1.1
A7.1.2
A73.1
A.8.2.2
A8.2.3
A9.1.1
A9.1.2
AUTH 45 C.F.R. §§ A.9.2.3
IGAU 164.308(a)(1)(ii)(D) | A.9.4.1
PR.DS-5: Protections MLDP 164.308(a)(3) A9.4.4
against data leaks are PS-6 SP-SYS-001 PLOK 164.308(a)(4) A9.45
implemented SC-7 STCF 164.310(b) A.10.1.1
SC-8 TXCF 164.310(c) All1.14
SC-13 TXIG 164.312(a) A.11.1.5
SC-31 Al1.2.1
Sl-4 A13.1.1
A.13.1.3
A.13.2.1
A.13.2.3
A.13.2.4
A14.1.2
A.14.1.3
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NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices
NIST SP Framework .
Function Category Subcategory 800-53 (NIST SP I8E0(;);I12- . :LLAA SIS ;S;()){)Ifc
Revision 4 800-181)
_ . 45 C.F.R. §§
Cheching meenansms 164 303(@)(1O) | 315
are useg to verif >C-16 IGAU 164.312(b) A.14.1.2
. ¥ SI-7 MLDP 164.312(c)(1) T
software, firmware, and A.14.1.3
information integrit 164.312(c)(2) Al14.24
gty 164.312(e)(2)(i) 442
PR.IP-4: Backups of 164.308(a)(7)IA) | 5 1531
. . CP-4 164.308(a)(7)(ii)(B)
information are DTBK . A.17.1.2
. CP-6 164.308(a)(7)(ii)(D)
conducted, maintained, PLOK . A.17.1.3
and tested CP-9 164.310(a)(2)() A.18.13
164.310(d)(2)(iv) B
PR.IP-6: Data is 45 C.F.R. §§ 2:;51;

. destroyed according to MP-6 DIDT 164.310(d)(2)(i) Pl
Information olic 164.310(d)(2) i) A.8.3.2
Protection policy ' Al11.2.7
(PR.IP) P2

(ncident Recpones and | €7 45 CER. 88

Business Con'finuit ) and CP-12 164.308(a)(6) A.16.1.1

PR (Inc»i/ o | cp-13 DTBK 164.308(a)(6)(i) A17.1.1

Recovery Zn Dienstaer | IR SGUD 164.308(a)(7) A17.1.2

Recovery) e | IR 164.310(a)(2) (i) A.17.1.3
v P IR-9 164.312(a)(2)(ii)

and managed PE-17
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NIST Cybersecurity Framework v1.1

Function

Sector-Specific Standards and Best Practices

controlled tools

NIST NICE
NIST SP Framework .
Category Subcategory 800-53 (NIST sP I:o%;:- . :LLAA Security IZS7C()){)I:ILEC
Revision 4 800-181)
CP-4
PR.IP-10: Response and IR-3 OM-NET- DTBK 45 C.F.R. §§ A17.13
recovery plans are tested PM-14 001 SGUD 164.308(a)(7)(ii)(D) R
PR.IP-12: A vulnerability RA-3 45 C.F.R. §§ 2112;
management plan is RA-S OV-PMA- MLDP 164.308(a)(1)(i) A.16.1.3
developed and SI-2 001 164.308(a)(1)(ii)(A) A.18.2.2
implemented 164.308(a)(1)(ii)(B) A18.23
PR.MA-1: Maintenance
. and re.pal.r of MA-2 OM-ADM- 45 CFR. §§ Al11.1.2
Maintenance organizational assets are | MA-3 001 CSUP 164.308(a)(3)(ii)(A) Al11.2.4
(PR.MA) performed and logged, MA-5 PR-INF-001 RDMP 164.310(a)(2)(iv) A.11.2.5
with approved and MA-6 Rl ' A11.2.6
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NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices
NIST SP Framework .
Function Category Subcategory 800-53 (NIST sP I8E0(;);I12- . :LLAA Security IZS7C()){)I:ILEC
Revision 4 800-181)
45 C.F.R. §§
164.308(a)(1)(ii)(D)
) 164.308(a)(3)(ii)(A)
v et
organizational assets is 12231853;8;8:3 A.11.2.4
approved, logged, and MA-4 CSup 164.312(a) A.15.1.1
performed in a manner ' N A.15.2.1
that prevents 164.312(a)(2)(ii
unach)horized access 164.312(a)(2)(iv)
164.312(b)
164.312(d)
164.312(e)
OV-PMA-
001
. OV-PMA- 45 C.F.R. §§
Protective documented ! OV-PMA- 164.308(a)(1)(ii)(D) | A.12.4.2
Technology i Iemente(; and AU Family | 003 AUDT 164.308(a)(5)(ii)(B) | A.12.4.3
(PR.PT) revr;ewed in a'ccordance OV-PMA- 164.308(a)(5)(ii)(C) | A.12.4.4
with policy 004 164.308(a)(2) A.12.7.1
OV-PMA- 164.308(a)(3)(ii)(A)
005
OV-SPP-001
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NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices

NIST SP Framework

IECTR HIPAA Security ISO/IEC

: 5 (NIST SP
Function Category Subcategory 800-53 80001-2-2 | Rule 27001

Revision 4 800-181)

OV-SPP-002

. 45 C.F.R. §§
et functionly o 164.308()(3
incorporated by AC-3 AUTH 164.308(a)(4)
configuring systems to CM-7 CNFS 164.310(a)(2)(iii) A.9.1.2
provide only essential SAHD 164.310(b)
capabilities 164.310(c)
164.312(a)(1)
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NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices

NIST SP Framework

Function Category Subcategory 800-53 (NIST sP
Revision 4 800-181)

IECTR HIPAA Security ISO/IEC
80001-2-2 | Rule 27001

SC-22 45 C.F.R. 8§
zg'r:;ﬁ'mcations and SC-23 f\\AULTDFF', 164.308(a)(1)(ii)(D) | A.13.1.1
control networks are 5C-24 PAUT 164.312(a)(1) A13.2.1
protected 325 SAHD 164.312(b) A.14.1.3

SC-29 164.312(e)
SC-32
SC-36
SC-37
SC-38
SC-39
SC-40
SC-41

SC-43
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NIST Cybersecurity Framework v1.1

Function

DETECT
(DE)

Sector-Specific Standards and Best Practices

NIST NICE
NIST SP Framework .
Category Subcategory 800-53 (NIST sP LEO%;I:- . :LTeAA Security ;S;()){)Ifc
Revision 4 800-181)
DE.AE-1: A baseline of
network operations and | AC-4 OV-EXL-001 | CNFS 45 CFR. §§ A12.1.1
expected data flows for CA-3 . A12.1.2
. OV-MGT- Csup 164.308(a)(1)(ii)(D)
users and systems is CM-2 001 MLDP 164.312(b) A13.1.1
established and Sl-4 ' A.13.1.2
managed
Anomalies and
AN-LNG-001
Events (DE.AE) 45CFR.85
DE.AE-2: Detected AU-6 LO-cLo-002 164.308(a)(1)(i)
Ab-S IN-FOR-001 164.308(a)(1)(ii)(D) | A.12.4.1
events are analyzed to CA-7 AUDT .
OM-DTA- 164.308(a)(5)(ii)(B) | A.16.1.1
understand attack IR-4 MLDP .
002 164.308(a)(5)(ii)(C) | A.16.1.4
targets and methods SI-4 .
OM-STS-001 164.308(6)(i)
PR-CDA-001 164.308(a)(6)(i)
AN-ASA-001
AC-2 AN-ASA-002 45 C-F-Rk §)? "
AU-12 AUDT 164.308(a)(1)(i
i .CM-1: i AN-EXP-001
i?;:ir:Zous r?wigitwclwle;—rc?;::g:?rk ; A7 AN-TWA CNFS 164.308(a)(1)1ii)(D)
Monitorin otential cybersecurit cM-3 001_ ) CSUP 164.308(a)(5)(ii)(B) | N/A
(DE.CM) & Zvents ¥ Y |scs MLDP 164.308(a)(5)(ii)(C)
' SC-7 CO-CLO-001 | NaUT 164.308(a)(2)
Sl-4 OM-DTA- 164.308(a)(3)(ii)(A)
001
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NIST Cybersecurity Framework v1.1 NIST NICE Sector-Specific Standards and Best Practices
NIST SP Framework .
Function Category Subcategory 800-53 (NIST sP ISEO%Z:-Z-Z :LLAA Security IZS7C()){)I:ILEC
Revision 4 800-181)
OM-KMG-
001
OM-NET-
001
OV-EXL-001
OV-LGA-002
OV-MGT-
001
DE.FM—Z: Thte‘physical CA7 AN-ASA-001 45 CER 5
environment is .F.R.
monitored to detect EEZ AN-ASA-002 |\ p 164.310(a)(2)(ii) 2111;
potential cybersecurity AN-TWA- 164.310(a)(2)(iii) B
PE-20 001
events
e 45 C.F.R. §§
2 %Zx;fég/'a"c'ous code 2:: :\(jfgp 164.308(a)(1)(ii)(D) | A.12.2.1
164.308(a)(5)(ii)(B)
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NIST Cybersecurity Framework v1.1

Function Category

Sector-Specific Standards and Best Practices

NIST NICE
NIST SP Framework .
T e || e
Revision4 800-181)
SC-18 45 C.F.R.
DE.CM-5: Unauthorized Sl4 MLDP 164.308( §)§1)(")(D) A125.1
mobile code is detected i SGUD ) a " 1 A12.6.2
SC-44 164.308(a)(5)(ii)(B)
/2;1:712 45 C.F.R. §§
DE.CM-7: Monitoring for CM-3 164.308(a)(1)(ii)(D)
unauthorized personnel, CM-8 AUDT 164.308(a)(5)(ii)(B) | A.12.4.1
connections, devices, PE-3 PAUT 164.308(a)(5)(ii)(C) | A.14.2.7
and software is PE-6 PLOK 164.310(a)(1) A.15.2.1
performed PE-20 164.310(a)(2)(ii)
Sl 164.310(a)(2)(iii)
. AN-EXP-001 45 C.F.R. §§
Sci'rfx'i ;/;I?;ﬁt;gty RA-5 IN-FOR-002 PML;DKP 164.308(a)(1)(i) A12.6.1
SP-DEV-002 164.308(a)(8)
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NIST Cybersecurity Framework v1.1

Function

RESPOND
(RS)

RECOVER
(RC)

523

Sector-Specific Standards and Best Practices

NIST NICE
NIST SP Framework .
Category Subcategory 800-53 (NIST sP I8E0(;);I12- . :LLAA Security IZS7C()){)I:ILEC
Revision 4 800-181)
45 C.F.R. §§
164.308(a)(6)(ii)
Response RS.RP-1: Response plan g:zjo DTBK 122382?:;2;;8?)%)
Planning is executed during or MLDP ' .. A.16.1.5
(RS.RP) after an event R4 SGUD 164.308(a)(7)1(i)(B)

' IR-8 164.308(a)(7)(ii)(C)
164.310(a)(2)(i)
164.312(a)(2)(ii)

. 45 C.F.R. §§
RS.IM-1: Response plans | CP-2 164.308(a)(7)(ii)(D) | A.16.1.6
incorporate lessons IR-4 DTBK 164.308(2)(8) Clause 10
Improvements | learned IR-8 164.316(b)(2) i)
(RS.IM)
: Cp-2 45 C.F.R. §§
8 P IR-8 164.308(a)(8)
45 C.F.R. §§
164.308(a)(7)
Recovery RC.RP-1: Recovery planis | CP-10 OM-ADM.- DTBK 164.308(a)(7)(i)
Planning executed during or after | IR-4 001 MLDP 164.308(a)(7)(ii) A.16.1.5
(RC.RP) a cybersecurity incident | IR-8 SGUD 164.308(a)(7)(ii)(C)
164.310(a)(2)(i)
164.312(a)(2)(ii)
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Table 3-6 identifies the NIST Privacy Framework v1.0 Functions, Categories and Subcategories

implemented in the lab build. NIST has begun the process of mapping the Privacy Framework to the final

published version of NIST SP 800-53, Revision 5 [15]. A future version of this publication will add a

control mapping using NIST SP 800-53, Revision 5, to Table 3-6. Practitioners should refer to the Privacy
Framework Resource Repository for further information regarding the latest references mapping to the

Privacy Framework [5].

Table 3-6 Privacy Characteristics—NIST Privacy Framework

NIST Privacy Framework v1.0

Function Category

Inventory and
Mapping
(ID.IM-P)

Identify - P

Subcategory

ID.IM-P1: Systems/products/services that process
data are inventoried.

ID.IM-P2: Owners or operators (e.g., the
organization or third parties such as service
providers, partners, customers, and developers)
and their roles with respect to the
systems/products/services and components (e.g.,
internal or external) that process data are
inventoried.

ID.IM-P7: The data processing environment is
identified (e.g., geographic location, internal,
cloud, third parties).

Risk
Assessment
(ID.RA-P)

ID.RA-P3: Potential problematic data actions and
associated problems are identified.

ID.RA-P4: Problematic data actions, likelihoods,
and impacts are used to determine and prioritize
risk.

ID.RA-P5: Risk responses are identified,
prioritized, and implemented.

Data
Processing

Control — P

CT.DM-P5: Data are destroyed according to
policy.
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Function

NIST Privacy Framework v1.0

Category Subcategory
Management CT.DM-P8: Audit/log records are determined,
(CT.DM-P) documented, implemented, and reviewed in
accordance with policy and incorporating the
principle of data minimization.
PR.PO-P3: Backups of information are conducted,
maintained, and tested.
PR.PO-P7: Response plans (Incident Response and
Business Continuity) and recovery plans (Incident
Data Recovery and Disaster Recovery) are established,
Protection in place, and managed.
Policies,
Processes, and
Procedures PR.PO-P8: Response and recovery plans are
tested.
PR.PO-P10: A vulnerability management plan is
developed and implemented.
PR.AC-P1: Identities and credentials are issued,
managed, verified, revoked, and audited for
Identity authorized individuals, processes, and devices.
Management,
Authentication,
and Access
Control

PR.AC-P2: Physical access to data and devices is
managed.
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NIST Privacy Framework v1.0

Function Category

Subcategory

PR.AC-P3: Remote access is managed.

PR.AC-P4: Access permissions and authorizations
are managed, incorporating the principles of least
privilege and separation of duties.

PR.AC-P5: Network integrity is protected (e.g.,
network segregation, network segmentation).

PR.AC-P6: Individuals and devices are proofed
and bound to credentials and authenticated
commensurate with the risk of the transaction
(e.g., individuals’ security and privacy risks and
other organizational risks).

Data Security
(PR.DS-P)

PR.DS-P1: Data-at-rest are protected.

PR.DS-P2: Data-in-transit are protected.

PR.DS-P3: Systems/products/services and
associated data are formally managed
throughout removal, transfers, and disposition.
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NIST Privacy Framework v1.0

Function Category

Subcategory

PR.DS-P4: Adequate capacity to ensure
availability is maintained.

PR.DS-P5: Protections against data leaks are
implemented.

PR.DS-P6: Integrity checking mechanisms are
used to verify software, firmware, and
information integrity.

Maintenance

PR.MA-P1: Maintenance and repair of
organizational assets are performed and logged,
with approved and controlled tools.

(PR.MA-P)
PR.MA-P2: Remote maintenance of
organizational assets is approved, logged, and
performed in a manner that prevents
unauthorized access.
PR.PT-P2: The principle of least functionality is
incorporated by configuring systems to provide
only essential capabilities.
Protective
Technology
(PR.PT-P)

PR.PT-P3: Communications and control networks
are protected.
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3.6 Technologies

Table 3-7 lists all the technologies used in this project, and provides a mapping among the generic
application term, the specific product used, and the security control(s) that the product provides. Refer
to Table 3-5 for an explanation of the NIST Cybersecurity Framework Subcategory codes and refer to
Table 3-6 for explanation of the NIST Privacy Framework Subcategory codes.

While this practice guide notes that the RPM solution is deployed across three domains, HDOs must
recognize that the responsibility for risk management remains with the HDO. Risk mitigation may be
achieved through tools or practices, where privacy and security measures are applied as appropriate in
each of the domains. HDOs may find that deploying privacy and security tools to the patient home
involve challenges and therefore, an HDO may collaborate with the telehealth platform provider to
provide adequate education and awareness training to patients. Training may address appropriate use
of the equipment that is sent to the patient home and awareness that patient data are involved and that
the patient needs to assure that data are shared only with authorized individuals.

For this practice guide, the telehealth platform provider is a third-party entity, distinct from the patient
and the HDO. Telehealth platform providers should implement an adequate control environment that
enables the telehealth platform provider to collaborate with HDOs in delivering RPM solutions. The
scope of this practice guide does not discuss all controls that a telehealth platform provider should
deploy. Rather, this practice guide focuses on controls that are deployed in the HDO. The telehealth
platform provider is a separate entity and should ensure that adequate controls are implemented in
their environment. Further, telehealth platform providers must ensure that equipment deployed to the
patient home includes appropriate safeguards.

Table 3-7 Products and Technologies

NIST
Cybersecurity
Component/ Framework

Capability function and Privacy

Framework
Subcategories

telehealth Accuhealth Evelyn = Provides role-based user ID.AM-1 patient
platform access control ID.AM-2 home
provider = Performs asset ID.AM-4
Vivify Pathways man:.ag'emzn; fo.r the ID.AM-5 telehealth
Home provisioned aevices PR.AC-1 platform
= Transmits health PR.AC-4 provider
information to the
ivi PR.AC-5
Vivify Pathways platform.
Care Team Portal PR.AC-6
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NIST
Cybersecurity
Component/ Framework

" P t Functi . D) i
Capability el HACHOR and Privacy omain

Framework
Subcategories

= Connects patients and PR.AC-7
physicians. PR.DS-1

PR.DS-2
PR.DS-3
PR.DS-4
PR.DS-6
PR.PT-1
PR.PT-3
PR.PT-4

ID.IM-P1
ID.IM-P2
ID.IM-P7
PR.AC-P1
PR.AC-P4
PR.AC-P5
PR.AC-P6
PR.DS-P1
PR.DS-P2
PR.DS-P3
PR.PT-P2
PR.PT-P3

risk Tenable.sc = Provides on-premises ID.RA-5 HDO

assessment Vulnerability centralized vulnerability

controls Management management with multiple ID.RA-P4

Version 5.13.0 with scanners

Nessus = Provides vulnerability
prioritization

= Provides risk scores
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Component/

Capability

identity
management,
authentication,
and access
control

NIST
Cybersecurity
Product Function Frame\.lvork
and Privacy
Framework
Subcategories
Active Directory Authenticates and PR.AC-1 HDO
(AD) authorizes users and PR.AC-4
computers in the domain.
Authenticates and PR.AC-P1
authorizes to multiple PR.AC-P4
applications within the
environment.
Cisco Firepower Provides console PR.AC-5 HDO
Version 6.3.0 management for Firepower | pR.pT-4
Threat Defense DE.AE-2
Provides centralized DE.CM-1
control o.ver.network and DE.CM-4
communication
. N DE.CM-5
Provides network visibility
Provides intrusion
prevention PR.AC-PS
Provides network PR.PT-P3
segmentation
Provides policy-based
network protection
Cisco Umbrella Provides domain name DE.CM-4 HDO
service (DNS) and internet | DE.CM-5
protocol (IP) layer security
Provides
content/application
filtering
Provides Advanced
Malware Protection (AMP)
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NIST
Cybersecurity
Compc.>r.1ent/ Product Function Frame\.lvork Domain
Capability and Privacy
Framework
Subcategories
Cisco Stealthwatch Provides insight into who PR.DS-5 HDO
Version 7.0.0 and what is on the network | pPR.PT-4
Provides network analysis DE.AE-1
through machine learning DE.CM-1
f'md global threat DE.CM-4
intelligence
. DE.CM-5
Provides malware
detection for encrypted
traffic PR.DS-P5
PR.PT-P3
data security Accuhealth Ensures that data-in-transit | PR.DS-1 patient
are protected. PR.DS-2 home
Vivify Health Ensures that data- at-rest PR.DS-3
are protected. telehealth
PR.DS-P1 platform
PR.DS-P2 provider
PR.DS-P3
HDO
anomalies and | LogRhythmXDR Aggregates log files. ID.RA-5 HDO
events and Version 7.4.9 Performs behavioral PR.PT-1
security analytics. DE.AE-1
continuous LogRhythm Monitors for unauthorized | pg.AE-2
monitoring NetworkXDR personnel, connections, DE.CM-7
Version 4.0.2 devices, and software.
Provides d.ashboards with ID.RA-P4
the analytic results
CT.DM-P8

4 Architecture

This practice guide implements a representative RPM solution as a distributed architecture. The solution
deployed components across three domains that consist of the patient home, the telehealth platform
provider, and the HDO. The patient home is the environment in which the patient lives and uses RPM
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components that include biometric monitoring devices, devices that the patient uses to communicate
with their care team, and devices that the patient operates for personal use. This practice guide
incorporates cloud-hosted telehealth platform providers within the architecture. The telehealth
platform provider maintains components that include virtual or physical components with servers to
manage, maintain, and receive data communications from either the patient home or the HDO. The
HDO maintains its own environment and includes components such as workstations and clinical systems
to receive and interpret patient data and record patient interactions in an electronic health record (EHR)
system. Figure 4-1 illustrates the high-level RPM distributed architecture.

Figure 4-1 RPM Architecture

Telehealth Platform

Patient Home _ HDO
Provider
Devioe Services Endpoints
] - _ ;
: Patient-Facing [ Workstations ]
: Applications
I path 2 ) | g [ Mobile Devices ]
[ Mobile Apps ]—- -------- F--| .
Operations and I
L Services 1 [ - ]
I
( N
HDO-Facing
Applications
v

|
[ Data Storage ]

4.1 Layering the Architecture

The NCCoE healthcare lab stratified the distributed architecture with three layers: business, security,
and infrastructure. The business layer focuses on functional capabilities that include biometric readings
and patient interactions. The security layer conceptually describes how the NCCoE lab implements
security capabilities. The NCCoE also implements an infrastructure layer that represents the network
and communications environment.

The layers intersect each of the three domains. The patient home domain implements the business layer
using the biometric devices and interface device(s) that capture and relay biometric data from the

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 43



574
575
576
577
578
579

580
581
582
583
584
585
586
587
588
589

590
5901
592
593
594

595
596

DRAFT

patient and allow the patient to communicate with the clinical care team, respectively. The patient
home may include a security layer component that segregates network traffic between the RPM
components and personally owned devices when the RPM devices use the same network infrastructure
(e.g., over Wi-Fi) as the personally owned devices. When devices operate and communicate over Wi-Fi,
the infrastructure layer would consist of Wi-Fi access points, routers, and switches that the patient
operates.

The telehealth platform provider domain also implements three layers. The business layer consists of
services that facilitate handling patient data and web- or audioconferencing capabilities. The security
layer consists of components used to secure the environment, such as authentication mechanisms,
certificate management systems, or security logging capabilities. The infrastructure layer consists of
network and server components that may be implemented as cloud services. Practitioners should note
that this practice guide does not go into significant detail regarding security or infrastructure layer
configurations for telehealth platform providers. As noted in this practice guide’s list of assumptions, it
is assumed that telehealth platform providers have adequate privacy and security controls. These
controls would align with the layer concept. HDOs should evaluate telehealth platform providers to
determine control adequacy.

The HDO domain implements the business layer with applications and clinical systems used to support
the RPM program. The security layer represents security capability deployment, which includes
authentication mechanisms, network monitoring capabilities, and vulnerability scanning as
representative examples. The HDO implements the infrastructure layer with fundamental IT services
such as AD, DNS, and networking devices.

Figure 4-2 depicts a high-level view of the three layers intersecting each domain of these components
and how we approached implementing them in the lab environment.
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Figure 4-2 Architecture Layers
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4.2 High-Level Architecture Communications Pathways

This practice guide describes an architecture that considers six different communications paths among
the patient home, telehealth platform provider, and HDO. Figure 4-3, RPM Communications Paths,
shows the different paths labeled A through F. The different communication paths represent the varying
modes by which the patient shares data with the clinician. Each path leads to the telehealth platform
provider who receives the data and presents the data in an HDO-facing application. The clinician
accesses data presented within an HDO-facing application via an app or application.

4.2.1 Cellular Data Pathways

The following communications pathways describe how patients use devices that are preconfigured with
cellular data services. Telehealth platform providers may provision devices with cellular data capability
to support ease of use and connectivity assurance and to ensure that the device may not be reachable
by an untrusted internet connection (e.g., an arbitrary Wi-Fi hot spot).

Path A assumes that the biometric device has cellular communications. The telehealth platform provider
deploys the biometric device with a preconfigured subscriber identity module, commonly referred to as
a SIM card. Option A does not include an RPM interface, such as a mobile device that may be a laptop,
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cellular phone, or tablet. The biometric device sends data over cellular data networks, which then route
the data to the telehealth platform provider. The telehealth platform provider receives the data and
displays it for clinicians to view through a portal or dashboard application. The clinician accesses the
data through a clinician-facing app or application.

Path B assumes that the telehealth platform provider has deployed a biometric device and an RPM
interface to the patient home. The RPM interface may be a mobile device such as a cellular phone or
tablet. For this path, the biometric device forwards data to the RPM interface via Bluetooth. The RPM
interface would include a SIM card that enables cellular data communication to the telehealth platform
provider. The RPM interface would be deployed with an app to be used by the patient. The app would
include an interface that allows the patient to forward the data to the telehealth platform provider.

4.2.2 Broadband Pathways

Telehealth platform providers may provide devices that leverage broadband internet connectivity
provisioned at the patient home. Devices may use Wi-Fi or other communications protocols. Devices
may transmit data that traverses a patient-provided internet router. The following pathways describe
how data may flow when internet broadband is available.

Path C assumes that the telehealth platform provider has deployed a biometric device and an RPM

interface to the patient home. The dataflow within the patient home domain is the same as Path B.
However, rather than cellular communication, the RPM interface communicates with the telehealth
platform provider via a broadband connection provided by the patient.

Path D has the same dataflow as Path C; however, external network transmissions traverse an add-on
security device such as a Layer 2 over Layer 3 gateway.

Path E is like Path A; however, rather than cellular data, the path leverages a patient home broadband
connection traversing an add-on security device such as a Layer 2 over Layer 3 gateway.

Path F is like Paths A and E. Path F leverages a patient home broadband connection; however, no other
gateway is used. Data are sent directly to the telehealth platform provider over the public internet.
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Figure 4-3 RPM Communications Paths
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4.3 Data and Process Flows

To gain a high-level understanding of how RPM programs operate, this practice guide evaluates diabetes
and cardiac and pulmonary rehabilitation use cases.

The World Health Organization defines diabetes as “a chronic, metabolic disease characterized by
elevated levels of blood glucose (or blood sugar), which leads over time to serious damage to the heart,
blood vessels, eyes, kidneys, and nerves” [16]. A diabetes RPM program could be beneficial in identifying
when a patient’s blood glucose levels are higher/lower than normal. Ensuring that a patient’s blood
glucose levels remain in a normal range helps prevent long-term complications that diabetes could
cause [17]. Patients may receive biometric devices such as glucometers, blood pressure monitors,
weight scales, and activity trackers. These biometric devices may be enabled with Bluetooth, Wi-Fi, or
cellular data communications capabilities that allow patients to share biometric data with physicians.
Physicians may continuously monitor their biometric data to identify and prevent a potential problem
from occurring.
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HDOs may enroll patients with chronic heart or lung conditions such as chronic obstructive pulmonary
disease or coronary heart disease into cardiac and pulmonary RPM rehabilitation programs. These
programs help patients return to a normal life and reduce other risk factors such as high blood pressure,
high blood cholesterol, and stress [18], [19].

Telehealth platform providers implement solutions using biometric devices, services, and applications.
While telehealth platform providers may develop and maintain services and applications, they
collaborate with manufacturers to procure and manage biometric devices. Conceptually, the device
manufacturer operates as an extension of the telehealth platform provider when delivering RPM
solutions to patients.

As noted in Section 4.2, High-Level Architecture Communications Pathways, practitioners may
implement RPM ecosystems where data communications involve different communications protocols or
paths.

This practice guide examines two distinct dataflows. The first dataflow begins when the patient
transmits data from the biometric device. The biometric device sends data to the device manufacturer.
The telehealth platform provider retrieves the data and presents the data through an HDO-facing
application. The clinician views the data from an app or application that interfaces with the patient data
residing in the telehealth platform provider HDO-facing application.

The second dataflow begins when the patient transmits the data from the biometric device. A field
gateway device, such as a mobile device that may be a tablet, mobile phone, or laptop, pulls the data
from the biometric device. The patient uses the field gateway device to transport the data to the
telehealth platform provider. The telehealth platform provider receives the data and presents it through
an HDO-facing application. The clinician views the data from an app or application that interfaces with
the patient data residing in the telehealth platform provider HDO-facing application.

Figure 4-4 depicts the first dataflow sequence. This dataflow sequence demonstrates an RPM
implementation that uses device vendor platforms to transmit data from a patient’s home to the
telehealth platform provider. A patient begins the process by interfacing with the biometric devices
provided by the third-party platform, which in turn gathers the required medical readings. Once the
device gathers the desired readings, the device transmits and stores the data to the vendor’s local
storage server. The third-party platform makes a connection to the vendor’s storage server and pulls
that data into its own local storage server. The platform then evaluates the received data and creates
correlations between the retrieved data, the associated patient, and the primary care provider. If the
platform identifies any areas of concern (such as high blood glucose readings for a diabetes use case)
while evaluating the data, the platform sends an alert to the patient’s primary care provider for
immediate action. Otherwise, the primary care provider will connect to the third-party platform’s web
server to view the patient’s data on a dashboard. The physician/clinician will evaluate the data, modify
the patient’s care plan, update the patient’s EHR, and contact the patient to update them on their new
care plan via video or audio call.

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 48



DRAFT

689 Figure 4-4 RPM Dataflow Option 1
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690 Figure 4-5 depicts the second dataflow sequence. In this dataflow sequence, a patient begins the

691 process by interfacing with the biometric device provided by the telehealth platform provider, which in
692  turn collects the required medical readings. Once the data are collected, the device transmits the data
693 to the mobile device. The patient uses the mobile device to answer survey questions associated with
694  their program, providing a clinician more insight on the patient’s health. The patient uses the mobile
695 device to collect data from all biometric devices associated with their RPM regimen. The patient uses
696  the mobile device to transmit the biometric device data and survey results. The mobile device pushes
697  the grouped data to the telehealth platform provider. The platform presents the data to the primary
698 care provider. The clinician connects to the third-party platform’s web server to view the patient’s data
699  on adashboard. The clinician evaluates the data and may update the patient’s care plan. Then, the
700 clinician may update the patient’s EHR and contact the patient via a mobile device to update them on
701 their new care plan.
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702 Figure 4-5 RPM Dataflow Option 2
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703 4.4 Security Capabilities

704  This practice guide implemented a lab environment that represented the three domains described in
705 Section 4, Architecture. When building the HDO environment, the practice guide built upon the zoned
706  network architecture described in NIST SP 1800-8, Securing Wireless Infusion Pumps in Healthcare

707 Delivery Organizations [20]. The practice guide used the network zoning approach as a baseline for the
708 RPM ecosystem infrastructure. On top of the baseline, the practice guide selected relevant security
709  capabilities for appropriate domains. The selected security capabilities are:

710 = telehealth platform provider

711 = risk assessment controls

712 = jdentity management, authentication, and access control
713 = data security

714 = anomalies and events and security continuous monitoring
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HDOs bear risk when implementing RPM practices. The RPM environment is distributed across three
domains and requires the participation of the patient, the telehealth platform provider, and the HDO to
assure that risks are adequately mitigated. This practice guide’s architecture describes deploying
components in three domains, with threats and risks that may affect each domain distinctly. As
organizations implement RPM solutions, they must involve parties involved in managing the individual
domains in recognizing and safeguarding against privacy and cybersecurity events that may occur within
the respective domains.

Practitioners will note that the security capability descriptions focus primarily on the HDO domain.
Capabilities are deployed to other domains to the extent that the HDO may have influence. HDOs may
not authoritatively determine the control environment implemented by the telehealth platform
provider. HDOs may obtain assurance that similar controls are implemented by the telehealth platform
provider before establishing the relationship with the provider. HDOs should establish questionnaires or
audit approaches that they may use in evaluating third parties such as telehealth platform providers.
HDOs and telehealth platform providers are subject to regulatory requirements to ensure patient
privacy and cybersecurity.

Telehealth platform providers are third parties that may implement security capabilities that do not
necessarily use the tools standard to the HDO. Telehealth platform providers may provide services for
many HDOs and implementing the same tools for all HDOs may not be feasible from a technical
perspective. Telehealth platform providers apply risk management approaches that are appropriate for
their business model. While telehealth platform providers may manage risk by using different tools and
techniques from the HDO, these providers should address the risk concerns for the HDO. Telehealth
platform providers should apply similar measures, e.g., the NIST Cybersecurity Framework [3] and Risk
Management Framework [4], that describe risk and control approaches. When evaluating telehealth
platform providers, HDOs should review the privacy and security control policies and other
documentation to ensure that the mitigation approaches that the telehealth platform provider
implements are consistent with the HDO's requirements.

HDOs and telehealth platform providers may find difficulties when implementing security capabilities on
the patient home domain. Patients may find complex controls or practices onerous and therefore, they
may be less likely to participate in the RPM program. Telehealth platform providers may implement
security capabilities for end-point devices such as biometric sensors or mobile devices that are part of
the RPM program. HDOs, in collaboration with telehealth platform providers, may offer education and
awareness material to discuss appropriate use of RPM-deployed equipment with the patient.

4.4.1 Telehealth Platform Provider

Telehealth platform providers are discussed in this practice guide as a security capability. HDOs
implementing RPM programs will depend on telehealth platform providers to enable communications
between patients and clinicians. Also, for this practice guide, telehealth platform providers configure,
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manage, and maintain biometric devices and potentially other technology that are provided to the
patient. HDOs engaging with telehealth platform providers to enable their RPM programs are
responsible for ensuring that they apply due diligence and understand the privacy and security
capabilities that the telehealth platform provider maintains. Telehealth platform providers represent a
third-party partner, and HDOs should evaluate their partners accordingly.

4.4.2 Risk Assessment Controls

The NIST Cybersecurity Framework includes risk assessment under the Identify Function. This practice
guide implements tools for vulnerability management.

The practice guide uses Tenable.sc with Nessus to perform vulnerability scanning and provide dashboard
reports. Vulnerability scanning operates by applying signatures of known vulnerabilities. Components
that operate within the HDO domain are subject to regular vulnerability scanning. As vulnerabilities are
identified, patching or other mitigating approaches may be applied. Patches or updates to operating
systems, apps, or applications may be applied as available.

4.4.3 Identity Management, Authentication, and Access Control

Identity management involves activities that discuss identity proofing and establishing credentials.
Authentication for this practice guide provides the mechanisms that assure that authorized entities
access the system after telehealth platform providers and HDOs establish respective credentials.
Practitioners should refer to NIST SP 1800-24 (reference Section 5.3.3), Securing Picture Archiving and
Communication System (PACS) [14], which provides more in-depth discussion on identity management
and access control. While that practice guide uses different tools and addresses a different clinical
practice from RPM, concepts regarding identity management and authentication are relevant for this
practice guide.

This practice guide extends on a network zoning concept that was discussed in NIST SP 1800-8, Securing
Wireless Infusion Pumps in Healthcare Delivery Organizations [20]. Figure 4-6 depicts the lab
environment built for this practice guide. The diagram splits the infrastructure between the NCCoE and
the RPM lab, with the latter representing the configured simulated environments for this practice guide.
Focusing on the HDO cloud depiction, this practice guide simulates the HDO environment that is made
up of enterprise services, health information services (HIS) services, remote services, databases, clinical
workstations, and security services virtual local area networks (VLANSs).
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Figure 4-6 Network Segmentation and VLAN Within the RPM Lab
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4.4.4 Data Security

This practice guide examines challenges associated with data loss and data alteration. Communications
initiate from the patient home, traversing a public communications channel, and are made accessible to
clinicians via internet connectivity. This practice guide addresses the need to provide end-to-end data
protection as a vital requirement to ensure RPM viability.

Network sessions are encrypted. Telehealth platform providers implement data security as they manage
biometric devices and the dataflow between the patient home and solutions hosted by the telehealth
platform provider. Stored data are protected through encryption. The practice guide examined
dataflows and applied a privacy risk assessment that analyzed communications between the
implemented components and identified how data-in-transit security controls are implemented.

4.4.5 Anomalies and Events and Security Continuous Monitoring

Managing anomalies and events and performing security continuous monitoring provides a proactive,
real-time measure to determine that threats and vulnerabilities are appropriately recognized and
mitigated within HDO environments. This practice guide implements several controls that address
managing anomalies and events and performing security continuous monitoring. Security engineers
require tools and processes to manage anomalies and events that include applying Cyber Threat
Intelligence (CTI), collecting and managing log information, and applying behavioral analytics. NIST
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describes CTl in NIST SP 800-150, Guide to Cyber Threat Information Sharing [21]. NIST provides
additional detail regarding security continuous monitoring in NIST SP 800-137 [22].

4.5 Final Architecture

The practice guide focused on cellular data-focused biometric devices in building the architecture. The
practice guide built an architecture that addressed communications pathways A and B that were
described in Section 4.2, High-Level Architecture Communications Pathways. This practice guide also
implemented a Layer 2 over Layer 3 solution provided by Onclave Networks as a proof of concept to
secure network sessions between the patient home and the telehealth platform provider. Discussion on
the Onclave solution appears in Appendix E. The Onclave solution discusses a future build consideration
where telehealth platform providers may deploy similar approaches, further enhancing data-in-transit
sessions from the patient home when those devices communicate over a broadband connection. Figure
4-7 depicts the final reference architecture of the example RPM solution.

Figure 4-7 Final Architecture
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The purpose of the security and privacy characteristic analysis is to understand the extent to which the
project meets its objective of demonstrating the privacy and security capabilities described in the
reference architecture in Section 4. In addition, it seeks to understand the security and privacy benefits
and drawbacks of the example solution.

5.1 Assumptions and Limitations

The security characteristic analysis has the following limitations:

= |tis neither a comprehensive test of all security components nor a red-team exercise.
= [t cannot identify all weaknesses.

= [t does not include the lab infrastructure. It is assumed that devices are hardened. Testing these
devices would reveal only weaknesses in implementation that would not be relevant to those
adopting this reference architecture.

= HDOs and telehealth platform providers implement an array of risk mitigation approaches that
extend beyond what is discussed in this document. The broader array of controls consists of
organizational structures, policies and procedures, and tools to support enterprise privacy and
cybersecurity programs that this practice guide refers to as a set of pervasive controls.

5.2 Pervasive Controls

NIST SP 1800-24, Securing Picture Archiving Communication System [14], described the use of controls
that were termed “pervasive.” Subsequent practice guides such as this RPM practice guide discuss
implementing controls that narrowly apply to the practice guide’s lab construction. Notwithstanding,
HDOs and telehealth platform providers are enterprise organizations that may face a broader set of
risks, including regulatory requirements, that extend beyond the narrow topic. The pervasive control
concept assumes that HDOs and telehealth platform providers have implemented a comprehensive
control set to address their risk and regulatory obligation.

For example, onboarding workforce members may involve identity proofing and creating, and managing
accounts and credentials. Organizations need to perform these activities to appropriately implement an
enterprise risk management program. The requirement is not specific to RPM programs. These functions
should be established prior to implementing an RPM program. Other controls, such as asset
management, having incident response teams, and establishing incident response programs, should also
be pervasive across the enterprise.

Another example is asset management. Asset management is a critical control that should be
implemented by telehealth platform providers. Telehealth platform providers should maintain accurate
inventories and manage configuration settings, patching, updates, and the overall life cycle for devices
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that are deployed to the patient home. While this is a requirement, this practice guide partnered with
multiple telehealth platform providers. This practice guide did not deploy security or privacy capabilities
to the telehealth platform providers. Rather, it relied upon telehealth platform providers to implement
an adequate and appropriate set of pervasive controls for their environment and for the services that
they provide.

The NIST Cybersecurity Framework [3] describes cybersecurity activities and outcomes that
organizations should achieve for establishing or improving enterprise security programs. These activities
and outcomes are articulated in the Subcategories of the Cybersecurity Framework Core. The
Cybersecurity Framework provides the basis for pervasive controls, whereas this practice guide
highlights implementation of selected controls. Readers should not regard the selected controls as the
only controls that an HDO must implement. The selected controls that are described in this practice
guide are a small subset of controls that HDOs and telehealth platform providers should implement. This
practice guide’s controls descriptions indicate how the selected controls were implemented in the lab
environment.

5.3 Telehealth Platform Providers

Telehealth platform providers address several controls for the RPM solution. Telehealth platform
providers configure, maintain, and manage devices that are deployed to the patient home domain.
Telehealth platform providers provision devices to patients who have been enrolled in an RPM program
by their HDO. Telehealth platform providers perform asset management for the provisioned devices and
thus address ID.AM-1, ID.AM-2, ID.AM-4, ID.AM-5, ID.IM-P1, ID.IM-P2, and ID.IM-P7. Telehealth
platform providers are responsible for addressing ID.RA-1.

Telehealth platform providers authenticate sessions based on the device identifier. When patients send
or transfer data from biometric devices, data are routed to the telehealth platform provider. The
telehealth platform provider receives the data and makes it available to clinicians and system users via a
portal. Portals use unique identifiers for credentials (e.g., username/password) and ensure that
connections to the portal are protected by using Transport Layer Security (TLS) 1.2.

For this practice guide, telehealth platform providers provisioned biometric devices and tablets that
used cellular data communications. Devices were explicitly not permitted to access Wi-Fi networks.
Removing Wi-Fi capability separated RPM communication from network traffic that may have been
present in the patient home domain. This practice guide used devices that were equipped to
communicate over 4G Long-Term Evolution (LTE), which uses asymmetric encryption between the
device and the cellular tower [31]. Further investigation in data-in-transit protection was not
determined in this practice guide.

The telehealth platform provider addresses PR.AC-1, PR.AC-4, PR.DS-1, PR.DS-2, PR.DS-4, PR.DS-6,
PR.PT-1, PR.PT-3, PR.PT-4, PR.AC-P1, PR.AC-P4, PR.DS-P1, PR.DS-P2, PR.DS-P4, PR.DS-P6, CT.DM-PS,
PR.PT-P2, and PR.PT-P3.
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This practice guide implemented telehealth platform provider services with Accuhealth and Vivify
Health.

5.4 Risk Assessment (ID.RA and ID.RA-P)

This practice guide implemented tools that address elements of ID.RA-5 (threats, vulnerabilities,
likelihoods, and impacts are used to determine risk) and ID.RA-P4. This practice guide implemented
Tenable.sc to address vulnerability management. Tenable includes vulnerability scanning and
dashboards that display identified vulnerabilities with scoring and other metrics that enable security
engineers to prioritize.

Telehealth platform providers have separate infrastructures and organizational structures that require
similar approaches. Telehealth platform providers may host their services with various implementations.
Telehealth platform providers may deploy similar solutions for their environments.

5.5 Ildentity Management, Authentication, and Access Control (PR.AC and
PR.AC-P) Protective Technology (PR.PT-P)

This practice guide regarded many of the identity management Subcategories as part of a set of
pervasive controls that have been discussed in NIST SP 1800-24, Securing Picture Archiving and
Communication System (PACS) [14]. HDOs and telehealth platform providers should apply similar
solutions to address managing human, device, and system identities. Sample solutions are provided in
NIST SP 1800-24.

Extending the network zoning concepts that were described in NIST SP 1800-8, Securing Wireless
Infusion Pumps in Healthcare Delivery Organizations [20], this practice guide implemented VLANs with
firewall feature sets by using Cisco Firepower Threat Defense. This practice guide addresses PR.AC-5 by
implementing VLANSs that represent network zones found within an HDO. Telehealth platform providers
may implement similar measures within their infrastructures.

The NIST Cybersecurity Framework implements identity management, authentication, and access
control under the Protect Function by using the PR.AC Category. Within the HDO, this practice guide
implements PR.AC-5 by using Cisco Firepower to establish network zones as a set of VLANs. The network
zones assure that components from each zone do not have implicit trust, and thus compromise on end
points found in one zone are limited in their ability to affect devices that operate in other zones.

This practice guide implemented three primary Cisco tools for the HDO environment: Cisco Firepower,
Cisco Umbrella, and Cisco Stealthwatch. As noted, this practice guide used Firepower to create and
manage VLANs within the environment. Cisco Firepower includes a central management dashboard that
allowed security engineers to configure and manage other features within the Cisco suite of tools.
Firepower also includes intrusion detection capability and visibility into network traffic and network
analytics that enabled engineers to detect and analyze events, monitor the network, and detect
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malicious code, and thus addressed DE.AE-2, DE.CM-1, and DE.CM-4. Cisco Firepower addressed PR.AC-
5, PR.PT-4, PR.AC-P5, and PR.PT-P3. The practice guide implemented Cisco Umbrella for DNS and IP layer
security and provide content and application filtering. Cisco Umbrella addressed DE.CM-4. The practice
guide also used Cisco Stealthwatch that implemented behavioral analytics capabilities and provided
malware detection. Cisco Stealthwatch addressed PR.DS-5, PR.PT-4, DE.AE-1, DE.CM-1, PR.DS-P5, and
PR.PT-P3.

Within the HDO domain, this practice guide implemented an AD to establish user accounts. AD
credentials provided engineers with authentication for several components deployed in the lab. The
lab’s AD implementation addresses PR.AC-1, PR.AC-4, PR.AC-P1, and PR.AC-P4.

The telehealth platform provider assures that PR.AC-5, PR.AC-6, PR.AC-7, PR.AC-P5, and PR.AC-P6 are
met by managing components that are deployed to the patient home. Components that are deployed by
the telehealth platform provider are fully managed devices that have been preconfigured and
distributed by Accuhealth. The RPM components that Accuhealth provided for the patient home use a
cellular communication pathway where unauthorized individuals may not remove or alter SIM cards.
The cellular data communication pathway assures that the RPM components are segregated from
untrusted devices that may operate in the patient home and thus implements PR.AC-5 and PR.AC-P5.

RPM-enrolled patients are predetermined by the HDO, and the telehealth platform provider provisions
RPM components to an established, known set of patients. HDOs enrolling patients in the RPM program
partially addresses PR.AC-1 and PR.AC-P1. Clinicians identifying patients may be regarded as performing
an identity-proofing activity, whereas telehealth platform providers may complete PR.AC-1 and PR.AC-
P1 activities by creating accounts or records that relate to the patient and the RPM equipment that the
patient receives.

Patient-provided (e.g., “bring your own device”) biometric devices were excluded in this practice guide’s
architecture. The telehealth platform provider manages patient home-deployed components and thus
assures that PR.AC-6 and PR.AC-P6 are addressed.

For this practice guide, the telehealth platform provider manages components that it procured and
configured. The telehealth platform provider configures the devices to include authenticators that
enforce component authentication. For this practice guide, only biometric devices that are managed by
telehealth platform providers are provisioned authenticators. This implements PR.AC-7 and PR.AC-P6.
Patient homes may include other devices, such as personally-owned devices, that are not a part of the
RPM ecosystem. Devices that are not managed by telehealth platform providers do not have
authentication credentials for the RPM solution.
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5.6 Data Security (PR.DS and PR.DS-P)

This practice guide implemented PR.DS-2 and PR.DS-P2 to ensure that data-in-transit are protected.
HDOs connecting to cloud-hosted consoles used TLS 1.2. The telehealth platform provider assured
implementation of PR.DS-3 and PR.DS-P3 for RPM biometric devices deployed to the patient home.

Accuhealth and Vivify Health use Advanced Encryption Standard (AES) AES256 encryption [23] for data-
at-rest and address PR.DS-1 and PR.DS-P1.

5.7 Anomalies and Events, Security Continuous Monitoring (DE.AE,
DE.CM) and Data Processing Management (CT.DM-P)

This practice guide implements LogRhythmXDR as a security incident event management (SIEM) tool.
End-point devices that include servers and network infrastructure components generate log data that
were aggregated in the SIEM tool for analysis. LogRhythm included two components: LogRhythmXDR
and LogRhythm NetworkXDR. SIEM capabilities provide security engineers a baseline of network
operations and allow security engineers to determine expected dataflows for users and systems.
Engineers can detect events and analyze potential threats. LogRhythmXDR therefore, is a SIEM that
addresses NIST Cybersecurity Framework Subcategories ID.RA-5, PR.PT-1, DE.AE-1, DE.AE-2, ID.RA-P4,
and CT.DM-P8. LogRhythm NetworkXDR provides capabilities that assure that the network is monitored
for potential cybersecurity threats. It also provides assurance that unauthorized mobile code is detected
and thus addresses DE.CM-7. This practice guide assures the implementation of a network monitoring
capability based on regular log collection and applies the SIEM analytics and automated response
capabilities. The practice guide implemented Cisco Firepower, Cisco Stealthwatch, and Cisco Umbrella,
which detects malicious code, detects unauthorized mobile code, and provides continuous network
monitoring and analytics. Therefore, the Cisco suite addresses DE.CM-4 and DE.CM-5.

This practice guide uses the NIST Cybersecurity Framework. The Cybersecurity Framework includes
Category and Subcategory concepts that allows this practice guide to develop a reference architecture.
The reference architecture reflects use cases and dataflows analyzed by the NCCoE. This practice guide
aligns privacy and cybersecurity tools to Cybersecurity Framework Subcategories. The reference
architecture depicts where tools were deployed.

6.1 RPM Functional Test Plan

One aspect of our security evaluation involved assessing how well the reference design addresses the
security characteristics that it was intended to support. The Cybersecurity Framework Categories and
Subcategories were used to provide structure to the security assessment by consulting the specific
sections of each standard that are cited in reference to a Subcategory. The cited sections provide
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979  validation points that the example solution would be expected to exhibit. Using the Cybersecurity
980 Framework Subcategories as a basis for organizing our analysis allowed us to systematically consider
981 how well the reference design supports the intended security characteristics.

982 6.1.1 RPM Functional Evaluation

983  Table 6-1 identifies the RPM functional evaluation addressed in the test plan and associated test cases.
984  The evaluations are aligned with the basic architecture design and capability requirements from
985 Section 4, Architecture.

986  Table 6-1 Functional Evaluation Requirements

Cybersecurity  Relevant Identifier Requirement Domain
Framework Cybersecurity
Category Framework
Subcategories
asset ID.AM-1 CR-1 device management home RPM-1
management ID.AM-5
telehealth
platform
provider
risk ID.RA-1 CR-2 end-point vulnerability HDO RPM-2
assessment ID.RA-4 scanning
ID.RA-5
ID.RA-6
identity PR.AC-1 CR-3 role-based access telehealth RPM-3
management, | PR.AC-2 platform
authentication, PR.AC-3 provider
and access PRAC-4 CR-4 domain user HDO RPM-4
control PRAC.S authentication
PR.AC-6 CR-5 domain user authorization | HDO RPM-4
CR-6 network segmentation HDO RPM-5
CR-7 access control policy HDO RPM-5
security DE.CM-1 CR-8 malware protection HDO RPM-6
continuous DE.CM-2 CR-9 anomaly detection HDO RPM-7
monitoring B
DE.CM-4 CR-10 | LogRhythm HDO RPM-8
DE.CM-7
CR-11 LogRhythm HDO RPM-9
DE.CM-8
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987 6.1.2 Test Case: RPM-1

Cybersecurity Framework
Category

Testable Requirement(s)
Associated Test Case(s)
Description

Preconditions

Procedure

Asset Management

(CR-1) device management

Demonstrate the ability to verify that provisioned devices are
associated with the intended patient who has enrolled in an RPM
program.

e Adoctor-level Accuhealth account has been provisioned.
e Accuhealth RPM devices have been provisioned and delivered,
including the following (obfuscated serial number):
0 blood pressure monitor (1234567)
0 blood glucose monitoring system (22334455)
0 digital scale (987654)
e Accuhealth has enrolled sample patients and associated them
with the RPM devices listed above, including:
O Regina Houston (1234567)
O Regina Houston (987654)
0 Janelle Kouma (22334455)

Verify the patient/device association in the Accuhealth system.

1. Loginto the Accuhealth platform with the doctor-level user
account.

Click Patient Details.

Under Select Patient, select Regina Houston.

Under Choose a view, select Profile.

Review the patient info for Regina Houston.

Navigate to Device Information.

Check if the Device ID field captures the device serial numbers,

NOU AW

1234567 and 987654, that are associated with Regina Houston.

o

Under Select Patient, select Janelle Kouma.

Review the patient information for Janelle Kouma.

10. Navigate to Device Information.

11. Check if the Device ID field captures the device serial number,
22334455, associated with Janelle Kouma.

©

Verify that data from the RPM devices is being sent to Accuhealth and

associated with the correct patient.
12. For the following devices, turn each device on and follow the
provided instructions to take a measurement:
a. blood pressure monitor
b. blood glucose monitoring system

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem

61



988

DRAFT

Expected Results

Actual Results

6.1.3 Test Case: RPM-2

Cybersecurity Framework
Category

Testable Requirement(s) \
Associated Test Case(s)

Description

Preconditions

c. digital scale

13. Record the time and measurement readings as notes.

14. Log in to the Accuhealth platform with the doctor-level user
account.

15. Click Patient Details.

16. Under Select Patient, select Regina Houston.

17. Under Choose a view, select Vitals.

18. Check if the blood pressure and weight measurements are
present.

19. Under Select Patient, select Janelle Kouma.

20. Under Choose a view, select Vitals.

21. Check if the glucose measurement is present.

e Accuhealth can provision the RPM devices and associate them to
the intended patient enrolled in an RPM.

e Accuhealth can capture the biometric measurements for the
correct patient with the assigned RPM devices.

Accuhealth provisioned an instance of its telehealth platform along
with doctor-level accounts and sample patients associated with these
accounts. We also received three RPM devices from Accuhealth:
blood pressure monitor, blood glucose monitor, and digital scale.
Accuhealth associated these RPM devices with the sample patients,
which we verified by checking the Device ID information for each
patient. Once the devices were received, we configured them and
recorded sample measurements from each one. With the
measurements taken, we logged in to the Accuhealth platform with
the doctor-level account and viewed the Vitals information for each
patient. As expected, the blood pressure and weight measurements
were associated with Regina Houston’s patient record, and the blood
glucose measurement was associated with Janelle Kouma’s patient
record.

Risk Assessment

(CR-2) end-point vulnerability scanning

Demonstrate the ability to perform vulnerability scans on assets and
view results in a dashboard format with risk-scoring evaluations.

e Tenable.sc has been configured with the following:
O organization
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Procedure

Expected Results

Actual Results

6.1.4 Test Case: RPM-3

Cybersecurity Framework
Category

Testable Requirement(s)
Associated Test Case(s)
Description

Preconditions

Procedure

repository
security manager user account
scan zones for each VLAN
host discovery scan policy
basic network scan policy
O active scans associated with each scan policy
e A Nessus scanner has been deployed to the Security Services
VLAN and is being managed by Tenable.sc.
e The Nessus scanner has access to each scan zone.

O 0O 0O0O0

Perform scans and view the results.

Log in to Tenable.sc with the security manager user account.
Navigate to Scans > Active Scans.

Under HDO Asset Scan, click the run button (P).

Wait for the HDO Asset Scan to finish.

Under HDO Network Scan, click the run button (»).

Wait for the HDO Network Scan to finish.

Click Dashboard in the menu ribbon.

Check if the risk assessment results are displayed.

sloNO U AWML

Tenable.sc and Nessus scan the HDO VLANSs, identify
vulnerabilities, and assign risk scores to discovered threats.

e Tenable.sc displays risk assessment scan results in the dashboard.

Using Tenable.sc, we ran a host discovery scan followed by a basic
network scan. Once both scans were finished, we returned to the
Tenable.sc dashboard and were able to view the results. The Nessus
scanner was able to identify end points in the scan zones (VLANs) as
well as potential vulnerabilities with associated risk scores.

Identity Management, Authentication, and Access Control

(CR-3) role-based access

Demonstrate the ability to limit and disable access to data by
implementing role-based access control on the Vivify platform.

e Vivify has provisioned a telehealth platform environment.

e Vivify has provisioned an administrative user account.

e Three test patients have been created in the Vivify platform:
0 TestPatient1
0 Test Patient 2
0 Test Patient 3

Create a Clinical Level 1 user account, and test account privileges.
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1. Login to the Vivify platform by using the provisioned admin
account.

2. Click Care Team in the menu bar.

3. Create a New User assigned to the Clinical Level 1 user group.

4. Access the Test Patient and add the new user into the Care Team
for this patient.

5. Log out of the environment.

6. Login to the environment with the user created in step 3.

7. Check if the account has read-only access to patient records
associated with that clinician level.

Create a Clinical Level 2 user account, and test account privileges.

8. Loginto the Vivify platform by using the provisioned admin
account.

9. Click Care Team in the menu bar.

10. Create a New User assigned to the Clinical Level 2 and Clinical
Level 1 user groups.

11. Access the Test Patient 2 and add the new user into the Care
Team for this patient.

12. Log out of the environment.

13. Log in to the environment with the user created in step 10.

14. Check if the account has read and write access to patient records
associated with that clinician level.

Create a Clinical Level 3 user account, and test account privileges.

15. Log in to the Vivify platform by using the provisioned admin
account.

16. Click Care Team in the menu bar.

17. Create a New User assigned to the Clinical Level 3, Clinical Level
2, and Clinical Level 1 user groups.

18. Log out of the environment.

19. Log in to the environment with the user created in step 17.

20. Check if the account has read and write privileges for all patient
records.

Expected Results e Auser account in the Clinical Level 1 group should be able to read
only patient records assigned to that clinician.

e Auser account in the Clinical Level 2 should be able to read and
write only to patient records assigned to that clinician.

e Auser account in the Clinical Level 3 should be able to read and
write to all patient records.

Actual Results We started by logging in to the provisioned Vivify portal with our
admin credentials and creating three new Care Team users, each with
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their own access levels. The first user was granted Clinical Level 1 and
was added as Care Team of the test patient; the second was granted
Clinical Levels 1 and 2 and was added as Care Team of the test
patient; and the third was granted Clinical Levels 1 through 3. Then
we logged in as each new user and tested their privileges. The first
user was able to only view patient records that assigned to her. The
second user was able to view and modify patient records that only
associated with those assigned to her. The third user was able to view
and modify all patient records.

6.1.5 Test Case: RPM-4

Cybersecurity Framework Identity Management, Authentication, and Access Control
Category

Testable Requirement(s) (CR-4) domain user authentication

(CR-5) domain user authorization

Associated Test Case(s)

Description Demonstrate the ability to create new domain users and enforce

restrictions on non-admin users.

Preconditions e A Windows Server is deployed to the Enterprise Services VLAN.

e The Windows Server has been configured as an Active Directory
Domain Controller for the hdo.trpm domain.

e A Windows workstation is deployed to the Enterprise Services
VLAN and has been added to the hdo.trpm domain.

e A Windows workstation is deployed to the Clinical Workstations
VLAN and has been added to the hdo.trpm domain.

e A Cisco Firepower access control policy rule has been created,
allowing network traffic from the Clinical Workstations VLAN to
the Enterprise Services VLAN.

e The Cisco Firepower Threat Defense (FTD) appliance has been
configured to provide Dynamic Host Configuration Protocol
(DHCP) services for the Enterprise Services and Clinical
Workstations VLANSs.

Procedure Create a non-admin domain user.

Power on the Windows Server and log in.

Open the Server Manager application.

Navigate to Tools > Active Directory Users and Computers.

Navigate to hdo.trpm > Users.

Click Create a new user in the current container.

Fill out the user’s information:

a. First Name: User
b. Last Name: Test

S
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c. Userlogon name: usertest
7. Click Next >.
8. Create a password for the user.
9. Uncheck User must change the password at next logon.
10. Click Next >.
11. Click Finish.
12. Right-click the user’s profile and select Properties.
13. Click Member Of.
14. Ensure that the user is a member of only Domain Users.

Create an admin domain user.
15. Navigate to hdo.trpm > Users.
16. Click Create a new user in the current container.
17. Fill out the user’s information:
a. First Name: Admin
b. Last Name: Test
c. Userlogon name: admintest
18. Click Next >.
19. Create a password for the user.
20. Uncheck User must change the password at next logon.
21. Click Next >.
22. Click Finish.
23. Right-click the user’s profile, and select Properties.
24. Click Member Of.
25. Click Add....
26. Type Domain, and click Check Names.
27. Select Domain Admins.
28. Click OK.
29. Click OK.

Create network share folder.

30. Power on the Windows workstation in the Enterprise Services
VLAN and log in with an administrator account.

31. Right-click the Windows Start Button.

32. Click Windows PowerShell (Admin).

33. Run the command ipconfig.

34. Note the IP address (192.168.40.107).

35. Open the File Explorer application.

36. Navigate to This PC > Local Disc (C:).

37. Under Home, click New Folder.

38. Name the folder Share.

39. Right-click the new folder and select Properties.
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40. Under Sharing, click Share....

41. Click the drop-down and select Find people....

42. Type Domain and click Check Names.

43. Select Domain Admins.

44. Click OK.

45, Click OK.

46. Click Share.

47. Click Done.

48. Create a new text document inside the Share folder, and name it
AccessTest.

Test ability to access network share folder with non-admin user.

49. Power on the Windows workstation in the Enterprise Services
VLAN.

50. Log in with the non-admin account, usertest, that was created in
the previous steps.

51. Right-click the Windows Start Button.

52. Click Run.

53. Under Open, type \\192.168.40.107\Share.

54. Click OK.

55. Check if a network error is displayed, stating that the user does
not have permission to access the network share folder

Test ability to access network share folder with admin user.

56. Log out of the non-admin account.

57. Log in with the admin account, admintest, that was created in
the previous steps.

58. Right-click the Windows Start Button.

59. Click Run.

60. Under Open, type \\192.168.40.107\Share.

61. Click OK.

62. Check if the network share folder is opened and the AccessTest
text document is visible.

Expected Results e After the non-admin and admin domain users have been created,
they will be able to use their credentials to log in to computers
within the domain.

e Only the admin domain user will be able to access the network
share folder.

Actual Results Once the user accounts were created and the network share folder

was created and configured, we began by logging in to a domain

computer with the non-admin domain user. The user was able to
successfully log in. Next, we tested the user’s ability to access the
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Expected Results

Actual Results

6.1.6 Test Case: RPM-5

Cybersecurity Framework
Category
Testable Requirement(s)

Associated Test Case(s)
Description

Preconditions

network share folder. The non-admin domain user was not able to
access the network share folder, receiving a network error stating
that the user did not have the proper permissions. Finally, we were
able to successfully log in to a domain computer with the admin
domain user’s account. With this user, we were also able to
successfully access the network share folder and view the files within.

e After the non-admin and admin domain users have been created,
they will be able to use their credentials to log in to computers
within the domain.

e Only the admin domain user will be able to access the network
share folder.

Once the user accounts were created and the network share folder
was created and configured, we began by logging in to a domain
computer with the non-admin domain user. The user was able to
successfully log in. Next, we tested the user’s ability to access the
network share folder. The non-admin domain user was not able to
access the network share folder, receiving a network error stating
that the user did not have the proper permissions. Finally, we were
able to successfully log in to a domain computer with the admin
domain user’s account. With this user, we were also able to
successfully access the network share folder and view the files within.

Identity Management, Authentication, and Access Control

(CR-6) network segmentation
(CR-7) access control policy

Demonstrate the use of network segmentation and an access control
policy to allow permitted traffic to selected network devices.

e The Cisco FTD appliance’s interfaces are configured.

e A Windows Server is deployed to the Clinical Workstations VLAN.

e The Windows Server has been configured with a basic Internet
Information Services (1IS) web service.

e A Windows workstation is deployed to the Clinical Workstations
VLAN.

e A Windows workstation is deployed to the Enterprise Services
VLAN.

e A Cisco Firepower access control policy has been configured, with
a default action of Block All Traffic, and applied to the Cisco FTD
appliance.
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e The Cisco FTD appliance has been configured to provide DHCP
services for the HIS Services and Clinical Workstations VLANs.

Procedure Test connectivity between devices in the same subnet.

1. Power on the Windows workstation, and log in.

2. Power on the Windows Server, and log in.

3. Onthe Windows workstation, right-click the Windows Start

Button.

Click Windows PowerShell (Admin).

Run the command ipconfig.

Note the IP address (192.168.44.101).

On the Windows server, right-click the Windows Start Button.

Click Windows PowerShell (Admin).

Run the command ipconfig.

10. Ensure that the IP address (192.168.44.102) is in the same subnet
as the Windows workstation.

11. On the Windows workstation, open an internet browser.

12. In the address bar, type in the address of the Windows server,
http://192.168.44.102.

13. Check if the default IIS landing page is displayed.

LN A

Test connectivity between devices in separate subnets with no access

control policy rules set.

14. Power off the Windows Server.

15. Move it to the HIS Services VLAN.

16. Power on the Windows Server, and log in.

17. On the Windows workstation, right-click the Windows Start
Button.

18. Click Windows PowerShell (Admin).

19. Run the command ipconfig.

20. Note the IP address (192.168.41.100).

21. On the Windows workstation, open an internet browser.

22. In the address bar, type in the address of the Windows Server,
http://192.168.41.100.

23. Check if the connection times out and the IIS web service cannot
be reached.

Test connectivity between devices in separate subnets with an access

control policy rule set to allow.

24. Power on the Windows workstation in the Enterprise Services
VLAN, and log in.

25. Open an internet browser.
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Expected Results

Actual Results

26. In the address bar, type in the address of the Cisco FMC,
https://192.168.40.100.

27. Log in to the Cisco FMC with your admin credentials.

28. Navigate to Policies > Access Control > Access Control.

29. Select the default access control policy.

30. Click Add Rule.

31. Give the rule a name.

32. Set the rule’s action to Allow.

33. Under Networks > Source Networks, type the IP address of the
Windows workstation in the Clinical Workstations VLAN
(192.168.44.101).

34. Click Add.

35. Under Networks > Destination Networks, type the IP address of
the Windows Server in the HIS Services VLAN (192.168.41.100).

36. Click Add.

37. Under Ports > Available Ports, select HTTP, and click Add to
Destination.

38. Click Add to create the rule.

39. Click Save and Deploy the configuration to the Cisco FTD.

40. On the Windows workstation in the Clinical Workstations VLAN,
open an internet browser.

41. In the address bar, type in the address of the Windows Server in
the HIS Services VLAN, http://192.168.41.100.

42. Check if the default IIS landing page is displayed.

e Devices in separate subnets are not able to communicate with
each other until an access control policy rule has been created to
allow that communication.

When the workstation and server were both placed inside the Clinical
Workstations VLAN, the workstation was able to access the server’s
web service, successfully displaying the server’s default 1IS web page.
After the server was moved to the HIS Services VLAN, the workstation
was no longer able to reach the server’s web service. Instead of
displaying the default IS web page, the workstation’s internet
browser returned an error code and stated that the web service could
not be reached. A new access control policy rule was created and
applied to the Cisco FTD, allowing hypertext transfer protocol (http)
traffic from the workstation to the server. Once the rule was created,
the workstation was able to access the server’s web service and
display the default IIS web page.
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992 6.1.7 Test Case: RPM-6

Cybersecurity Framework
Category

Testable Requirement(s)
Associated Test Case(s)
Description

Preconditions

Procedure

Security Continuous Monitoring

(CR-8) malware protection

Demonstrate the ability to protect the network and end points from
malicious services by blocking the service before a connection is
made.

Two Cisco Umbrella Forwarder appliances have been deployed to
the Enterprise Services VLAN.

The domain’s DHCP service has been configured to provide the
Cisco Umbrella Forwarder appliances as the primary and
secondary DNS providers.

A Cisco Umbrella policy has been created, with no malware
blocking and has been applied to the Cisco Umbrella Forwarder
appliances.

A Windows workstation is deployed to the Clinical Workstations
VLAN.

Test connectivity to outside malicious service with no Umbrella

policy.

R wN e

Power on the Windows workstation, and log in.
Right-click the Windows Start Button.

Click Windows PowerShell (Admin).

Run the command ipconfig/all.

Under DNS Servers, ensure that the IP addresses listed
correspond to the deployed Cisco Umbrella Forwarder
appliances, 192.168.40.30 and 192.168.40.31.

Open an internet browser.

In the address bar, type in the address of Cisco’s malware test
page, examplemalwaredomain.com.

Check if the site loads and no block message is displayed.

Test connectivity to outside malicious service with Umbrella policy.

9.

10.

11.

12.
13.

Open an internet browser.

In the address bar, type in the address of the Cisco Umbrella
dashboard, dashboard.umbrella.com.

Log in to the Cisco Umbrella dashboard with your admin
credentials.

Navigate to Policies > Management > All Policies.

Open the policy applied to the Cisco Umbrella Forwarder
appliances.
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Expected Results

Actual Results

6.1.8 Test Case: RPM-7

Cybersecurity Framework
Category

Testable Requirement(s)
Associated Test Case(s)

Description

Preconditions

14. Under Security Setting Applied, click Edit.

15. Under Categories to Block, click Edit.

16. Click the checkbox next to Malware.

17. Click Save.

18. Click Proceed to confirm the changes.

19. Click Set & Return to save the default settings.

20. Click Save to update the policy applied to the Cisco Umbrella
Forwarder appliances.

21. On the Windows workstation in the Clinical Workstations VLAN,
open an internet browser.

22. In the address bar, type in the address of Cisco’s malware test
page, examplemalwaredomain.com.

23. Check if the site does not load and a Cisco Umbrella block
message is displayed.

e When the Cisco Umbrella policy is active, devices within the HDO
environment will not be able to access potentially malicious web
services outside the HDO.

To start, the Cisco Umbrella policy applied to the Forwarder
appliances was not configured to block external sites that have been
flagged for potential malware. Using a workstation in the Clinical
Workstations VLAN, we navigated to a test malware site hosted by
Cisco (examplemalwaredomain.com) to verify Cisco Umbrella’s
effectiveness. Without the malware policy in place, the workstation
was able to successfully reach the test malware site. After this, the
Cisco Umbrella policy was configured to block external sites that have
been flagged for potential malware. With the policy in place, the
workstation was used again to connect to the test malware site, this
time receiving a Cisco Umbrella block page notifying us that access to
the site was not permitted.

Security Continuous Monitoring

(CR-9) malicious activity detection

Demonstrate the ability to detect anomalous network traffic and
create an alert for further investigation.

e C(Cisco Stealthwatch has been configured and licensed.
e A CCisco Stealthwatch Flow Collector has been deployed to the
Security Services VLAN and is being managed by the Cisco SMC.
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e The Cisco FTD has been configured to send NetFlow traffic to the
Cisco Stealthwatch Flow Collector for analysis.

e A Windows workstation is deployed to the Security Services
VLAN.

e An Ubuntu workstation, with the Nmap tool installed, has been
deployed to the HIS Services VLAN.

Procedure Configure Cisco Stealthwatch policy rule.

Power on the Ubuntu workstation, and log in.

Run the command ifconfig.

Note the IP address (192.168.41.10).

Power on the Windows workstation, and log in.

Open an internet browser.

In the address bar, type in the address of the Cisco SMC,

https://192.168.45.30.

7. Login to the Cisco SMC with your admin credentials.

8. Navigate to Configure > Policy Management.

9. Click Create New Policy and select Single Host Policy.

10. Under IP Address, type the IP address of the Ubuntu workstation,
192.168.41.10.

11. Click Select Events.

12. Select Recon.

13. Click Apply.

14. Under When Host is Source, select On + Alarm.

15. Click Save.

ok wneE

Test ability for Cisco Stealthwatch to detect a network discovery scan

and create an alert.

16. On the Ubuntu workstation, run the command nmap
192.168.40.0/24 to perform a host scan of the Enterprise
Services VLAN.

17. On the Windows workstation, bring up the Cisco Stealthwatch
session, and navigate to Dashboards > Network Security.

18. Check if the scan from the Ubuntu workstation has triggered one
or more alarms.

Expected Results e The network scans from the Ubuntu workstation will trigger some
form of alert from Cisco Stealthwatch.
Actual Results Once the Cisco Stealthwatch policy rule had been created, it took

roughly a minute after the Nmap scan had run to begin displaying
alerts on the Cisco Stealthwatch dashboard. The Ubuntu workstation
from which the scans originated, 192.168.41.10, was listed on the
dashboard under Top Alarming Hosts and was also listed in the
Recon category under Today’s Alarms. On top of triggering the Recon
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6.1.9 Test Case: RPM-8

Cybersecurity Framework
Category

Testable Requirement(s)
Associated Test Case(s)
Description

Preconditions

Procedure

rule that we had created, the scans also triggered a New Flows
Initiated alarm for exceeding a threshold number of new flows within
a set period of time.

Security Continuous Monitoring

(CR-10) end-point monitoring and protection

Demonstrate the ability to detect unusual authentication behaviors
and file integrity changes on protected end points.

e LogRhythmXDR has been configured and licensed.

e A Windows Server is deployed to the Clinical Workstations VLAN.

e The Windows Server has a LogRhythm System Monitor Agent
installed.

Enable user activity monitor services on the Clinical Workstation.
Power on the LogRhythmXDR host, and log in.

Start the Management Console application.

Click Deployment Manager.

Click System Monitors.

Double-click the Windows Server.

Click Endpoint Monitoring.

Click User Activity Monitor.

Click the checkbox next to Monitor Logon Activity.

Click the checkbox next to Monitor Network Session Activity.
10 Click the checkbox next to Monitor Process Activity.

11. Click OK.

©oONOUAWNE

Create a file integrity monitor policy for the Clinical Workstation.

12. Power on the Windows Server and log in with an administrator
account.

13. Open the File Explorer application.

14. Navigate to This PC > Local Disc (C:).

15. Create a new folder, and name it testdirectory.

16. Create a new text document inside the testdirectory, folder and
name it testfile.

17. On the LogRhythmXDR workstation, open the Management
Console application.

18. Click Deployment Manager.

19. Under Tools, select Administration.

20. Click File Integrity Monitor Policy Manager.
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21. In the dialog box, right-click and select New.

22. Name the policy NCCoE Testdirectory.

23. Provide a Description.

24. Under Monitoring Configuration, right-click and select New.

25. Name the policy testdirectory configuration.

26. Under Monitoring Flags, select Modify and Permission.

27. Under Monitored Items, right-click and select New.

28. Under Type, select Directory.

29. Under Path, type C:\testdirectory.

30. Click Apply.

31. Click OK.

32. Click System Monitors.

33. Double-click the Windows Server.

34. Click Endpoint Monitoring.

35. Click File Integrity Monitor.

36. Click the checkbox next to Enable File Integrity Monitor.

37. Select Realtime mode.

38. Click the checkbox next to Enable Realtime Mode Anomaly
Detection.

39. Under Policy, select NCCoE Testdirectory.

40. Click Apply.

41. Click OK.

Create an artificial intelligence (Al) engine rule._
42. Click Deployment Manager.
43. Click Al Engine.
44. Click Create a New Rule.
45. Under Rule Block Types, select and drag a rule block to the Rule
Block Designer.
46. Under each tab, fill out the necessary information.
47. Click Next.
48. Click OK.
49. Create a rule for Authentication Failure Monitoring.
a. Al Engine Rule Name: NCCoE Authentication failure
threshold
Data Source: Data Processor Logs
Primary Criteria-> Classification: Authentication Failure
Log Sources: All Log Sources
e. Group By: Host (Impacted), User (Origin)
50. Create a rule for File Integrity Monitoring.
a. Al Engine Rule Name: NCCoE Use Case File Activity
b. Data Source: Data Processor Logs

o0 o
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Expected Results

Actual Results

c. Primary Criteria -> Common Event: File Monitoring
Event—Add, File Monitoring Event—Modify
d. Log Sources: All Log Sources
e. Group By: User (Origin), Object
51. For both new rules, click the checkbox for Action.
52. Under Actions, select Enable.

Test user activity monitoring.

53. Power on the Windows Server.

54. Attempt to log in with a username and invalid password at least
five times.

View user authentication failure alerts.

55. On the LogRhythmXDR host, open an internet browser.

56. In the address bar, type in the address of the LogRhythm Web
Console, https://logrhythm-host:8443, and log in.

57. Click the Alarms tab.

58. Check for alerts coinciding with the user authentication failures.

Test file integrity monitoring.

59. On the Windows Server, log in with an administrator account.
60. Open the File Explorer application.

61. Navigate to This PC > Local Disc (C:) > testdirectory.

62. Open the testfile text document.

63. Modify the content of the testfile text document.

64. Under File, select Save.

View file integrity monitoring alerts.

65. On the LogRhythmXDR workstation, open an internet browser.

66. In the address bar, type in the address of the LogRhythm Web
Console, https://logrhythm-host:8443, and log in.

67. Click the Alarms tab.

68. Check for alerts coinciding with the file modification.

e The unusual authentication behavior will trigger an alarm event
that is viewable in the LogRhythm Web Console.

e The unauthorized file modification will trigger an alarm event that
is viewable in the LogRhythm Web Console, and log files will
identify the user who has performed the file modification.

Once LogRhythmXDR was configured to provide user activity
monitoring and file integrity monitoring, we began by testing the user
activity monitoring. For this test, we powered on the Windows Server
in the Clinical Workstations VLAN that had been configured with a
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6.1.10Test Case: RPM-9

Cybersecurity Framework
Category

Testable Requirement(s)
Associated Test Case(s)
Description

Preconditions

Procedure

LogRhythm System Monitor Agent. We made five consecutive login
attempts using an invalid password, which was then detected by
LogRhythm, and an alert was created that was visible on the
LogRhythm Web Console.

Next, we tested the file integrity monitoring. For this test, we logged
in to the Windows Server in the Clinical Workstations VLAN and made
some modifications to the testfile text document in the
C:\testdirectory folder. Once the changes had been saved, an alarm
was triggered and visible in the LogRhythm Web Console. From the
alert, we could also drill down to the event and determine what user
had made the modification.

Security Continuous Monitoring

(CR-11) end-point network access monitoring

e RPM-8

This test case demonstrates the ability to create alarms for
unauthorized network traffic.

e LogRhythm NetworkXDR has been configured and licensed.

e A Windows Server is deployed to the Clinical Workstations VLAN.

e The Windows Server has a LogRhythm System Monitor Agent
installed.

Enable user network connection monitor on the Clinical Workstation.
Power on the LogRhythmXDR host, and log in.

Start the Management Console application.

Click Deployment Manager.

Click System Monitors.

Double-click the Windows Server.

Click Endpoint Monitoring.

Click User Activity Monitor.

Click the checkbox next to Monitor Logon Activity.

Click the checkbox next to Monitor Network Session Activity.
10. Click the checkbox next to Monitor Process Activity.

11. Click OK.

12. Click Network Connection Monitor.

13. Click the checkbox next to Enable Network Connection Monitor.
14. Click the checkbox next to Monitor Inbound TCP Connections.
15. Click the checkbox next to Monitor Outbound TCP Connections.
16. Click the checkbox next to Monitor Listening TCP/UDP Sockets.

WoONOUAEWNRE
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Expected Results

Actual Results

17. Click the checkbox next to Include User Activity Monitor Data
(Required UAM).
18. Click OK.

Create an Al engine rule.
19. Click Deployment Manager.
20. Click Al Engine.
21. Click Create a New Rule.
22. Under Rule Block Types, select and drag a rule block to the Rule
Block Designer.
23. Under each tab, fill out the necessary information.
24. Click Next.
25. Click OK.
26. Create a rule for Monitoring HTTP Traffic.
a. Al Engine Rule Name: NCCoE HTTP traffic from clinical
workstation
b. Data Source: Data Processor Logs
c. Primary Criteria -> Application: HTTP, Know Host
(origin)-Windows Server
d. Log Sources: All Log Sources
e. Group By: Host (Origin), Application
27. For the new rule, click the checkbox for Action.
28. Under Actions, select Enable.

Test user network connectivity monitoring.

29. Power on the Windows Server, and log in.

30. Open an internet browser.

31. In the address bar, type the address of a web service by using the
http protocol, as in http://www.msn.com/.

View user network connectivity monitoring alerts.

32. On the LogRhythmXDR host, open an internet browser.

33. In the address bar, type in the address of the LogRhythm Web
Console, https://logrhythm-host:8443, and log in.

34. Click the Alarms tab.

35. Check for alerts coinciding with use of the http protocol.

e Connecting to a web service using the http protocol will trigger an
alarm event that is viewable in the LogRhythm Web Console.

Once LogRhythmXDR and NetworkXDR were configured to provide
user network connection monitoring, we powered on the Windows
Server in the Clinical Workstations VLAN that had been configured
with a LogRhythm System Monitor Agent. After logging in, we opened
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a web browser and connected to http://www.msn.com/. LogRhythm
detected use of the http protocol and created an alert that was
visible on the LogRhythm Web Console.

This practice guide implemented biometric devices that used cellular data communications. For a future
build, the NCCoE Healthcare Team would consider updating the reference architecture to include
broadband-based communications. The practice guide implemented Onclave Networks as a proof-of-
concept solution that would provide Layer 2 over Layer 3 protections but did not deploy biometric
devices that would leverage the benefits from this micro-segmentation solution.

A future build may also implement an EHR system that would receive automated data from the
telehealth platform provider. Patient-initiated messages from RPM components deployed to the patient
home were contained within the RPM systems hosted within an application to which HDOs connected
for review and analysis. The future build may include direct messaging from the RPM systems to the
EHR.
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Appendix C Threats and Risks

Organizations need to understand risks associated with systems they deploy. The National Institute of
Standards and Technology (NIST) provides two bodies of work that enable organizations to examine risk
and determine how risks may be mitigated. The National Cybersecurity Center of Excellence (NCCoE)
uses the NIST Cybersecurity Framework as guidance for managing risks in healthcare technology.
Dovetailing with the Cybersecurity Framework is the NIST Risk Management Framework (RMF). This
appendix discusses how the Cybersecurity Framework and the RMF may be applied when managing
risks for the remote patient monitoring (RPM) environment.

C-1 Discussion on the Risk Management Framework

This practice guide implements concepts in the NIST RMF [4]. The NIST RMF consists of a series of
documents that may be applied in categorizing systems, selecting controls, assessing controls, and
monitoring the security state of the overall architecture. The RMF captures this concept by describing a
six-step process.

The RMF security life cycle can be described as follows:

Step Description Guidance Document(s)

1 categorize Federal Information Processing Standards (FIPS) 199 [24]; NIST
Special Publication (SP) 800-60 [25], [26]

2 select FIPS 200 [27]; NIST SP 800-53 [10]

3 implement NIST SP 800-70 [28]

4 assess NIST SP 800-53A [29]

5 authorize NIST SP 800-37 [30]

6 monitor NIST SP 800-37 [30]; NIST SP 800-53A[29]
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PREPARE

Process Initiation

Note that this practice guide does not apply the RMF sequentially as described. The NIST RMF, in this
stepped approach, applies to new systems as they are evaluated for their suitability to transition from
development to production environments. For this RPM practice guide, components are already
developed. The approach that this practice guide uses in applying the RMF is first categorizing the
system, then assessing risk and understanding threats that may result in risk. The practice guide then
selects controls to disrupt threats.

C-2 Information and Information System Categorization

An initial step in performing a system risk assessment and then selecting and applying appropriate
controls is to perform an information and information system categorization exercise. A method to
categorize is described in NIST SP 800-60 volumes 1 and 2 [24], [25], as well as in FIPS 199. These
documents are a foundational step in the NIST Risk Management Framework. The NIST SP 800-60
volumes provide guidance on identifying information categories and provides recommended
categorization, based on confidentiality (C), integrity (1), and availability (A) security objectives.

In reviewing information types described in NIST SP 800-60 volume 2 [25], this practice guide selected
two information types as relevant for the representative build: C.2.8.9, personal identity and
authentication; and D.14.1, access to care. The two information types were recorded in Table C-1,
Information Types and Categorizations, and provisional impact levels were captured, with the category
levels corresponding to the recommended value found in NIST SP 800-60 volume 2 [25].
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Table C-1 Information Types and Categorizations

Information Type NISTSP 800-60 Confidentiality Integrity Availability  Justification
Volume I (to change
Reference an impact
(e.g., C.2.8.9) B

personal identity | C.2.8.9 moderate moderate moderate N/A

and

authentication

access to care D.14.1 low moderate low N/A

Overall Rating moderate moderate moderate N/A

After identifying the information categories, one may determine the security objectives. Security
objectives use a scale of low, medium, and high. FIPS 199 provides guidance in applying security
categorization (SC). This practice guide identifies two information types: "personal identity and
authentication", as well as "access to care". RPM's SC may be expressed as {(confidentiality,
MODERATE), (integrity, MODERATE),(availability, MODERATE)} [24]. The SC provides a base guide for
security controls selection.

C-3 Risk Context

This practice guide describes risk from a systemic perspective while contextualizing risk. The RPM
system for this practice guide consists of three domains. For this practice guide, a domain is a group of
assets whose maintenance and underlying infrastructure are the responsibility of discrete entities. In
RPM, this practice guide implements a reference architecture that uses the patient home, the telehealth
platform provider, and the HDO as domains.

Because each domain is managed and used by different entities, risks and threats may manifest
differently in each domain. While HDOs and telehealth platform providers are corporate entities that
are subject to regulatory obligations, the patient home tends to be managed by individuals. For RPM,
HDOs and telehealth platform providers should provide guidance to patients in safeguarding their
systems and information. Controls may be implemented on provisioned devices managed by HDOs or
telehealth platform providers; however, other controls may need to be addressed through education
and awareness.

Despite how controls may be implemented, this practice guide examines the contextualized risks and
threats and describes how the NCCoE implemented mitigating controls. Organizations that implement
RPM practices should ensure that they apply due diligence by examining their own risk scenarios,
including legal and regulatory obligations that may apply to their locale. Risks and threats should be
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analyzed based on their context. This practice guide applies contextualized controls to disrupt threats as
its strategy to mitigate risk.

C-4 Threats

In this practice guide, the NCCoE identified a threat taxonomy for the entire system. Threats may
manifest differently to the system depending on the domain in which they appear. Environments that
may have resources to maintain security tools and procedures may have mitigating circumstances that
reduce the likelihood of attack and minimize impact based on pervasive controls. This practice guide
considers scenarios where patient homes may have less resource and capability to minimize threats
when compared with telehealth platform providers and HDOs. Also, for the purposes of this practice
guide, some threats may target HDOs to a greater extent than patient homes or telehealth platform
providers given a more target-rich data set that may attract threat actors.

The following tables describe events and consider the likelihood of variation based on this context. Note
that the assigned values are notional. Practitioners who perform similar exercises may determine
different assignments. For purposes of this exercise, likelihood is categorized using a range that extends
from very low to very high, consistent with a model described in Appendix G of NIST 800-30 [9]. An
abstract of the table appears below. The qualitative values from the describe threat likelihood.
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1190 Table C-2 Assessment Scale: Likelihood of Threat Event Initiation

Qualitative Frequency (derived from Description (derived from adversarial

Values nonadversarial table) table)

very high Error, accident, or act of nature is Adversary is almost certain to initiate
almost certain to occur or occurs more the threat event.
than 100 times per year.

high Error, accident, or act of nature is highly | Adversary is highly likely to initiate the
likely to occur or occurs 10-100 times threat event.
per year.

moderate Error, accident, or act of nature is Adversary is somewhat likely to initiate

somewhat likely to occur or occurs 1-10 | the threat event.
times per year.

low Error, accident, or act of nature is Adversary is unlikely to initiate the
unlikely to occur or occurs less than threat event.
once a year but more than every ten
years.

very low Error, accident, or act of nature is highly | Adversary is highly unlikely to initiate
unlikely to occur or occurs less than the threat event.

once every ten years.

1191  The patient home may include technology and network infrastructure that offers malicious actors the
1192  opportunity to introduce disruption. Patients and individuals in the patient home come from different
1193  walks of life and may have varying degrees of experience in ensuring that privacy and cybersecurity are
1194  appropriately implemented for the devices that they may use. Malicious actors may opportunistically
1195 leverage a lack of robust controls in the patient home. While the patient home environment may have
1196 limited data to exfiltrate and that pertains to a few individuals, the ability to compromise a patient
1197  home environment may pose fewer challenges than better resourced companies and hospital systems.

1198  Table C-3 Threats Applied to the Patient Home

Threat Event Description Likelihood

C phishing Patients and individuals in the high
patient home may be susceptible to
phishing attempts.

1, A malicious Patients and individuals in the moderate
software patient home may be susceptible to
permitting or introducing malicious
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Threat Event

Description

software into the patient home
environment.

Likelihood

command and
control

Patients and individuals in the
patient home may be susceptible to
enabling malware that gives threat
actors the ability to exercise
command and control on devices.

moderate

ransomware

Ransomware may be introduced
into the patient home environment
either as links or attachments found
in phishing emails or may be
introduced through local media.

moderate

credential
escalation

Malware may be introduced to the
patient home environment that
allows threat actors to execute
arbitrary code and perform
privileged functions.

low

operating system
(OS) or
application
disruption

Malware may be introduced into
the patient home environment that
disrupts the operating system or
applications. Libraries or
subsystems may be affected.

moderate

data exfiltration

Sensitive data may be exposed to
unauthorized individuals, e.g., via
social engineering disclosure or
malware that allows threat actors
to retrieve data arbitrarily. Malware
may be used for this purpose.

moderate

1199 Using the same threat matrix, an examination is made of the telehealth platform provider. In general,
1200 the threat table considers when threat actors target workforce members who may have privileged
1201  access. The assumption is that telehealth platform providers may implement pervasive controls and
1202 have privacy and cybersecurity resources deployed that mitigate likelihood. The caveat in these

1203 assumptions is that HDOs that engage with telehealth platform providers should be provided assurance
1204  that third parties that they engage deploy mature privacy and cybersecurity programs.
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Table C-4 Threats Applied to the Telehealth Platform Provider

Threat Event
phishing

Description

Telehealth platform provider
workforce with privileged access
may be susceptible to spear
phishing attacks.

Likelihood

high

malicious
software

Telehealth platform provider
workforce with privileged access to
permitting allows malicious
software to be introduced into the
telehealth platform environment.

moderate

command and
control

Telehealth platform provider
workforce with privileged access to
permitting allows threat actors to
execute arbitrary code and perform
privileged functions.

low

ransomware

Ransomware may be introduced
into the telehealth platform
provider environment either as
links or attachments found in
phishing emails or may be
introduced through local media.

moderate

credential
escalation

Malware may be introduced to the
telehealth platform provider
environment that allows threat
actors to execute arbitrary code
and perform privileged functions.

moderate

OS or application
disruption

Malware may be introduced into
the telehealth platform provider
environment that disrupts the
operating system or applications.
Libraries or subsystems may be
affected.

low

data exfiltration

Sensitive data may be exposed to
unauthorized individuals, e.g., via
social engineering disclosure or
malware that allows threat actors
to retrieve data arbitrarily.

moderate
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The table below represents a notional healthcare delivery organization (HDO) model. As with the
telehealth platform provider above, many assumptions have been made about implementing pervasive

controls.

Table C-5 Threats Applied to the HDO

Threat Event

phishing

Description

HDO workforce with privileged
access may be susceptible to spear
phishing attacks.

Likelihood
high

malicious
software

HDO workforce with privileged
access to permitting allows
malicious software to be introduced
into the HDO environment.

moderate

command and
control

HDO workforce with privileged
access to permitting allows threat
actors to execute arbitrary code
and perform privileged functions.

moderate

ransomware

Ransomware may be introduced
into the HDO environment either as
links or attachments found in
phishing emails or may be
introduced through local media.

moderate

credential
escalation

Malware may be introduced to the
HDO environment that allows
threat actors to execute arbitrary
code and perform privileged
functions.

moderate

OS or application
disruption

Malware may be introduced into
the HDO environment that disrupts
the operating system or
applications. Libraries or
subsystems may be affected.

moderate

data exfiltration

Sensitive data may be exposed to
unauthorized individuals, e.g., via
social engineering disclosure or
malware that allows threat actors
to retrieve data arbitrarily.

high

denial of service
attack

Flooding network connection with
high-volume traffic to disrupt

high
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Threat Event

Description

communication in patient home,
between home and telehealth
platform, or between telehealth
platform provider and HDO. Such

type of attack could also be used to

damage a device, e.g., through
accelerated battery depletion.

Likelihood

C-5 Threat Sources

Threat sources describe those groups or individuals that may expose weaknesses to the RPM
infrastructure. Threat sources may take actions that expose or leverage vulnerabilities either through
unintentional actions or by actively attacking components within the RPM infrastructure. The following
table lists the threat sources identified for this risk assessment. The table is derived from one referenced
in NIST Special Publication 800-30 revision 1 (page D-2) [9].

Table C-6 Taxonomy of Threat Sources

Type of Threat Source

unintentional—patient

Description

The patient has physical access
to biometric devices,
workstations, and mobile
devices that may be used as
part of the RPM patient home
environment.

Characteristics

able to access components
in patient home domain
intend to access
components

Patient may be targeted by
malicious actors.

unintentional—care provider
(e.g., family member, friend, or
others with relationship to the
patient)

care providers or other trusted
individuals that may have
physical access to biometric
devices, workstations, and
mobile devices that may be
used as part of the RPM patient
home environment

able to access components
in patient home domain
intend to access
components

Individuals may be targeted
by malicious actors.

unintentional-other actors

Other actors may include
clinical or technical staff who
may be involved in deploying
the RPM infrastructure in the
patient’s home and may have
local or remote access to data
or systems used as part of the
overall RPM system. Other

able to access components
or data as part of the RPM
system

intend to access the system
(e.g., through maintenance
or data review)

Individuals may be targeted
by malicious actors or may
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Characteristics

Type of Threat Source

Description

actors may interact with
components at the Software as
Service (SaaS) provider or at the
HDO location.

represent “insider threats”
where actors have
legitimate access; however,
component use or data
access is not aligned with
providing patient care.

intentional—domestic—
criminal

Criminal actors may be
domestic and are motivated
primarily by financial interest.
Criminal actors may disrupt
RPM deployments either
directly or by affecting other
devices. Threat actions may be
direct or through a chain of
attacks.

=  Ability to access
components is not initially
provisioned. Criminal actors
may perform discovery to
identify vulnerable
components and may seek
means to deploy malicious
software that would allow
them access and control of
the components.

= Intent often is driven by
financial motivation.
Criminal elements may seek
to obtain information that
allows them to obtain funds
directly (e.g., credit or bank
account numbers) or
indirectly (e.g., personal
information that would
allow criminals to
fraudulently obtain financial
accounts, to commit
insurance fraud, or to sell
sensitive information).

intentional—nation-state

Some foreign nation-states may
want to disrupt another
nation’s critical infrastructure. A
malicious nation-state’s intent
may be difficult to discern as it
pertains to an individual.
Attacks may be sophisticated
and challenging to attribute
definitively to a specific
attacker.

=  Ability to access
components is not initially
provisioned. Nation-state
actors may perform
discovery to identify
vulnerable components,
may try to obtain user or
administrator credentials,
or may seek to deploy
malicious software that
would allow them access to
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Type of Threat Source Description Characteristics

and control of the
components.

= Nation-states may
obfuscate their identity,
posing as legit users, other
nation-states, criminals, or
activists.

= Nation-states have
significant resources to
implement complex or
advanced attack types.

= Nation-states may act to
disrupt critical
infrastructure to either do
physical damage or cause
sociopolitical discord.

= Nation-state actors may
seek to obtain intellectual
property (designs,
formularies, clinical
research).

Domestic or International-non- | Non-nation-state actors include | ® Ability to access

nation-state actors (e.g., those parties that operate as components is not initially
hacktivists or terrorists) large, disparate organizations provisioned. Non-nation-
that are not necessarily state actors may perform
tethered to a government discovery to identify
entity. Non-nation-state actors vulnerable components and
implement attacks based on may seek to deploy
political or social motivations. malicious software that

would allow them access to
and control of the
components.

= Non-nation-state actors
primarily seek to further a
social or political agenda.

= Attacks may seek to disrupt
critical infrastructure to
either do physical damage
or cause sociopolitical
discord.
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C-5.1 Business Processes

Several functions are performed with the RPM system, with those functions performed in the respective
scopes. Patient data are gathered and stored, and patients interact from the patient home;
communications between patients and care teams are routed through the telehealth platform provider,
which is cloud hosted; and clinicians receive and interact with patient data from the HDO. Table C-7

identifies these and other business processes that support the RPM functions.

Table C-7 RPM Functions and Processes

Function

interface with biometric
devices

Description

Patients may connect
biometric devices to
their bodies. Physical
contact occurs between
the device and the
patient to allow the
device to capture health
data. Physical interface is
a continuous process in
that patients may make
physical contact with the
biometric device on a
daily or more frequent
basis.

Components Used

biometric device

Domain

patient home

store biometric data

Biometric data are
stored to physical media.
Physical media are
nonvolatile media types,
meaning that data are
recorded to the media
and available for
retrieval after a device
has been power cycled.
Physical media may
consist of flash memory,
secure digital (SD) cards,
or hard drives associated
with the biometric
device or a device
hosting a healthcare app
or application (e.g., a

biometric device

mobile device

laptop

desktop

dedicated device
gateway

patient home
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Function

Description

mobile device, laptop,
desktop, or other
workstation-type
device).

Components Used

Domain

connect to cloud
environment

Biometric devices may
connect to a local device
that uses a telehealth
app or application, or
the devices may connect
to a cloud-hosted
telehealth platform
provider directly.
Connections originate
from the patient home
connected to the cloud-
hosted telehealth
platform.

biometric device

mobile device

laptop

desktop

dedicated device
gateway

cloud-hosted
components

patient home
telehealth platform

connect to HDO
environment

The telehealth platform
provider serves as a
routing mechanism that
connects
communications
between the patient
home and the HDO. The
telehealth platform
provider handles in-
transit data as well as
manages the underlying
technology to enable
RPM.

telehealth platform
provider

gateway or end-
point devices at the
HDO

telehealth platform
provider

HDO

conduct video- or
audioconferencing

Patients may initiate
video or audio
communication with the
clinical care team
through the telehealth
app or application.
Communications will
route through the
telehealth platform

mobile device
laptop
desktop

cloud-hosted
components

HDO mobile devices
HDO workstations

patient home

telehealth platform
provider

HDO
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Function Description Components Used Domain
provider and be routed
to the HDO.
remote configuration or | HDOs may periodically HDO-hosted servers | HDO
settings updates push configuration or biometric devices

other settings updates to
biometric devices. The
connection initiates from
the HDO and connects to
the biometric device
located in the patient

patient home

home.
review patient Physicians access patient | HDO workstation HDO
biometric data biometric data and HDO mobile device

review and analyze it.
add biometric data to Biometric data may not HDO workstation HDO
clinical notes ingest directly to an EHR

electronic health record
system. A physician may
need to manually enter
information based on
the biometric data to the
electronic health record
(EHR).

1224 C-6 Vulnerabilities

1225 Below is a customized application on identifying vulnerabilities that aggregates vulnerabilities identified
1226 in NIST SP 800-30 Revision 1 [9]. As noted in the document, a vulnerability is a deficiency or weakness
1227  that a threat source may exploit, resulting in a threat event. The document further describes that

1228  vulnerabilities may exist in a broader context, i.e., that they may be found in organizational governance
1229 structures, external relationships, and mission/business processes. The following table enumerates
1230  those vulnerabilities, using a holistic approach, and represents those vulnerabilities that this project
1231 identified and for which it offers guidance. For further description, readers should reference NIST SP
1232 800-30 Revision 1 [9].
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Table C-8 Vulnerability Taxonomy

Vulnerability

Description

out-of-date software

Vulnerability Severity

high

Predisposing Condition

Systems may not have
patches deployed in a
timely fashion, or
software may not be
validated to assure that
applications may
operate appropriately
should the underlying
operation system
receive new updates.

Pervasiveness of
Predisposing Condition

high

permissive
configuration settings

high

Underlying operating
systems or security
components (e.g.,
firewall) may have
configuration settings
that allow actions that
exceed the minimum
necessary to operate
the application.

high

unmanaged or
improperly managed
credentials

high

Applications may use
service or other
privileged accounts to
operate, or operating
systems may have
privileged accounts
that have expansive
access to the host
system(s). These access
privileges may exceed
the minimum
necessary to operate
applications.

high

unprotected data

high

Data on systems may
lack restrictions that
limit accessibility.

high

failing or missing
integrity or

high

Data path may lack
end-to-end data

high
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Vulnerability Vulnerability Severity Predisposing Condition Pervasiveness of
Description Predisposing Condition
authenticity integrity or authenticity

verification verification.

C-7 Threat Modeling

Thus far, this practice guide has discussed several elements that make up an attack. Threats involve
threat actors that may leverage vulnerabilities found in components. Components represent end-point
devices found in the overall system. Components are made up of several subcomponents. The threat-
modeling exercise described below identifies adverse actions that may expose vulnerabilities at the
subcomponent level.

This practice guide considers that threats may include multiple actions taken that ultimately result in
risk. These multiple actions are described herein as “adverse actions.” A threat may involve one or more
adverse actions leveraging vulnerabilities at the subcomponent level that then result in risk.

The patient home environment is used a representative domain by which the threat-modeling exercise
is applied. Practitioners may wish to perform a similar, granular level of analysis for other domains in
their deployment.

For the RPM solution, components are identified in three distinct domains: the patient home, the
telehealth platform provider, and the HDO. This section describes a means by which threats may occur
contextually. Adverse actions that align with threats may target specific subcomponents, with different
risk outcomes based on the domain within which the threat actor executes the attack. Practitioners
should note that while this practice guide does not apply any particular threat-modeling methodology;
several are available that provide guidance for performing similar exercises for an organization’s
environment.

C-7.1 Modeling Threats to the Patient Home

The patient home domain poses several challenges when considering threats. For example, patients or
care providers may not have the resources or technology background to address these threats
independently. Telehealth platform providers and HDOs may not have the ability to manage the patient
home environment entirely. Patients may have devices that are unrelated to RPM operating in their
home environment. Other individuals within the patient home may have physical access to RPM devices.

Components that may be present in the RPM system’s environment are outlined in Table C-9.
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Table C-9 Components in the Patient Home Environment

Component

biometric device

Description

a sensor device that
interfaces with the
patient and captures
biometric data that is
conveyed to the
clinician

Communicates with

patient (direct,
tactile interface)

interface device
wireless Personal
Area Network (PAN)
(Bluetooth, Wi-Fi)

telehealth platform
provider (Wi-Fi)

Provisioned by

telehealth platform

HDO

interface device

A device that potentially
retrieves data from
biometric devices and is
used as a
communications device
by which patient-
clinician
communications may
occur. The device may
be a mobile device such
as a tabletora
connected phone
running a dedicated
application, may be a
full-feature device such
as a laptop or desktop
workstation, or may be
a purpose-designed
device.

biometric device
(Near Field
Communication
[NFC], Bluetooth,
Wi-Fi)

telehealth platform
provider

telehealth platform
provider

HDO

Wi-Fi access point

a device that provides
the RPM environment a
wireless means to
communicate with
devices using internet
protocols

biometric device

interface device

unrelated
equipment

telehealth platform
provider

HDO

patient
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Component Description Communicates with Provisioned by
internet router a device that allows biometric device patient
computing devices in
the home to interface device
communicate via the
internet over broadband
. unrelated
infrastructure (e.g., . ;
cable, fiber-optic, equipmen
telephone)
personally owned device | A device that is not part | biometric device patient

of the RPM solution;
however, it may have
communications
capabilities to
components. These
devices may include
patient-owned devices
such as personal
computers, mobile
devices, or connected
home devices

interface device

internet router

Wi-Fi access point

unknown device

A device belonging to
individuals other than
the patient. This may
include guests or

unknown individuals.

unknown

biometric device

interface device

internet router

Wi-Fi access point

unknown individuals

1261  The RPM solution deployed in the patient home is not a closed system. Elements that may be

1262 provisioned by the patient include Wi-Fi or cellular access points and the internet router. Further, the
1263 patient may have other devices on the home network. These may include connected home devices,
1264  personal computers, mobile devices, and gaming and entertainment systems.

1265  The biometric device may consist of several subcomponents. Biometric devices may have PAN interfaces
1266  that support short-distance communication (e.g., Bluetooth). Biometric devices may also support Wi-Fi
1267 connectivity. A biometric device has a tactile interface that makes physical contact with an individual.
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There may be a display that acts as a user interface, and there may be storage media embedded in the

device. There may be onboard storage. Physical external interfaces are ports for data communication

(e.g., Universal Serial Bus [USB]), acceptance of removeable media (e.g., SD card), and power.

Table C-10 Biometric Device Subcomponent Breakdown

Subcomponent

Adverse Action

Proximity

CLA

Adverse
Outcome

Unmitigated

Likelihood

communication
port

access the
biometric device
and expose a
subsystem (e.g.,
operating
system).

subsystem such
as an OS may
enable a
malicious actor
to escalate
privileges and
modify, install,

tactile interface An individual local I Biometric data high
other than the would be false;
patient attaches does not pertain
the biometric to the patient.
device and
introduces
nonpatient data.
display An individual local C Unauthorized high
other than the individuals may
patient may be have access to
able to navigate biometric data.
the user interface
and view patient
biometric data.
display The display may local A biometric device | high
be damaged so usage degraded
that navigation is
not possible.
onboard storage Storage media local A biometric device | low
that maintains rendered
biometric device inoperative
system files may
be damaged or
made
unavailable.
data An individual may | local I, A Exposing a low
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Subcomponent Adverse Action Proximity CIlA Adverse Unmitigated
Outcome Likelihood
or execute
arbitrary code.

personal area An individual may | near C Unauthorized low

network retrieve remote individuals may

communications have access to

between the biometric data.

biometric device

and the interface

device.

removable media | An individual may | local C Unauthorized moderate

be able to individuals may

leverage have access to

removable media biometric data.

and extract data

from the

biometric device.

removable media | An individual may | local I, A Unauthorized moderate

be able to individuals may

introduce introduce

removable media unauthorized or

to convey malicious

malicious software to the

software. biometric device
and alter
functionality or
render the
device
inoperative.

cellular Cellular local; A Cellular low

communications communications | remote communications

may be damaged. may be
inoperative.

cellular Cellular local; A Cellular data low

communications communications | remote may be exposed

may become to unauthorized
compromised. individuals.
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Subcomponent Adverse Action Proximity CIlA Adverse Unmitigated
Outcome Likelihood
Wi-Fi Wi-Fi local A Wi-Fi low
communications communications communications
may be damaged. may be
inoperative.
Wi-Fi Wi-Fi local; C Data carried moderate
communications communications | remote over Wi-Fi may
may be be exposed to
compromised. unauthorized
individuals.

The interface device may be a connected phone, tablet, laptop, or desktop device. Depending on the
device type and manufacturer, subcomponents may vary. The first threat model profile offered below
assumes that the interface device is a connected phone or tablet. Connected phones and tablets are
assumed to have similar characteristics for the purposes of developing the threat model considered in
this practice guide.

Table C-11 Interface Device Subcomponent Breakdown

Subcomponent

Adverse Action

Proximity

CLA

Adverse
Outcome

Unmitigated
Likelihood

access the mobile
device and expose a
subsystem (e.g.,
operating system).

code may be
introduced that
compromises
the device
integrity or
renders the
device

display Display may local A Device may be high
become damaged. inoperable or
unusable.
display An unauthorized local A biometric data low
individual who has lost
access to the
display may be able
to obtain biometric
data (e.g.,
fingerprint).
data access port | Anindividual may local I, A Unauthorized low
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Subcomponent

Adverse Action

Proximity

CLA

Adverse
Outcome

inoperable for

Unmitigated

Likelihood

intended
purposes.
operating system | The operating local; CIlA Vulnerability moderate
system may be remote exposure may
susceptible to allow
known vulnerability unauthorized
exposure. removal of data,
allow
introduction of
unauthorized
code that could
compromise the
device
operational
integrity, or
render the
device
inoperable.
RPM app The RPM app may local; CIA Apps on the moderate
not be patched to remote device may
current versions include flaws or
and may allow vulnerabilities
known vulnerability that result in
exposure. unauthorized
data exposure,
compromise to
an app or device
operational
integrity, or
render the app
or device
inoperable.
other apps Apps may be local; C Unauthorized moderate
installed on the remote actors may
device that include exfiltrate data
unauthorized code. from the device.
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Subcomponent

Adverse Action

Proximity

Adverse
Outcome

Unmitigated
Likelihood

other apps Apps may be local; I, A Unauthorized moderate
installed on the remote actors may
device that include disrupt the
unauthorized code. device’s
functionality.
onboard storage | Onboard storage local A Device may low
media media may become become
damaged. inoperative or
unable to obtain
or transmit
biometric data.
removable media | A device that allows | local C Data may be low
removable media exfiltrated.
may enable a
means by which
files may be moved
or copied.
removable media | A device that allows | local ClA Unauthorized low
removable media software is
may allow code introduced on
installation. the device.
camera The camera may local Images and moderate
become damaged, videos may not
rendering be obtained.
videoconferencing
inoperative.
camera Malicious actors remote C Sensitive video moderate
may be able to data may be
compromise exposed.
subsystems and
allow unauthorized
control of camera
functions.
audio Audio microphone local C Audio low
microphone may become communication
damaged. may not
function
appropriately.
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Subcomponent Adverse Action Proximity CIlA Adverse Unmitigated
Outcome Likelihood
cellular cellular local A Cellular low
communications | communications communications
may be damaged. may be
inoperative.
cellular Cellular local; C Cellular data low
communications | communications remote may be exposed
may become to unauthorized
compromised. individuals.
Wi-Fi Wi-Fi local A Wi-Fi low
communications | communications communications
may be damaged. may be
inoperative.
Wi-Fi Wi-Fi local; C Data carried moderate
communications | communications remote over Wi-Fi may
may be be exposed to
compromised. unauthorized
individuals.

Table C-12 Laptop Subcomponent Breakdown

Subcomponent

Adverse Action

Proximity

GLA

Adverse
Outcome

Unmitigated
Likelihood

individual who
has access to the
display may be

lost

data access port An individual may | local I, A Unauthorized low
access the mobile code may be
device and expose introduced that
a subsystem (e.g., compromises
operating the device
system). integrity or
renders the
device
inoperable for
intended
purposes.
display An unauthorized local A biometric data low
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Subcomponent

Adverse Action

able to obtain
biometric data
(e.g., fingerprint).

Proximity

CGLA

Adverse
Outcome

Unmitigated

Likelihood

operating system | The operating local; CIlA Vulnerability moderate
system may not remote exposure may
be patched to allow
current versions unauthorized
and may allow removal of data,
known allow
vulnerability introduction of
exposure. unauthorized
code that could
compromise the
device
operational
integrity, or
render the
device
inoperable.
RPM application The RPM local; CILA Applications on moderate
application may remote the device may
not be patched to include flaws or
current versions vulnerabilities
and may allow that result in
known unauthorized
vulnerability data exposure,
exposure. compromise the
app or device
operational
integrity, or
render the
application or
device
inoperable.
other applications | Applications may | local; C Unauthorized moderate
be installed on remote actors may
the device that exfiltrate data
include from the device.
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Subcomponent

Adverse Action

Proximity

CGLA

Adverse
Outcome

Unmitigated
Likelihood

unauthorized

code.
other applications | Applications may | local; C Unauthorized moderate
be installed on remote actors may
the device that exfiltrate data
include from the device.
unauthorized
code.
onboard storage Onboard storage local A Device may low
media media may become
become damaged. inoperative or
unable to obtain
or transmit
biometric data.
removable media | A device that local Unauthorized low
allows removable software is
media may allow introduced on
code installation. the device.
camera The camera may local Images and moderate
become damaged, videos may not
rendering be obtained.
videoconferencing
inoperative.
camera Unauthorized remote C Sensitive video moderate
actors may be data may be
able to exposed.
compromise
subsystems and
allow
unauthorized
control of camera
functions.
audio Audio local A Audio low
microphone microphone may communication
become damaged. may not
function
appropriately.
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Subcomponent Adverse Action Proximity CIA Adverse Unmitigated
Outcome Likelihood
Wi-Fi Wi-Fi local A Wi-Fi low
communications communications communications
may be damaged. may be
inoperative.
Wi-Fi Wi-Fi local; C Data carried moderate
communications communications remote over Wi-Fi may
may be be exposed to
compromised. unauthorized
individuals.
Table C-13 Desktop Subcomponent Breakdown
Subcomponent Adverse Action Proximity CIA Adverse Unmitigated
Outcome Likelihood
data access port An unintended local I, A Unauthorized low
device may obtain code may be
communications conveyed via the
channels by using data access port
data access ports and expose or
(e.g., USB). corrupt
subsystem
libraries (e.g.,
operating
system).
display port The display port local A Information may | low
may become not be
physically displayed;
damaged. interaction with
the system may
be prevented.
operating system | The operating local; CI,A Vulnerabilities moderate
system may not remote may persist.
be patched to
current versions.
RPM application The RPM local; C Il A Vulnerabilities moderate
application may remote may persist.
not be patched.
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Subcomponent

Adverse Action

Proximity

Adverse
Outcome

Unmitigated

Likelihood

other applications | Applications may | local; Unauthorized moderate
be installed on remote actors may
the device that exfiltrate data
include malicious from the device.
code.
other applications | Applications may | local; Unauthorized moderate
be installed on remote actors may
the device that exfiltrate data
include malicious from the device.
code.
onboard storage Onboard storage | local Device may low
media media may become
become damaged. inoperative or
unable to obtain
or transmit
biometric data.
removable media | A device that local Unauthorized low
allows removable software is
media may allow introduced on
code installation. the device.
camera The camera may local Images and moderate
become damaged, videos may not
rendering be obtained.
videoconferencing
inoperative.
camera Unauthorized remote Sensitive video moderate
actors may be data may be
able to exposed.
compromise
subsystems and
allow
unauthorized
control of camera
functions.
audio Audio local Audio low
microphone microphone may communication
become damaged. may not
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Subcomponent Adverse Action Proximity Adverse Unmitigated
Outcome Likelihood
function
appropriately.

Ethernet network | Ethernet port may | local A Wi-Fi low

port be damaged. communications
may be
inoperative.

Ethernet network | Ethernet local; C Data carried moderate

port communications remote over Wi-Fi may

may be be exposed to
compromised. unauthorized
individuals.

Wi-Fi Wi-Fi local A Wi-Fi low

communications communications communications

may be damaged. may be
inoperative.

Wi-Fi Wi-Fi local; C Data carried moderate

communications communications remote over Wi-Fi may

may be be exposed to
compromised. unauthorized
individuals.

C-7.2 Linking Threats to Adverse Actions

For the threat-modeling exercise, this practice guide examines concepts at a granular level. The exercise
examined the concept that threats may be evaluated at the subcomponent level through introduction of
adverse actions. The adverse actions that the threat-modeling exercise included in themselves do not
represent the enterprise threat environment but rather events that may occur that, in combination, may
be how threats are found in the three domains that the practice guide describes as composing the RPM
architecture.

Table C-14 Threat Event to Adverse Action Mapping

CIA Threat Event Attack Description Target Adverse Action

Component

C phishing A social engineering attack | interface device escalation of privilege
that solicits an authorized | mobile device

user to perform an action laptop
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CILA Threat Event

Attack Description

Target
Component

Adverse Action

that is beyond intended desktop
function. Phishing typically
is delivered via an email
that falsely claims
authenticity. A phishing
email may contain
payloads such as
attachments or links that
then run arbitrary code.
I, A unauthorized Unauthorized software biometric device | system integrity
software may include arbitrary code | interface device compromise: system
that compromises system laptop availability degraded
integrity or system desktop
stability.
I, A command and | Unauthorized software is biometric device | system integrity
control introduced that allows interface device compromise: system
unintended actors to laptop availability degraded
initiate connections to the desktop
target device.
A ransomware a form of unauthorized interface device system availability
software that prevents laptop degraded
legitimate access to the desktop
system and resources
C credential Unauthorized individuals interface device information exposure
escalation can leverage credentials laptop
and view sensitive data. desktop
I, A OSor Resource requests or interface device system integrity
application application of laptop compromise: system
disruption unauthorized software desktop availability degraded
may compromise the
integrity or stability of the
RPM application.
C data Unauthorized users may be | biometric device | information exposure
exfiltration able to remove sensitive interface device
data from the device. laptop
desktop
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While the project team was writing this practice guide, the National Institute of Standards and
Technology (NIST) published the NIST Privacy Framework, Version 1.0 [5]. Privacy concerns should be
addressed particularly in healthcare environments. This practice guide examined the NIST Privacy
Framework and included approaches that lead toward better understanding and managing the privacy
risks that may be present in remote patient monitoring (RPM) deployments.

Structurally, the NIST Privacy Framework is like the NIST Cybersecurity Framework. Both frameworks
should be applied when evaluating enterprise programs and developing mitigation strategies. Applying
the Privacy Framework does not supersede the NIST Cybersecurity Framework. Rather, the Privacy
Framework provides organizations with information to understand privacy-specific risks. For more
information about the NIST Privacy Framework, health delivery organizations (HDOs) should review NIST
Privacy Framework: A Tool for Improving Privacy through Enterprise Risk Management, Version 1.0 [5].

D-1 Privacy Risk Assessment Methodology (PRAM)

The practice guide applied the NIST Privacy Risk Assessment Methodology (PRAM) to conduct a privacy
risk assessment for the RPM architecture. The PRAM helps an organization analyze and communicate
about how it conducted its data processing to achieve business/mission objectives. The PRAM also uses
the privacy risk model and privacy engineering objectives described in NIST Internal Report 8062 [32] to
analyze potential problematic data actions. A problematic data action is an action that could cause an
adverse effect, or problem, for individuals. Processing can include collection, retention, logging, analysis,
generation, transformation or merging, disclosure, transfer, and disposal of data.

The occurrence or potential occurrence of problematic data actions is a privacy event. For this RPM
solution, the PRAM helped elucidate how RPM solutions can present privacy concerns for individuals.
The PRAM, being a risk assessment, also supports the risk assessment task in the Prepare step of the
NIST Risk Management Framework as discussed in Section C-1 of this guide. The privacy events
identified are discussed in Section D-2. A blank version of the PRAM is available for download on NIST’s
website [5]. When conducting the PRAM for this RPM solution, metadata was not assessed as it is out of
scope for this project; therefore, the PRAM will not help an organization with securing any possible
metadata in the event that it may be leaked on devices within the telehealth ecosystem. An organization
should consider the risk as a result of this incident occurring in their telehealth ecosystem. A blank
version of the PRAM is available for download on NIST’s website [32].

Figure D-1 depicts the privacy view of the RPM solution dataflow and was used to conduct the privacy
risk assessment.
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1315 Figure D-1 Privacy View of RPM Solution Dataflow
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1316 D-2 Problematic Data Actions and Mitigations

The NIST Privacy Framework refers to the concept of "problematic data actions", which derives from the
NIST Privacy Risk Assessment Methodology (PRAM). A problematic data action arises when any data
processed from systems may be compromised or lead to unintended consequences that could result to
problems for individuals. Problematic data actions have parallels to the concept of "threats" and
“vulnerabilities” in that they represent adverse consequences for individuals. The NIST Privacy
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Framework is intended to help organizations identify and mitigate problematic data actions. The
following sections discuss representative problematic data actions identified in the RPM architecture.

The discussion of problematic data actions in structured as follows:

=  Privacy Risk: descriptive name for the issue that can arise in the RPM solution

= Data action: the activity in the RPM solution’s data flow that may lead to a potential problem that
leads to the problematic data action described

=  Problematic Data Action: The type of problematic data action associated with the data action
patients (based on the NIST Catalog of Problematic Data Actions and Problems)

= Potential Problems for Individuals: Discussion regarding the nature of the problematic data action
and the specific privacy problems that can arise for patients (based on the NIST Catalog of
Problematic Data Actions and Problems)

=  Mitigations: Examples of mitigations for the problematic data action, including those this RPM
solution addresses as well as other mitigations organizations may wish to consider beyond the direct
capabilities built into their RPM solution.

D-2.1 Privacy Risk 1: Unauthorized individuals may access data on devices

Data Action: Patients’ readings are taken from the biometric device and collected by the RPM mobile
device and forwarded to the telehealth platform.

Problematic Data Action: Insecurity

Potential Problems for Individuals:

Data between all these devices may not be protected at rest or in transit. Data may include sensitive
information. Disclosure of this sensitive information could cause harm to the patient. Patient harm may
be realized as loss of reputation, embarrassment, or distrust of the RPM system.

Patients’ data not protected at rest or in transit may allow unauthorized individuals to view sensitive
information. In this event, someone other than the patient-approved individual can access data that is
unencrypted on the tablet or biometric device. The patient may experience dignity loss due to their
health information being exposed and may also experience loss of trust for the HDO and tablet.

Mitigation(s):
RPM Solution Mitigation:
Physical device security is out of scope for this lab solution.
Protect data at rest and in transit between devices and telehealth platforms.

Protecting data on the biometric device, e.g., by using encryption, prior to moving it to the
telehealth platform and using encrypted connections to protect the contents of data in transit
reduces the risk of exposure. Robust network security controls should be in place to help protect
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data in transit. For example, firewalls and network access control will help secure the data against
ransomware, malware and other attacks. If data are not encrypted, unauthorized individuals may be
able to retrieve the data which can lead to inappropriate use of information. Encryption methods
should be used in preventing health information disclosure.

Additional Privacy Mitigations for Organizations to Consider:
Develop and adopt enterprise encryption policies.

Policies should be created, developed and adopted for systematically categorizing and classifying
all healthcare data, no matter where the data are held.

D-2.2 Privacy Risk 2: Biometric device types can indicate patient health problems
that individuals would prefer not to disclose beyond their healthcare
provider

Data Action: Patients are provided one or more biometric devices that monitor biometric data, which
helps healthcare providers assess the physical health condition of the patient between visits with the
provider.

Problematic Data Action: Unanticipated Revelation

Potential Problems for Individuals: Patients with given medical conditions may use certain biometric
devices. Knowledge of the biometric devices that a patient is using, alone or in combination, can indicate
a particular health problem. For example, a glucometer can indicate that a patient is being monitored
for diabetes. This assumption could be more obvious if that same patient is also known to be using a
blood pressure monitor, weight scale, and activity tracker.

Patient sensitivities regarding their health status can vary widely. Unauthorized individuals who become
aware of the biometric device types and the values of the patient data may be able to determine the
patient's medical condition. Revealing a health condition that patients would prefer not to disclose or
disclosure of a patient's medical treatment and their course of treatment outside their healthcare
provider or can lead to dignity loss, such as embarrassment or emotional distress, and lead to loss of
trust in the HDO or provider and RPM system. This could damage the relationship with a patient,
including losing the opportunity to continue providing care. The likelihood of intercepting this kind of
data may be low from the cellular communications and is more likely to be realized through access to
data are information in the telehealth platform.

Mitigation(s):

RPM Solution Mitigation(s):
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Protect data transmitted between parties and in storage.

Data-in-transit protection, e.g., by encrypting communications channels, reduces the risk of
compromise of information transmitted between parties. Reducing the risk of compromise and any
resulting exposures reduces the risk of unintentional exposure of the information. Biometric devices
communicate through a mobile device that uses a Bluetooth connection, and the RPM solution
assumes that these devices are deployed using an appropriate encryption mode [31]. The RPM
solution uses devices that are equipped to communicate over 4G long-term evolution (LTE), which
uses asymmetric encryption between the device and the cellular tower. Additionally, all data at rest
is protected with AES256 encryption.

Limit or disable access to data.

Conduct a system-specific privacy risk assessment to determine how access to data in the telehealth
platform provider can be limited. Using access controls to limit staff access to biometric and patient
data can be important in preventing associating health conditions with specific individuals.

D-2.3 Privacy Risk 3: Incorrect data capture of readings by devices may impact
quality of patient care

Data Action: The RPM solution relies on the patient to take readings by using the patient’s assigned
biometric device(s) when required according to their care plan.

Problematic Data Action Distortion

Potential Problems for Individuals: Devices may be inaccurately applied by the patient (e.g., not
properly using or inadvertently changing settings) which can impact the ability of a biometric device to
take proper readings. Anomalies may also be introduced by other individuals who may have physical
access to the device (e.g., allowing someone other than the patient to use the device), which may
introduce biometric readings other than the patient's into the system. Data integrity may be
compromised, causing confusion regarding the patient’s actual health and possibly leading to physical
harm.

Mitigation(s):
RPM Solution Mitigation(s):

Physical device security is out of scope for this lab solution. Ultimately, responsibility for monitoring
patient data, including identifying anomalies, falls on the clinician.

Additional Privacy Mitigations for Organizations to Consider:

Educate patients regarding practices for handling biometric device(s) and the importance of
following their monitoring plan.
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Educating patients regarding how their interactions with the biometric devices assigned to them
affect the quality of the data provided to the telehealth platform provider, HDO, healthcare
provider, and ultimately the quality of care they receive and their health safety will encourage them
to use the biometric devices as designed and intended.

D-2.4 Privacy Risk 4: Aggregated data may expose patient information

Data Action: Patients use one or more biometric devices to monitor the condition of their health. The
biometric data generated is transmitted through multiple entities, including cellular or broadband
internet providers, biometric device vendors, telehealth platform providers, cloud service providers, and
HDOs before reaching the healthcare provider.

Problematic Data Action: Re-identification

Potential Problems for Individuals: The RPM architecture integrates data from multiple organizations
each of which may have different data that pertains to the patient. The biometric data generated by the
solution indicates an individual’s health status. Aggregation of biometric data with patient identifiers
associates information about patients that, if revealed to an entity other than their healthcare provider
and care team, may result in dignity losses, such as embarrassment or emotional distress, as well as loss
of trust in the HDO and provider.

Mitigation(s):
RPM Solution Mitigation(s):
Combine biometric data with patient identifiers only when operationally required.

The RPM solution is configured so that only biometric data and device information are transmitted
between the patient and either the biometric device vendor or, and onward from the biometric
device vendor or RPM interface to the telehealth platform providers without patient identifiers. It is
not associated with patient identifiers in the RPM solution until it is operationally necessary, in this
case when the data reaches the telehealth platform providers. The telehealth platform providers
use a biometric device identification (ID) to correlate the biometric data that a device transmits with
a patient to perform analytics that enable providers to manage the patient’s care.

Protect data transmitted between parties and in storage.

Data protection, e.g., by using encryption, reduces the risk that compromised data can be easily
used and combined with other data to re-identify patients. Biometric devices communicate through
a mobile device that uses Bluetooth connections and the RPM solution assumes that these devices
are deployed using an appropriate encryption mode. The RPM solution uses devices that are
equipped to communicate over 4G LTE, which uses asymmetric encryption between the device and
the cellular tower. Additionally, all data at rest is protected with AES256 encryption.
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D-2.5 Privacy Risk 5: Exposure of patient information through multiple providers of
system components

Data Action: Data about individuals and their devices flows between various applications and analytical
tools, some of which are managed by third parties.

Problematic Data Action: Unanticipated Revelation

Potential Problems for Individuals: Multiple organizations work together to provide individual
components of the RPM solution and each organization that plays a role in data processing represents
an exposure point for patient information. Patient biometric data from devices travels to the HDO
through device vendors and telehealth platform providers over cellular and broadband networks. Some
of the data also flows through cloud solutions. These third parties beyond the HDO and patient’s
provider may conduct system monitoring, analytics, and other operational activities as part of the
solution. System administrators have access to otherwise private healthcare information through
knowledge of biometric device types and the data they generate which may reveal information about
patients that results in dignity losses, such as embarrassment or emotional distress.

Data transmission about patients and their biometric devices among a variety of different parties could
be confusing for patients who might not know who has access to information about them. This
transmission could reveal personal information about the patient to parties they would not expect to
have such information. This lack of patient visibility and awareness of data-sharing practices may also
cause patient loss of trust in the provider.

Mitigation(s):
RPM Solution Mitigation(s):
Combine biometric data with patient identifiers only when operationally required.

The RPM solution is configured so that only biometric data and device information are transmitted
between the patient and either the biometric device vendor or, and onward from the biometric
device vendor or RPM interface to the telehealth platform providers without patient identifiers. It is
not associated with patient identifiers in the RPM solution until it is operationally necessary, in this
case when the data reaches the telehealth platform providers. The telehealth platform providers
use a biometric device ID to correlate the biometric data that a device transmits with a patient to
perform analytics that enable providers to manage the patient’s care.

Protect data transmitted between parties and in storage.

Data protection, e.g., using encryption, reduces the risk of compromise of information transmitted
between parties. Biometric devices communicate through a mobile device that uses Bluetooth
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connections, and the RPM solution assumes that these devices are deployed using an appropriate
encryption mode. The RPM solution uses devices that are equipped to communicate over 4G LTE,
which uses asymmetric encryption between the device and the cellular tower. Additionally, all data
at rest is protected with AES256 encryption.

Limit or disable collection of specific data elements.

Conduct a system-specific privacy risk assessment to determine what elements can be limited. The
RPM solution sends only biometric and device data from the device to RPM interface and vendors

and excludes identifying information about the patient. This would limit insight into patient health

status by outsiders or telehealth platform provider administrators if the security of the information
is compromised.

Additional Privacy Mitigations for Organizations to Consider:
Limit or disable access to data.

Conduct a system-specific privacy risk assessment to determine how access to data can be limited.
Using access controls to limit staff access to compliance information, especially when associated
with patients, can be important in preventing association of specific biometric data with particular
individuals.

Use contracts to limit third-party data processing.

Establish contractual policies to limit data processing by third parties to only the processing that
facilitates delivery of security services and to no data processing beyond those explicit purposes.

D-3 Mitigations Applicable Across Various Data Actions

Several mitigations benefit patients in multiple data actions were identified in the privacy risk
assessment. As part of their own risk assessment process, organizations that deploy RPM solutions will
determine what mitigations are most appropriate for their environment. This section includes several
examples of mitigations that may be common and is not intended to be all-encompassing.

Mitigations:

Ensure that privacy notices address end-to-end dataflows in the RPM solution between patient and
provider.

RPM solutions empower patients as active participants in their healthcare. Privacy notices— information
such as the data collected about the patient, the reason it is collected, how it is processed by an
organization, how it is protected, and how long an organization plans to use it—are one way that HDOs
can help patients understand their relationship and expectations with an organization. Privacy notices
are also a precursor to requesting consent so that patients understand what agreements they are

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 123



1497
1498
1499
1500
1501
1502
1503
1504
1505
1506

1507

1508
1509
1510

1511

1512
1513
1514
1515
1516

DRAFT

making. Effective notices that cover the RPM solution should be specific enough to help patients
understand the PRM solution and should be written in clear terms that are easily understood by any
individuals (i.e., individuals do not need healthcare, RPM, or privacy expertise to interpret the privacy
notice). Patients may not be aware of or easily able to discern what is happening with the information
generated by their biometric device(s), such as analytics and trend analyses that telehealth platform
providers can conduct and how a provider may use this information for their care. Information regarding
the RPM solution that includes a discussion of privacy helps patients better understand how the system
processes their data, which enhances predictability. One example of providing an effective RPM privacy
notice would be to create an RPM website or pamphlet, separate from the overall operational privacy
notice that an HDO may have, that explains the RPM program.

Provide a support point of contact.

Providing patients with a point of contact in the organization who can respond to privacy inquiries and
concerns regarding the RPM solution helps patients better understand how the system processes their
data, which enhances predictability.

Define and communicate clear retention policies.

To minimize security and privacy risk to patients (e.g., making a decision based on aged data that could
impact the quality of care provided through an RPM solution), HDOs should use the results of their risk
assessment to determine how each solution component impacts their retention policies for each step in
the dataflow process and clearly communicate its needs to all entities responsible for supporting the
HDO in managing privacy risks associated with data retention.
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This practice guide deployed biometric devices to the patient home that used cellular data
communications to transmit data. This practice guide did not implement devices that used broadband
internet connectivity. As a future build consideration, this practice guide examined the use of Layer 2-
over-Layer-3 solutions to secure biometric devices that communicate over broadband communications.

Networking professionals often refer to the Open Systems Interconnection (OSI) model when
implementing network protocols. The International Organization for Standardization and International
Electrotechnical Commission (ISO/IEC) describes the OSI model as consisting of seven layers called
Application, Presentation, Session, Transport, Network, Data Link, and Physical, where layers are
numerically ordered in reverse. That is, the Application Layer is regarded as Layer 7, whereas the
Physical Layer is regarded as Layer 1, a proof of concept to secure network sessions between the patient
home and the telehealth platform provider [34].

Layer 2 aligns with the OSI model’s Data link layer. Devices operating at Layer 2 have Media Access
Control (MAC) addresses by which devices, such as biometric devices, may communicate across a local
area network (LAN) segment. Layer 3 aligns with the OSI model’s Network layer. Devices implement the
Network layer with Internet Protocol (IP) addresses. Layer 2 over Layer 3 solutions enable devices that
do not implement the Network layer to have broader interconnectivity. Layer 2 over Layer 3 solutions
provide security by limiting access to devices and securing the data-in-transit communications, e.g., with
encryption. Layer 2 over Layer 3 solutions may be used to create secure enclaves, grouping small
numbers of devices that may require enhanced network security. Creating secure enclaves aligns with
the concept of micro-segmentation.

Organizations may consider Layer 2 over Layer 3 solutions for devices that may be prone to internet
threats. Biometric devices may implement Layer 2 and Layer 3 interconnectivity; however, they do not
have robust controls that prevent unauthorized remote access. Secure enclaves may be created that
encapsulate biometric devices with other devices when secure cross communication is required.

This practice guide deployed a micro-segmentation solution as part of a proof of concept within the
healthcare lab. In collaboration with Onclave Networks, NCCoE implemented a Layer 2 over Layer 3
solution. The practice guide anticipated a scenario whereby biometric devices hosted in the patient
home could securely communicate with systems at the telehealth platform provider or HDO by using
secure enclaves.

Practitioners should refer to NIST SP 800-207, Zero Trust Architecture for guidance [35] . NIST SP 800-
207 describes an enclave gateway model that may be applied to a telehealth RPM architecture. In the
enclave gateway model, a zero trust solution operates in two conceptual planes: a Control and a Data
plane. Micro-segmentation management devices operate in a control plane. These management devices
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provide administrative and policy capabilities to support secure enclaves. Operational components, such
as biometric devices, telehealth platform provider services, and HDO-hosted devices, may operate in the
data plane. Figure E-1 depicts the enclave gateway model.

Figure E-1 Enclave Gateway Model [35]

—
R

Control Plane

Data Plane

Subject »

Data Resource

The Onclave Networks solution, depicted in Figure E-2, adheres to NIST SP 800-207’s Enclave Gateway
Model and includes several components in the control plane: an Onclave Administrative Console, an
Onclave Orchestrator Console, and an Onclave Secure Blockchain (OSB). Referring to Figure E-1, the
Onclave Networks solution implements the Policy Administrator concept by using an Onclave
Administrative Console and an OSB. The Onclave Administrative Console provides identity management
capabilities, including management of biometric devices, gateways, and bridges. OSB then stores
identity data as cipher keys. The Onclave Orchestrator Console aligns with the Policy Engine concept
depicted in Figure E-1 while the Onclave Bridge aligns with the enterprise system agent concept,
establishing trust between itself and the gateway devices. Finally, Onclave Gateway aligns with the
gateway concept and represents endpoints that participate in the secure enclave environment.

NIST SP 1800-30B: Securing Telehealth Remote Patient Monitoring Ecosystem 126



1566

1567
1568
1569
1570

DRAFT

Figure E-2 Onclave Networks Solution
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Figure E-3 shows a notional method by which the Onclave Networks solution may be applied to

pathways that were described in Section 4.2, High-Level Architecture Communications Pathways. The

solution encapsulates biometric data that may be sourced from the patient and then sent to the
telehealth platform provider by using a broadband internet connection at the patient’s home.
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1571  Figure E-3 Onclave Zero Trust Platform for Remote Patient Monitoring
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1572  This practice guide deployed the Onclave Networks solution as a future build consideration to include
1573 biometric devices that may use a broadband internet connection. The solution takes advantage of the
1574 NIST zero trust architecture and separates biometric data from the patient home network to then
1575  securely transmit the data to the telehealth platform provider. Healthcare practitioners who provide
1576 services to remote patients who may use broadband internet connectivity should refer to NIST SP 800-

1577 207 [34] for further guidance.
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intended to imply that the entities, equipment, products, or materials are necessarily the best available
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own organization, we ask you and your colleagues to share your experience and advice with us.

Comments on this publication may be submitted to: hit nccoe@nist.gov.

Public comment period: November 16, 2020 through December 18, 2020

As a private-public partnership, we are always seeking feedback on our practice guides. We are
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you
have implemented the reference design, or have questions about applying it in your environment,
please email us at hit nccoe@nist.gov.

All comments are subject to release under the Freedom of Information Act.

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
100 Bureau Drive
Mailstop 2002
Gaithersburg, MD 20899

Email: nccoe@nist.gov
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The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and
academic institutions work together to address businesses’ most pressing cybersecurity issues. This
public-private partnership enables the creation of practical cybersecurity solutions for specific
industries, as well as for broad, cross-sector technology challenges. Through consortia under
Cooperative Research and Development Agreements (CRADAs), including technology partners—from
Fortune 50 market leaders to smaller companies specializing in information technology security—the
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity
solutions using commercially available technology. The NCCoE documents these example solutions in
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework
and details the steps needed for another entity to re-create the example solution. The NCCoE was
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County,
Maryland.

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit
https://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the
adoption of standards-based approaches to cybersecurity. They show members of the information
security community how to implement example solutions that help them align with relevant standards
and best practices, and provide users with the materials lists, configuration files, and other information
they need to implement a similar approach.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. These documents do not describe regulations
or mandatory practices, nor do they carry statutory authority.

Increasingly, healthcare delivery organizations (HDOs) are relying on telehealth and remote patient
monitoring (RPM) capabilities to treat patients at home. RPM is convenient and cost-effective, and its
adoption rate has increased. However, without adequate privacy and cybersecurity measures,
unauthorized individuals may expose sensitive data or disrupt patient monitoring services.

RPM solutions engage multiple actors as participants in a patient’s clinical care. These actors include
HDOs, telehealth platform providers, and the patients themselves. Each participant uses, manages, and
maintains different technology components within an interconnected ecosystem, and each is
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responsible for safeguarding their piece against unique threats and risks associated with RPM
technologies.

This practice guide assumes that the HDO engages with a telehealth platform provider that is a separate

entity from the HDO and patient. The telehealth platform provider manages a distinct infrastructure,
applications, and set of services. The telehealth platform provider coordinates with the HDO to
provision, configure, and deploy the RPM components to the patient home and assures secure
communication between the patient and clinician.

The NCCoE analyzed risk factors regarding an RPM ecosystem by using risk assessment based on the

NIST Risk Management Framework. The NCCoE also leveraged the NIST Cybersecurity Framework, NIST
Privacy Framework, and other relevant standards to identify measures to safeguard the ecosystem. In
collaboration with healthcare, technology, and telehealth partners, the NCCoE built an RPM ecosystem
in a laboratory environment to explore methods to improve the cybersecurity of an RPM.

Technology solutions alone may not be sufficient to maintain privacy and security controls on external

environments. This practice guide notes the application of people, process, and technology as necessary
to implement a holistic risk mitigation strategy.

This practice guide’s capabilities include helping organizations assure the confidentiality, integrity, and

availability of an RPM solution, enhancing patient privacy, and limiting HDO risk when implementing an
RPM solution.

access control; authentication; authorization; behavioral analytics; cloud storage; data privacy; data

security; encryption; HDO; healthcare; healthcare delivery organization; remote patient monitoring;

RPM; telehealth

We are grateful to the following individuals for their generous contributions of expertise and time.
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Steve Waite The University of Mississippi Medical Center
Dele Atunrase Vivify Health
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Robin Hill Vivify Health
Dennis Leonard Vivify Health
David Norman Vivify Health
Bill Paschall Vivify Health
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The collaborators who participated in this build submitted their capabilities in response to a notice in

the Federal Register. Respondents with relevant capabilities or product components were invited to sign

a Cooperative Research and Development Agreement (CRADA) with NIST, allowing them to participate

in a consortium to build this example solution. We worked with:

Technology Partner/Collaborator

Accuhealth

Build Involvement

Accuhealth Evelyn

Cisco

Cisco Firepower Version 6.3.0
Cisco Umbrella
Cisco Stealthwatch Version 7.0.0

Inova Health System
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Technology Partner/Collaborator Build Involvement

LogRhythm LogRhythm XDR Version 7.4.9
LogRhythm NetworkXDR Version 4.0.2

MedCrypt subject matter expertise

MedSec subject matter expertise

Onclave Networks Inc. (Onclave) Onclave Zero Trust Platform

Tenable Tenable.sc Vulnerability Management Version 5.13.0 with
Nessus

The University of Mississippi Medical subject matter expertise

Center

Vivify Health Vivify Pathways Home
Vivify Pathways Care Team Portal
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The following volumes of this guide show information technology (IT) professionals and security
engineers how we implemented this example solution. We cover all of the products employed in this
reference design. We do not re-create the product manufacturers’ documentation, which is presumed
to be widely available. Rather, these volumes show how we incorporated the products together in our
environment.

Note: These are not comprehensive tutorials. There are many possible service and security configurations
for these products that are out of scope for this reference design.

1.1 How to Use this Guide

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a
standards-based reference design and provides users with the information they need to replicate the
telehealth remote patient monitoring (RPM) environment. This reference design is modular and can be
deployed in whole or in part.

This guide contains three volumes:

= NIST SP 1800-30A: Executive Summary
= NIST SP 1800-30B: Approach, Architecture, and Security Characteristics — what we built and why

= NIST SP 1800-30C: How-To Guides — instructions for building the example solution (you are
here)

Depending on your role in your organization, you might use this guide in different ways:

Business decision makers, including chief security and technology officers, will be interested in the
Executive Summary, NIST SP 1800-30A, which describes the following topics:

= challenges that enterprises face in securing the remote patient monitoring ecosystem
= example solution built at the NCCoE
= benefits of adopting the example solution

Technology or security program managers who are concerned with how to identify, understand, assess,
and mitigate risk will be interested in NIST SP 1800-30B, which describes what we did and why. The
following sections will be of particular interest:

= Section 3.4, Risk Assessment, describes the risk analysis we performed.

=  Section 3.5, Security Control Map, maps the security characteristics of this example solution to
cybersecurity standards and best practices.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 1
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You might share the Executive Summary, NIST SP 1800-30A, with your leadership team members to help
them understand the importance of adopting standards-based commercially available technologies that
can help secure the RPM ecosystem.

IT professionals who want to implement an approach like this will find this whole practice guide useful.
You can use this How-To portion of the guide, NIST SP 1800-30C, to replicate all or parts of the build
created in our lab. This How-To portion of the guide provides specific product installation, configuration,
and integration instructions for implementing the example solution. We do not recreate the product
manufacturers’ documentation, which is generally widely available. Rather, we show how we
incorporated the products together in our environment to create an example solution.

This guide assumes that IT professionals have experience implementing security products within the
enterprise. While we have used a suite of commercial products to address this challenge, this guide does
not endorse these particular products. Your organization can adopt this solution or one that adheres to
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing
parts of the National Cybersecurity Center of Excellences’ (NCCoE’s) risk assessment and deployment of
a defense-in-depth strategy in a distributed RPM solution. Your organization’s security experts should
identify the products that will best integrate with your existing tools and IT system infrastructure. We
hope that you will seek products that are congruent with applicable standards and best practices.
Section 3.6, Technologies, lists the products that we used and maps them to the cybersecurity controls
provided by this reference solution.

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and
success stories will improve subsequent versions of this guide. Please contribute your thoughts to

hit nccoe@nist.gov.

Acronyms used in figures are in the List of Acronyms appendix.

1.2 Build Overview

The NCCoE constructed a virtual lab environment to evaluate ways to implement security capabilities
across an RPM ecosystem, which consists of three separate domains: patient home, telehealth platform
provider, and healthcare delivery organization (HDO). The project implements virtual environments for
the HDO and patient home while collaborating with a telehealth platform provider to implement a
cloud-based telehealth RPM environment. The telehealth environments contain simulated patient data
that portray relevant cases that clinicians could encounter in real-world scenarios. The project then
applies security controls to the virtual environments. Refer to NIST Special Publication (SP) 1800-308B,
Section 5, Security Characteristic Analysis, for an explanation of why we used each technology.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 2
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1.3 Typographic Conventions

The following table presents typographic conventions used in this volume.

Typeface/Symbol Meaning Example
Italics file names and path names; For language use and style guidance,
references to documents that | see the NCCoE Style Guide.
are not hyperlinks; new
terms; and placeholders
Bold names of menus, options, Choose File > Edit.
command buttons, and fields
Monospace command-line input, mkdir

onscreen computer output,
sample code examples, and
status codes

Monospace Bold

command-line user input
contrasted with computer
output

service sshd start

blue text

link to other parts of the
document, a web URL, or an
email address

All publications from NIST’s NCCoE
are available at
https://www.nccoe.nist.gov.

1.4 Logical Architecture Summary

Figure 1-1 illustrates the reference network architecture implemented in the NCCoE virtual
environment, initially presented in NIST SP 1800-30B, Section 4.5, Final Architecture. The HDO

environment utilizes network segmenting similar to the architecture segmentation used in NIST SP 1800-
24, Securing Picture Archiving and Communication System (PACS) [1]. The telehealth platform provider is
a vendor-managed cloud environment that facilitates data transmissions and communications between
the patient home and the HDO. Patient home environments have a minimalistic structure, which

incorporates the devices provided by the telehealth platform provider.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem
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179  Figure 1-1 Final Architecture
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181  This section of the practice guide contains detailed instructions for installing and configuring all the
182 products used to build an instance of the example solution. This practice guide implemented several
183 capabilities that included deploying components received from telehealth platform providers and

184  components that represent the HDO. The telehealth platform providers provisioned biometric devices
185  that were deployed to a patient home environment. Within the HDO, this practice guide deployed
186 network infrastructure devices to implement network zoning and configure perimeter devices. This

187  practice guide also deployed security capabilities that supported vulnerability management and a
188  security incident event management (SIEM) tool. The following sections detail deployment and

189  configuration of these components.

190 2.1 Telehealth Platform Provider

191  This practice guide implemented a model where an HDO partners with telehealth platform providers to
192 enable RPM programs. Telehealth platform providers are third parties that, for this practice guide,
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configured, deployed, and managed biometric devices and mobile devices (e.g., tablets) that were sent
to the patient home. The telehealth platform provider managed data communications over cellular data
where patients send biometric data to the telehealth platform provider. The telehealth platform
provider implemented an application that allowed clinicians to access the biometric data.

This practice guide collaborated with two independent telehealth platform providers. Collaborating with
two unique platforms enabled the team to apply NIST’s Cybersecurity Framework [2] to multiple
telehealth platform implementations. One platform provides biomedical devices enabled with cellular
data. These devices transmitted biometric data to the cloud-based telehealth platform. The second
platform provider deployed biometric devices enabled with Bluetooth wireless technology. Biometric
devices communicated with an interface device (i.e., a tablet). The telehealth platform provider
configured the interface device by using a mobile device management solution, limiting the interface
device’s capabilities to those services required for RPM participation. The patient transmitted biometric
data to the telehealth platform provider by using the interface device. The interface device transmitted
data over cellular data communications. Both telehealth platform providers allowed HDOs to access
patient data by using a web-based application. Both platforms implemented unique access control
policies for access control, authentication, and authorization.

2.1.1 Accuhealth

Accuhealth provided biometric devices that included cellular data communication. Accuhealth also
included a cloud-hosted application for HDOs to access patient-sent biometric data. Accuhealth
provisioned biomedical devices with subscriber identity module (SIM) cards that enabled biomedical
devices to transmit data via cellular data communications to the Accuhealth telehealth platform.
Accuhealth stored patient-transmitted data in an application. Individuals assigned with clinician roles
accessed transmitted data hosted in the Accuhealth application. The biomedical data displayed in the
following screen captures are notional in nature and do not relate to an actual patient.

2.1.1.1 Patient

This practice guide assumed that the HDO enrolls the patient in an RPM program. Clinicians would
determine when a patient may be enrolled in the program appropriately, and conversations would occur
about understanding the roles and responsibilities associated with participating in the RPM program.
When clinicians enrolled patients in the RPM program, the HDO would collaborate with Accuhealth.
Accuhealth received patient contact information and configured biometric devices appropriate for the
RPM program in which the patient was enrolled. Accuhealth configured biometric devices to
communicate via cellular data. Biometric devices, thus, were isolated from the patient home network
environment. Accuhealth assured device configuration and asset management.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 5
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226 2.1.1.2 HDO

227  The Accuhealth solution includes installing an application within the HDO environment. Clinicians access
228 a portal hosted by Accuhealth that allows a clinician to view patient biometric data. The application

229  requires unique user accounts and role-based access control. System administrators create accounts and
230 assign roles through an administrative console. Sessions from the clinician to the hosted application use

231 encryption to ensure data-in-transit protection.

232 This section discusses the HDO application installation and configuration procedures.

233 1. Access a device that has a web browser.

234 2. Navigate to accuhealth login page and provide a Username and Password. The following
235 screenshots show a doctor’s point of view in the platform.

236 3. Click LOGIN.

accuhealth.

Email Address or Username

Password

Keep me signed in

INFO | FORGOT PASSWORD | HELP

237 After logging in, the Patient Overview screen displays.
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238 4. To view patients associated with the account used to log in, navigate to the View Select drop-
239 down list in the top left corner of the screen, and select My Patients.

Patient Overview
View Seioct
My Patients - | x
Un-Actioned Critical Readings Un-Actioned Al-Risk Readings Fallowed Patients
2m ag0
Critical / Al-Risk Patient Readings
Prone Numser Fovew Riview
Time Staws . Patieat £ Categeey Paramater 3 Comments & Folowing + Reading * Detaits +
Critical # Detected: 182 bpa o coments yet [ ] E=
Critical [TTEPCRINER 3 Hemrt A Kigh Feart Rate Detected: 102 bps o comments yet ) l:l
Critical Hart Hate Figh keart Hate Uetected: 182 bpe fo comments yet [ ] |

240 5. Click a Patient to display the Patient Details page, which displays all patient biomedical
241 readings.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem



242
243

244

245

246

DRAFT

Patient Details

Select Patient Tirse Range
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To leave a comment on a reading, click no comments yet under the Comments column on the
row of the reading to which the comment refers.

A Comment screen displays that allows free text input.
Click Comment.

Click Close.

Comment

“Untitled - Notepad
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10. To have a call with a patient, click Request an Appointment in the top left of the Patient Details
page.

11. A notification box displays, asking if the Home Health Agency needs to schedule an appointment
with the patient.

12. Click OK.

B Paticnt Dotails | Accuhealth 800 %X 4

= C @& rpmaccub

Patien Details

Patient Details

2.1.2 Vivify Health

Vivify provided biometric and interface devices (i.e., Vivify provisioned a tablet device) and a cloud-
hosted platform. Vivify enabled biometric devices with Bluetooth communication and provisioned
interface devices with SIM cards. Individuals provisioned with patient roles used the interface device to
retrieve data from the biometric devices via Bluetooth. Individuals acting as patients then used the
interface device to transmit data to Vivify using cellular data. Vivify’s application presented the received
data. Individuals provisioned with clinician roles accessed the patient-sent data stored in the Vivify
application via a web interface.

2.1.2.1 Patient

This practice guide assumed that the HDO enrolls the patient in an RPM program. Clinicians would
determine when a patient may be enrolled in the program appropriately, and conversations then occur
about understanding the roles and responsibilities associated with participating in the RPM program.
When clinicians enroll patients in the RPM program, the HDO would collaborate with Vivify. Vivify
received patient contact information and configured biometric devices and an interface device (i.e.,
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tablet) appropriate for the RPM program in which the patient was enrolled. Vivify assured device
configuration and asset management.

2.1.2.2 HDO

The Vivify solution includes installing an application within the HDO environment. Clinicians access a
portal hosted by Vivify that allows a clinician to view patient biometric data. The application requires
unique user accounts and role-based access control. System administrators create accounts and assign
roles through an administrative console. Sessions from the clinician to the hosted application use
encryption to ensure data-in-transit protection.

This section discusses the HDO application installation and configuration procedures.
1. Access a device that has a web browser.

2. Navigate to https://demonccoerpm.vivifyhealth.com/CaregiverPortal/index.html#/Login and
provide the Username and Password of the administrative account provided by Vivify.

3. Click Login.

Remote Patient Monitoring

Log in to shape lives.

Login

4. Navigate to the Care Team menu item on the left-hand side of the screen.

Click + New User.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem
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282 5. Inthe New User screen provide the following information:

283 a. First Name: Test

284 b. Last Name: Clinician

285 c. User Name: TClinicianl

286 d. Password: *#xkkkkokkx

287 e. Confirm Password: ***#x#xkxx

288 f. Facilities: Vivify General

289 g. Sites: Default

290 h. Roles: Clinical Level 1, Clinical Level 2

291 i.  Email Address: *****xkkxk

292 j- Mobile Phone; ***#***x:x*

293 6. Click Save Changes.

294 7. Navigate to Patients in the left-hand menu bar.

295 8. Select the NCCoE, Patient record.

296 9. Under Care Team, click the notepad and pencil in the top right of the box.
297 10. In the Care Team window, select Clinician, Test and click Ok.

298 11. Logout of the platform.

299 12. Login to the platform using the Test Clinician credentials and click Login.
300 13. Click the NCCoE, Patient record.

301 14. Navigate to the Monitoring tab to review patient readings.

302 15. Based on the patient’s data, the clinician needs to consult the patient.
303 16. Click the ellipsis in the NCCoE, Patient menu above the green counter.
304 17. Select Call Patient.

305 18. In the Respond to Call Request screen, select Phone Call Now.

306 19. After the consultation, record the action items performed during the call.
307 20. In the Monitoring window, click Accept All under the Alerts tab to record intervention steps.
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21. In the Select Intervention window, select the steps performed to address any patient alerts.
22. Click Accept.

23. Navigate to Notes to review recorded interventions or add other clinical notes.

2.2 Security Capabilities

The following instruction and configuration steps depict how the NCCoE engineers along with project
collaborators implemented provided cybersecurity tools to achieve the desired security capabilities
identified in NIST SP 1800-30B, Section 4.4, Security Capabilities.

2.2.1 Risk Assessment Controls

Risk assessment controls align with the NIST Cybersecurity Framework’s ID.RA category. For this practice
guide, the Tenable.sc solution was implemented as a component in an HDO’s risk assessment program.
While Tenable.sc includes a broad functionality set, this practice guide leveraged Tenable.sc’s
vulnerability scanning and management capabilities.

2.2.1.1 Tenable.sc

Tenable.sc is a vulnerability management solution. Tenable.sc includes vulnerability scanning and
configuration checking, which displays information through a dashboard graphical user interface.
Tenable.sc’s dashboard includes vulnerability scoring, enabling engineers to prioritize patching and
remediation. This practice guide used Tenable.sc to manage a Nessus scanner, which performed
vulnerability scanning against HDO domain-hosted devices. While the Tenable.sc solution includes
configuration-checking functionality, this practice guide used the solution for vulnerability management.

System Requirements

Central Processing Unit (CPU): 4
Memory: 8 gigabytes (GB)
Storage: 250 GB

Operating System: CentOS 7
Network Adapter: VLAN 1348

Tenable.sc Installation

This section discusses installation of the Tenable.sc vulnerability management solution.
1. Import the Tenable.sc open virtual appliance or appliance (OVA) file to the virtual environment.

2. Assign the virtual machine (VM) to VLAN 1348.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 12



337

338
339

340

341

342

343

344

345

346
347

348

DRAFT

3. Start the VM and document the associated internet protocol (IP) address.

4. Open a web browser that can talk to virtual local area network (VLAN) 1348 and navigate to the
VM’s IP address.

5. For the first login, use wizard as the Username and admin for the Password.
6. Tenable.sc prompts a popup window for creating a new admin username and password.
7. Repeat step 5 using the new username and password.

a. Username: admin

b. Password: ****#xkxkx

c. Check the box beside Reuse my password for privileged tasks.

tenable

Lser name

adrmin

Password

Reuse my password for privileged tasks

A Feguired for agdmin usage

8. After logging in, the Tenable Management Console page displays.

9. Click the Tenable.sc menu option on the left side of the screen.

10. To access Tenable.sc, click the IP address next to the uniform resource locator (URL) field.
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- tenable-0xata384

Tenable.sc™

System
ﬁ System Log
Metworking
Storage URL:  https://192.168.45.101:443
Accounts

License:  License is valid and expires in 315 days (Expires Menday, June
Services 21st, 2021, 8:00:00 PM).

Diagnostic Reports
Service Status:  Running Stop | Restart

Terminal

Remote Storage Challenge  6485cfa9c5b6358fc9705ea336b50baf669b15f7
Code:

Tenable.sc

Daemons  httpd

Update Management
Running:

SSL/TLS Certificates Jobd.php
Backup/Restore Application  5.15.0
SNMP Version:

Software Updates Build ID: 202007153999

RPM Version: 5.15.0

349 11. Log in to Tenable.sc using the credentials created in previous steps, and click Sign In.
350 a. Username: admin
351 b. Password; *#**¥kkx
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12.

13.

14.

15.

16.

17.
18.

19.

( )tenable.sc

admin

P

O tenable

After signing in, Tenable.sc’s web page displays.

Navigate to the System drop-down list in the menu ribbon.
Click Configuration.
Under Tenable.sc License, click Upload next to License File.

Navigate to the storage location of the Tenable.sc license key obtained from a Tenable
representative and select the key file.

Click OK.
Click Validate.

When Tenable.sc accepts the key, a green Valid label will display next to License File.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem
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\ " tenable.SC  Dashboard  Resources~  Repositories~  Organizations ~ Users «

License Configuration

Tenable.sc License

|P Limit 64 ( 0 currently active )

Type Subscription

Expiration Jun 21, 2021 20:00

Licensee National Cybersecurity Center of Excellence (NCCOE)
Hostname tenable-Oxata384

License File m Update License

361 20. Under Additional Licenses, input the Nessus license key provided by a Tenable representative
362 next to Nessus Scanner.
363 21. Click Register.
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Repositories = Organizations Users Scanning * System =

Tenable.sc License

IP Limit 64 ( 0 currently active
Type Sut
Expiration un 21. 2021 20:00

Licensee Nationa

Hostname tenable-Oxata384

License File m Jpdate

Additional Licenses

nessus | |

Scanner

364  Tenable.sc Configuration

365  This practice guide leveraged support from Tenable engineers. Collectively, engineers installed

366  Tenable.sc and validated license keys for Tenable.sc and Nessus. Engineers created Organization,
367 Repository, User, Scanner, and Scan Zones instances for the HDO lab environment. The configuration
368  steps are below.

369 Add an Organization

370 1. Navigate to Organizations in the menu ribbon.

371 2. Click +Add in the top right corner of the screen. An Add Organization page will appear.
372 3. Name the Organization RPM HDO and leave the remaining fields as their default values.
373 4. Click Submit.
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Otenable.sc'

Dashboard Resources = Repositories + Organizations u

General

Name* RPM HDO

Add a Repository

1. Navigate to the Repositories drop-down list in the menu ribbon.
2. Click +Add in the top right corner of the screen. An Add Repository screen displays.

3. Under Local, click IPv4. An Add IPv4 Repository page displays. Provide the following
information:

a. Name: HDO Repository
b. IP Ranges: 0.0.0.0/24
¢. Organizations: RPM HDO

4. Click Submit.
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( )tenable.sc  pashboara

Add IPv4 Repository

General

Name*

Description

Data

IP Ranges”

Access

Organizations

Resources v

HDO Repository

0.0.0.0/24

Search

& RPM HDO

Repositories v

Organizations

Add a User

1. Navigate to the Users drop-down list in the menu ribbon.

2. Select Users.

3. Click +Add in the top right corner. An Add User page displays. Provide the following information:

a. Role: Security Manager

b. Organization: RPM HDO

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem
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First Name: Test

Last Name: User

Username: TestSecManager
Password: * sk sk k

Confirm Password: *#*#xsoxsdork
Enable User Must Change Password.

Time Zone: America/New York

4, Click Submit.

(:/' tena b le.SC Dashboard Resources v Repositories ~

Add User

Organizations

Users =

Membership

Role Security Manager ¥
Organization™ RPM HDO ~

First Name Test

Last Name User

Usermmame*® TestSecManager
Password*® sssssssrarassessessesanee
Confirm ’ ......... sostessessnnsny
Password™®

User Must &

Change

Password

Time Zone™ America/New_York «
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For the lab deployment of Tenable.sc, the engineers instantiated one Nessus scanner in the Security
Services subnet that has access to every subnet in the HDO environment.

Add a Scanner
1. Navigate to the Resources drop-down list in the menu ribbon.
2. Select Nessus Scanners.

3. Click +Add in the top right corner. An Add Nessus Scanner page displays. Fill in the following
information:

a. Name: HDO Scanner

b. Description: Scans the Workstation, Enterprise, HIS, Remote, and Database VLANs
¢. Host: 192.168.45.100

d. Port: 8334

e. Enabled: on

f. Type: Password

g. Username: TestSecManager

bl

Password. 3k 3k ok 3k %k %k k k ok ok

4. Click Submit.
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( tenable.sc

Dashboard Resources v

Add Nessus Scanner

General
Name*

Description

Host*

Port*

Enabled

Verify Hostname

Use Proxy

Authentication

Repositories v Organizations

HDO Scanner

Scans the Workstation, Enterprise, HIS,

192.168.45.100

8834

Type Password ~
Username* TestSecManager
Password* [T

Users v

The engineers created a scan zone for each subnet established on the HDO network. The process to

create a scan zone is the same for each subnet aside from the IP address range.

As an example, the steps for creating the Workstation scan zone are as follows:

Add a Scan Zone

1. Navigate to the Resources drop-down list in the menu ribbon.

2. Select Scan Zones.
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3. Click +Add. An Add Scan Zone page will appear. Provide the following information:
a. Name: Workstations
b. Ranges: 192.168.44.0/24
¢. Scanners: HDO Scanner

4, Click Submit.

Q tenable.sc Dashboard Resources v Repositories v Organizationg

Add Scan Zone

General
Name* Workstations
Description
VA
Ranges® 192.168.44.0/24
Scanners Search Q

& HDO Scanner

Repeat steps in Add a Scan Zone section for each VLAN.

To fulfil the identified NIST Cybersecurity Framework Subcategory requirements, the engineers utilized
Tenable’s host discovery and vulnerability scanning capabilities. The first goal was to identify the hosts
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427 on each of the HDO VLANs. Once Tenable identifies the assets, Tenable.sc executes a basic network scan
428  to identify any vulnerabilities on these assets.

429 Create Scan Policies

430 1. Engineers created a Security Manager account in a previous step when adding users. Log in to
431 Tenable.sc using the Security Manager account.

432 2. Navigate to the Scans drop-down list in the menu ribbon.

433 3. Select Policies.

434 4. Click +Add in the top right corner.

435 5. Click Host Discovery in the Add Policy page. An Add Policy > Host Discovery page will appear.
436 Provide the following information:

437 a. Name: HDO Assets

438 b. Discovery: Host enumeration

439 c. Leave the remaining options as their default values.

440 6. Click Submit.

¢ )te nable,sc Dashboard ~ Solutions Analysis v Scans v Reporting Assels Workflow » Users =

Add Policy > Host Discovery

setup General

Name* HDO Assets
Report

Description

Tag -

Configuration

General Settings:
Discovery Host enumeration ~ « Always test the local Nessus host
=« Use fast network discovery
Ping hosts using:
« TCP
= ARP
« |CMP (2 refries)
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7. Click +Add in the top right corner.

8. Click Basic Network Scan in the Add Policy page. An Add Policy > Basic Network Scan page
displays.

9. Name the scan HDO Network Scan and leave the remaining options to their default settings.

10. Click Submit.

';,':._‘__:Il- tenable.sC  pashboard~  Solutions sis cans ssets  Workflow = Users » & Test User =
Add Policy = Basic Network Scan €Back
Batup General
Name* HDO Network Scan
ription
ag
Configuration
Performance options
Advanced Defaull = L
Port scan (common pons) ~
General Settings:

Create Active Scans

1. Navigate to the Scans drop-down list in the menu ribbon.
2. Select Active Scans.

3. Click +Add in the top right corner. An Add Active Scan page will appear. Provide the following
information for General and Target Type sections.

General
a. Name: Asset Scan
b. Description: Identify hosts on the VLANs
c. Policy: Host Discovery

Targets

a. Target Type: IP/DNS Name
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457 b. IPs/DNS Names: 192.168.44.0/24, 192.168.40.0/24, 192.168.41.0/24,
458 192.168.42.0/24, 192.168.43.0/24
459 4. Click Submit.

Analysis = Scans Reporting>  Assets

Workflow -

( )tenable.sc  Dashboara~

Add Active Scan

General
Setlings
Targets
Credentials

Post Scan

General

Name* Asset Scan

Description Identify hosts on the VLANS
Policy™ Host Discovery ~
Schedule

Schedule On Demand #
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( \ tenable.sc Dashboard v Solutions Analysis v Scans v Reporting v Assets Workflow v Users v

Add Active Scan

General Target Type IP / DNS Name ~
. IPs / DNS Names*® 192.168.44.0/24, 192.168.40.0/24, 192.168.41.0/24, 192.168.42.0/24,
Settings 192 168.43 0/24|
Targets
Credentials
Post Scan
s

460 Repeat steps in Create Active Scans section for the Basic Network Scan policy. Keep the same value as
461  defined for Active Scan with the exception of the following:

462 a. Name the scan HDO Network Scan.
463 b. Set Policy to HDO Network Scan.

464  After the engineers created and correlated the Policies and Active Scans to each other, they executed
465 the scans.

466 Execute Active Scans

467 1. Navigate to the Scans drop-down list in the menu ribbon.

468 2. Select Active Scans.

469 3. Next to HDO Asset Scan click p>.

470 4. Navigate to the Scan Results menu option shown at the top of the screen under the menu
471 ribbon to see the status of the scan.

472 5. Click HDO Asset Scan to see the scan results.

473 6. Repeat the above steps for HDO Network Scan.

474 View Active Scan Results in the Dashboard

475 1. Navigate to the Dashboard drop-down list in the menu ribbon.

476 2. Select Dashboard.
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3.

4.

In the top right, click Switch Dashboard.

Click Vulnerability Overview. A screen will appear that displays a graphical representation of the
vulnerability results gathered during the HDO Host Scan and HDO Network Scan.

2.2.1.2 Nessus

Nessus is a vulnerability scanning engine that evaluates a host’s operating system and configuration to
determine the presence of exploitable vulnerabilities. This project uses one Nessus scanner to scan each
VLAN created in the HDO environment to identify hosts on each VLAN and the vulnerabilities associated
with those hosts. Nessus sends the results back to Tenable.sc, which graphically represents the results in
dashboards.

System Requirements

CPU: 4

Memory: 8 GB

Storage: 82 GB

Operating System: CentOS 7

Network Adapter: VLAN 1348

Nessus Installation

1.

2.

Import the OVA file to the virtual lab environment.
Assign the VM to VLAN 1348.
Start the VM and document the associated IP address.
Open a web browser that can talk to VLAN 1348 and navigate to the VM'’s IP address.
Log in using wizard as the Username and admin for the Password.
Create a new admin username and password.
Log in using the new username and password.
a. Username: admin
b. Password: *****xkxkx

c. Enable Reuse my password for privileged tasks.
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_tenable

Lzer name

admin

Password

Reuse my password for privileged tasks

A Reguirad for admin usage

503 8. Click Tenable.sc on the left side of the screen.

504 9. To access Tenable.sc, click the IP address next to the URL field.
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tenable-gyx8j0wp
AR =
== Nessus®
System
@ System Log
Networking
Storage URLs:  https://192.168.45.100:8834
Accounts License: Managed by SecurityCenter
Services
Diagnostic Reports Service Status  Running Stop | | Restart
Terminal
Challenge Code:  683cfc32203a303fccebeadb4f722297a4dceb37
Nessus
Application Version:  8.11.0
Remote Storage
Build ID:  8.11.0
Update Management u

Nessus Configuration

The engineers utilized Tenable.sc to manage Nessus. To configure Nessus as managed by Tenable.sc,
follow Tenable’s Managed by Tenable.sc guide [3].

2.2.2 |dentity Management, Authentication, and Access Control

Identity management, authentication, and access control align with the NIST Cybersecurity Framework
PR.AC control. This practice guide implemented capabilities in the HDO to address this control category.
First, the practice guide implemented Microsoft Active Directory (AD), then installed a domain controller
to establish an HDO domain. Next, the practice guide implemented Cisco Firepower as part of its
network core infrastructure. The practice guide used Cisco Firepower to build VLANs that aligned to
network zones. Cisco Firepower also was configured to provide other network services. Details on
installation are included in the following sections.

2.2.2.1 Domain Controller

The engineers installed a Windows Server domain controller within the HDO to manage AD and local
domain name service (DNS) for the enterprise. The following section details how the engineers installed
the services.

Domain Controller Appliance Information
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CPU: 4

Random Access Memory (RAM): 8 GB

Storage: 120 GB (Thin Provision)

Network Adapter 1: VLAN 1327

Operating System: Microsoft Windows Server 2019 Datacenter

Domain Controller Appliance Installation Guide

Install the appliance according to the instructions detailed in Microsoft’s Install Active Directory Domain

Services (Level 100) documentation [4].

Verify Domain Controller Installation

1. Launch Server Manager.

2. Click Tools > Active Directory Domains and Trusts.

= @ I I' Manage Tools View

Active Directory Administrative Center

Active Directory Domains and Trusts

Active Directory Module for Windows PowerShell
Active Directory Sites and Services

Active Directory Users and Computers

= ADSI Edit

Component Services

Computer Management

Defragment and Optimize Drives

Disk Cleanup

i

3. Right-click hdo.trpm.

4. Click Manage.
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,ﬂ Active Directory Domains and Trusts
File Action View Help

o= |F E G HE

ﬂ Active Directory Domains and Trust

i3 hdotrom

| Mame

Manage
Raise Domain Functional Level...

Properties

Help

5. Click hdo.trpm > Domain Controllers.

6. Check that the Domain Controllers directory lists the new domain controller.

] Active Directory Users and Computers
File Action View Help

o« | FE FEIXEBd2 BHR|PRETE%R

] Active Directory Users and Computy|| MName Type DC Type Site
v | Saved Queries

w f_j hdo.trpm
s || Builtin
» | Computers

Computer Default-First-5ite-MName

= | Domain Contrellers
» | ForeignSecurityPrincipals
» [ | Managed Service Accounts
] Users

Configure Local DNS

1. Launch Server Manager.

2. Click Tools > DNS.
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Active Directory Administrative Center
Active Directory Domains and Trusts
Active Directory Module for Windows PowerShell

Active Directory Sites and Services
Active Directory Users and Computers
er ADS! Edit

Compaonent Services

Computer Management

Defragment and Optimize Drives

je Disk Cleanup
DMNS

Event Viewer

Group Policy Management

1 services iSCS| Initiator
541 3. Click the arrow symbol for DC-HDO.
542 4. Right-click Reverse Lookup Zones.
543 5. Click New Zone.... The New Zone Wizard displays.
£ DNS Manager — O >

File Action View Help
9| @d=zHE 88

é [ENS Mame

hd j DC-HDO E'DC_HDO
| Forward Lookup Zones
| Reverselc * 7
| Trust Poin MNew Zone...
= Cendition S

Help
544 6. Click Next >.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 33



DRAFT

Mew Zone Wizard
Welcome to the New Zone
Wizard
This wizard helps you create a new zone for your DNS
SErVEr,
A zone translates DMS names to related data, such as IP
addresses or network services,
To continue, did Next,
< Back Cancel
545 7. Click Primary zone.
546 8. Check Store the zone in Active Directory.
547 9. Click Next >.
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Mew Zone Wizard

Zone Type

The DMS server supports various types of zones and storage.

Select the type of zone you want to create:

(®) Primary zone
Creates a copy of a zone that can be updated directly on this server.,

() Secondary zone
Creates a copy of a zone that exists on another server. This option helps balance
the processing load of primary servers and provides fault tolerance.

() Stub zone

Creates a copy of a zone containing only Mame Server (MS), Start of Autharity
(504), and possibly glue Host (A) records. A server containing a stub zone is not
authoritative for that zone.

Store the zone in Active Directory (available only if DMS server is a writeable domain
controller)

10. Check To all DNS servers running on domain controllers in this forest: hdo.trpm.

11. Click Next >.
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Mew Zone Wizard

Active Directory Zone Replication Scope
You can select how you want DMS data replicated throughout your netwark,

Select how you want zone data replicated:

{®) To all DNS servers running on domain controllers in this forest: hdo. trpm
(") To all DNS servers running on domain controllers in this domain: hdo. trpm
() To all domain controllers in this domain (for Windows 2000 compatibility): hdo. trpm

To all domain controllers spedified in the scope of this directory partition:

550 12. Check IPv4 Reverse Lookup Zone.

551 13. Click Next >.
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Mew Zone Wizard

Reverse Lookup Zone Name
A reverse lookup zone translates IP addresses into DNS names.

addresses,

(@) IPv4 Reverse Lookup Zone

() IPvS Reverse Lookup Zone

Choose whether you want to create a reverse lookup zone for IPv4 addresses or IPvE

Cancel

552 14. Check Network ID.
553 15. Under Network ID, type 192.168.
554 16. Click Next >.
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Mew Zone Wizard

Reverse Lookup Zone Name
& reverse lookup zone translates IP addresses into DMNS names.

To identify the reverse lookup zone, type the netwaork ID or the name of the zone.
(@) Network ID:
|192 168 |

The netwark ID is the portion of the IP addresses that belongs to this zone. Enter the
netwark ID in its normal {not reversed) order.

If you use a zero in the netwark ID, it will appear in the zone name. For example,
network ID 10 would create zone 10.in-addr.arpa, and network ID 10.0 would create
zone 0. 10.in-addr.arpa.

() Reverse lookup zone name:
168.192.in-addr.arpa

555 17. Check Allow only secure dynamic updates.

556 18. Click Next >.
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Mew Zone Wizard

Dynamic Update

¥ou can spedfy that this DNS zone accepts secure, nonsecure, or no dynamic
updates.

Dynamic updates enable DMS dient computers to register and dynamically update their
resource records with a DMS server whenever changes occur,

Select the type of dynamic updates you want to allow:

(®) allow only secure dynamic updates {recommended for Active Directory)
This option is available only for Active Directory-integrated zones.,

() allow both nonsecure and secure dynamic updates
Dynamic updates of resource records are accepted from any dient.

4. This option is a significant security vulnerability because updates can be
“2  accepted from untrusted sources.,

() Do not allow dynamic updates
Dynamic updates of resource records are not accepted by this zone. You must update
these records manually.

19. Click Finish.
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Mew Zone Wizard
Completing the New Zone Wizard
‘fou have successfully completed the Mew Zone Wizard, You
specified the following settings:
Mame:  163.192.in-addr.arpa
Type: Active Directory-Integrated Primary
Lookup type; Reverse
Mote: You should now add records to the zone or ensure
that records are updated dynamically. You can then verify
name resolution using nslookup.
To dose this wizard and create the new zone, dick Finish.
< Back Cancel
558 20. Click the arrow symbol for Reverse Lookup Zones.
559 21. Right-click 168.192.in-addr.arpa.
560 22. Click New Pointer (PTR)....
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é DMS Manager

File Action View Help

&% =z Hm i 8&

£ DNS
v F DC-HDO
> [ Forward Lockup Zones
~ || Reverse Lookup Zones
|z 168.192.in-addr.arpa
[ Trust Points
] Conditional Forwarders

MName Type

There are no items to show in this view,

Update Server Data File

Reload

Mew Pointer (PTR)...

Mew Alias (CMNAME)...

MNew Delegation...

Other New Records...

DMSSEC >

All Tasks »

Delete
Refresh

Properties

Help

Create a new pointer resource record.

23. Under Host name, click Browse....
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Mew Resource Record

Pointer (PTR)

Host [P Address:

192.168.

Fully qualified domain name (FQDM):

168.192 in-addr.arpa

Host name:

Browse. .

[ ] Allow any authenticated user to update all DNS records with the same
name. Thig setting applies only to DN5 records for a new name.

oKk || Cancd

562 24. Under Look in, select hdo.trpm.
563 25. Under Records, select dc-hdo.
564 26. Click OK.
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Mew Resource Record

Doirdoe (B TOY

Browse it
Loak in: 15__‘| hdo. trpm e |£‘||
Records: EJ_., DNS
3 pc+oo
Name || Forward Lookup Zones ! ~
1 _udp B hdo.trpm
|| DomainDns...
|| ForestDnsZ...
g (same as p... Host(A) 192.163.40... &/14/2020...
Sl clinicalws  Haost (&) 192.168.44... 8/17/2020...
S dc-hdo Host (A) 192,163.40... static
g OpENMrs Host (A) 192.168.41... &/14/2020... W
Selection: dc-hdo.hdo. trpm
Record types: | Hosts (& or AAAA Recaords) b |
o[ ot |
. 0K || Cancel

27. Click OK.
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Mew Resource Recaord

Fairter (FTR)

Host |P Address:

192.168.40.10|

Fully qualified domain name (FQDMN):

10.40.168.192 in-addr apa

Host name:
de-hdo hdo tpm | Browse... |

[] Allow any authenticated user to update all DNS reconds with the same
name. This setting applies only to DMNS records for a new name.

OK || Cancel
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& DNS Manager - O *
File Action View Help

x| mXE HmR § EE

Eﬁ EENS Mame Type Data
v B [?_C_HDO E—I(same as parent folder) Start of Authority (SOA) [4], de-hdo.hdotrpm,, ho..
o — ;Z:::::!‘DDDD:LT:ZZ;:;S E—I(sameasparentfolder] Mame Server (N5) de-hde.hdo.trpm.
- - 168.192.in-addr.arps 192.168.40.10 Pointer (PTR) dec-hde.hdotrpm.
3 'I_-"r—ustPoints E-|192.168.41.20 Pointer (PTR) openmrs.hdo.trpm.

| Conditional Forwarders

2.2.2.2 Cisco Firepower

Cisco Firepower consists of two primary components: Cisco Firepower Management Center and Cisco
Firepower Threat Defense (FTD). Cisco Firepower provides firewall, intrusion prevention, and other
networking services. This project used Cisco Firepower to implement VLAN network segmentation,
network traffic filtering, internal and external routing, applying an access control policy, and Dynamic
Host Configuration Protocol (DHCP). Engineers deployed Cisco Firepower as a core component for the
lab’s network infrastructure.

Cisco Firepower Management Center (FMC) Appliance Information

CPU: 4

RAM: 8 GB

Storage: 250 GB (Thick Provision)
Network Adapter 1: VLAN 1327
Operating System: Cisco Fire Linux 6.4.0

Cisco Firepower Management Center Installation Guide

Install the appliance according to the instructions detailed in the Cisco Firepower Management Center
Virtual Getting Started Guide [5].

Cisco FTD Appliance Information

CPU: 8
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RAM: 16 GB

Storage: 48.5 GB (Thick Provision)
Network Adapter 1: VLAN 1327
Network Adapter 2: VLAN 1327
Network Adapter 3: VLAN 1316
Network Adapter 4: VLAN 1327
Network Adapter 5: VLAN 1328
Network Adapter 6: VLAN 1329
Network Adapter 7: VLAN 1330
Network Adapter 8: VLAN 1347
Network Adapter 9: VLAN 1348
Operating System: Cisco Fire Linux 6.4.0

Cisco FTD Installation Guide

Install the appliance according to the instructions detailed in the Cisco Firepower Threat Defense Virtual
for VMware Getting Started Guide in the “Deploy the Firepower Threat Defense Virtual” chapter [6].

Configure FMC Management of FTD

The Cisco Firepower Threat Defense Virtual for VMware Getting Started Guide’s “Managing the
Firepower Threat Defense Virtual with the Firepower Management Center” (FMC) chapter covers how
we registered the FTD appliance with the FMC [7].

Once the FTD successfully registers with the FMC, it will appear under Devices > Device Management in
the FMC interface.
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Overview Analysis Policies JESUILEN Objects AMP Intelligence Deploy , System Help v

Device Management NAT VPN w QoS Platform Settings FlexConfig Certificates

Device Management

List of all the devices currently registered on the Firepower Management Center.

View By : | Group | All{1) | Eror(1) | Waming (0) | Offline (0) | MNormal (0) | Deployment Pending (0 |@ Add - |

-, Search Device

Name Model | V... | Chassis Licenses Access Contr... |

4 ] Ungrouped (1)

FTD-TRPM FTD for Base, Threat - I
@ (10 1 ra0.101 - Routed VMWare AT [T (2 more...) [EEFERED & R

admin v

From the Device Management section, the default routes, interfaces, and DHCP settings can be
configured. To view general information for the FTD appliance, navigate to Devices > Device

Management > FTD-TRPM > Device.
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Overview Analysis

Policies

Devices Qelij[Hue

AMP Intelligence

Deploy

, System Help »

Device Management MNAT VPN ¥ Qos Platform Settings FlexConfig Certificates
Cisco Firepower Threat Defense for WMWare
m Routing Interfaces Inline Sets DHCP
General &7 i License &
Name: FTD-TRPM Base: Yes
Transfer Packets: Yes Export-Controlled Y
Es
Features:
Mode: routed
Malware: Yes
Compliance Mode: MNone
Threat: Yes
TLS Crypto No
Acceleration: URL Filtering: Yes
AnyConnect Apex: No
AnyConnect Plus: Mo
AnyConnect VPN N
o
Only:
System @c Health
i Cisco Firepower Threat Status: @
Model: Defense for VMWare
- S Initial Health Policy
Serial: AT 2020-02-26 20:00:53
Time: 2020-08-20 11:58:41 Blacklist: None
Time Zone: UTC (UTC+0:00)
Version: 5.4.0.8
Management & @D
Host: 152.168.40.101
Status: @
Advanced &
Application Bypass: No
Bypass Threshold: 3000 ms

608  Configure Cisco FTD Interfaces for the RPM Architecture

609 By default, each of the Interfaces are defined as GigabitEthernet, and are denoted as 0 through 6.
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610 1. From Devices > Device Management > FTD-TRPM > Device, click Interfaces.

611 2. Onthe Cisco FTD Interfaces window, an Edit icon appears on the far right. The first

612 GigabitEthernet interface configured is GigabitEthernet0/0. Click on the Edit icon to configure
613 the GigabitEthernet interface.

Overview Analysis Policies LU0 Objects AMP Intelligence L, System Helpv admin v

Device Management MNAT VPN ¥ QoS Platform Settings FlexConfig Certificates
FTD-TRPM (@ cancel |
Cisco Firepower Threat Defense for YMWare
Device Routing Interfaces Inline Sets DHCP
Search by name & sync Device | | (20 Add Interfaces =
[Imterface Logical Name Type Security Zones  MAC Adds (Active/s 1P Add
Diagnostic0/0 <|ir!f..1““‘=| ic l":;\;‘u'l al i .
GigabitEthernet0/0 Physical
GigabitEthernet0/1 Physical
GigabitEthernato/2 Physical &
GlgabitEthernetd/3 Physical é
GigabitEtherneto/4 Physical 4
GigabitEthernet(/s Physical a4
GigabitEtherneto/6 Physical g
614 3. The Edit Physical Interface group box displays. Under the General tab, enter WAN in the Name
615 field.
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Edit Physical Interface

m IPv4 IPv6é  Advanced Hardware Configuration

Name: WAN

Description:

Mode: None i
Security Zone: None o
Interface ID:

MTU: 1500 (64 - 9000)

Enabled

OK

] Management Only

Cancel

4. Under Security Zone, click the drop-down arrow and select New....
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Edit Physical Interface X
m IPv4 IPv6  Advanced Hardware Configuration
Name: WAN Enabled [ | Management Only
Description:
Mode: None h
Security Zone: None |v |
None
Interface 1ID:
Clinical-Workstations
MTU: Databases
Enterprise-Services
HIS-Services
Remote-Services
Security-Services
New... | OK | | Cancel
5. The New Security Zone pop-up box appears. Enter WAN in the Enter a name... field.
6. Click OK.
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New Security Zone

Enter a name...

|waN

619 7. On the Edit Physical Interface page group box, click the IPv4 tab.
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Edit Physical Interface

m IPv4 IPv6  Advanced Hardware Configuration

Name: WAN

Description:

Mode: None i
Security Zone: WAN |v |
Interface ID:

MTU: 1500 (64 - 9000)

Enabled

0K

(] Management Only

Cancel

8. Fill out the following information:

a. IP Type: Use Static IP

b. IP Address: 192.168.4.50/24

c. Click OK.
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Edit Physical Interface ? X
General lizl IPvé  Advanced Hardware Configuration
IP Type: Use Static IP v
IP Address: eg. 192.0.2.1/255.255.255.128 or
192.168.4.50/24 192.0.2.1/25
OK Cancel

9. Configure each of the other GigabitEthernet interfaces following the same pattern described

above, populating the respective IP addresses that correspond to the appropriate VLAN. Values

for each VLAN are described below:
a. GigabitEthernet0/0 (VLAN 1316)
i. Name: WAN
ii. Security Zone: WAN
iii. 1P Address: 192.168.4.50/24
b. GigabitEthernet0/1 (VLAN 1327)
i. Name: Enterprise-Services
ii. Security Zone: Enterprise-Services
iii. 1P Address: 192.168.40.1/24
c. GigabitEthernet0/2 (VLAN 1328)

i. Name: HIS-Services
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ii. Security Zone: HIS-Services
iii. IP Address: 192.168.41.1/24
d. GigabitEthernet0/3 (VLAN 1329)
i. Name: Remote-Services
ii. Security Zone: Remote-Services
iii. IP Address: 192.168.42.1/24
e. GigabitEthernet0/4 (VLAN 1330)
i. Name: Databases
ii. Security Zone: Databases
iii. 1P Address: 192.168.43.1/24
f. GigabitEthernet0/5 (VLAN 1347)
i. Name: Clinical-Workstations
ii. Security Zone: Clinical-Workstations
iii. 1P Address: 192.168.44.1/24
g. GigabitEthernet0/6 (VLAN 1348)
i. Name: Security-Services
ii. Security Zone: Security-Services
iii. 1P Address: 192.168.45.1/24
10. Click Save.

11. Click Deploy. Verify that the Interfaces have been configured properly. Selecting the Devices
tab, the Device Management screen displays the individual interfaces, the assigned logical
names, type of interface, security zone labelling, and the assigned IP address network that
corresponds to the VLANSs that are assigned per security zone.
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Overview Analysis Policies =0T 0 Objects AMP Intelligence Jeploy , System Helpv admin ¥
Davice Management NAT VPN * Qos Platform Settings FlexConfig Certificates
FTD-TRPM 6.Concel..)
Cisco Firepower Threat Dafense for VMWare
Device Routing Interfaces Inline Sets DHCP
h by name 22 sync Device | | (D) Add Interfaces =
Interface Logical Name Type Security Zones  MAC Address (Active/Stan... IP Address
Diagnostic/0 diagnostic Physical
GigabitEtherneta/o WAN Physical WAN 192.168.4.50/24(Static) &
GigabirEtl1ern-:L0.-’1 Enterprise-Servi..  Physical Enterprise-Servi... 192.168.40.1/24( Static) &
GigabitEthernet,2 HIS-Services Physlcal HIS-Services 192.168.41.1/24(Static) &
GigabitEthernetny3 Remote-Sarvices Physical Remota-Sarvices 192.168.42,1/24(Static) &
GigabltEthernet0/4 Databases Physical Databases 192.168.43.1/24(Static) &
GigabitEthernet0/s Clinical-Worksta...  Physical Clinical-Worksta... 192.168.44,1/24(Static) o
GigabitEthernet0/6 Security-Services  Physical Security-Services 192.168.45.1/24(Static) o
660  Configure Cisco FTD DHCP
661 1. From Devices > Device Management > FTD-TRPM > Interfaces, click DHCP.

662 2. Click the plus symbol next to Primary DNS Server.

Overview Analysis Policies STl Objects | AMP Intelligence Deploy

Device Management MNAT VPN v Qos Platform Settings FlexConfig Certificates
FTD-TRPM
Cisco Firepower Threat Defense for WMWare
Device Routing Interfaces Inline Sets m
» DHCP Server Ping Timeout 50
DHCP Relay
T Lease Length 3600
Auto-Configuration O
Interface
Override Auto Configured Settings:
Domain Name
Primary DMNS Server w @ Primary WINS Server
Secondary DNS Server W @ Secondary WINS Server
663 3. The New Network Object popup window appears. Fill out the following information:
664 a. Name: Umbrella-DNS-1
665 b. Network (Host): 192.168.40.30
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666 4. Click Save.
New Network Object ? X
Name Umbrella-DNS-1
Description
Network @ Host (O Range (O Network () FQDN

192.168.40.30

Allow Overrides [ ]

save || cancel
667 5. Click the plus symbol next to Secondary DNS Server.
668 6. The New Network Object popup window appears. Fill out the following information:
669 a. Name: Umbrella-DNS-2
670 b. Network (Host): 192.168.40.31
671 7. Under Domain Name, add hdo.trpm.
672 8. Click Add Server.

Overview Analysis Policies JREICEE Objects | AMP Intelligence

Device Management NAT VPN ¥ QoS Platform Settings FlexConfig Certificates
FTD-TRPM
Cisco Firepower Threat Defense for VMWare
Device Routing Interfaces Inline Sets m
* DHCP Server Ping Timeout 50
DHCP Relay
- Lease Length 3600
Auto-Configuration
Intarface
Override Auto Configured Settings:
Domain Name hda.trpm
Primary DNS Server Umbrella-DNS-1 v @ Primary WINS Server v
Secondary DNS Server Umbrella-DNS-2 v Q Secondary WINS Server v o
673 9. The Add Server popup window appears. Fill out the following information:
674 a. Interface: Enterprise-Services
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b. Address Pool: 192.168.40.100-192.168.40.254

c. Enable DHCP Server: Checked

10. Click OK.
Add Server ? X
Interface* Enterprise-Services v
Address Pool* 192.168.40.100-192.168.¢
Enable DHCP Server

OK Cancel

11. Add additional servers following the same pattern described above, populating the respective
Interface, Address Pool and check the Enable DHCP Server that correspond to the appropriate
server. Values for each server are described below:

a. Interface: Enterprise-Services
i. Address Pool: 192.168.40.100-192.168.40.254
ii. Enable DHCP Server: Checked

b. Interface: HIS-Services
i. Address Pool: 192.168.41.100-192.168.41.254
ii. Enable DHCP Server: Checked

c. Interface: Remote-Services
i. Address Pool: 192.168.42.100-192.168.42.254
ii. Enable DHCP Server: Checked

d. Interface: Databases
i. Address Pool: 192.168.43.100-192.168.43.254
ii. Enable DHCP Server: Checked

e. Interface: Clinical-Workstations

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 58



694

695

696

697

698

699

700
701
702
703
704
705
706
707

DRAFT

i. Address Pool: 192.168.44.100-192.168.44.254
ii. Enable DHCP Server: Checked
f. Interface: Security-Services
i. Address Pool: 192.168.45.100-192.168.45.254
ii. Enable DHCP Server: Checked
12. Click Save.

13. Click Deploy. Verify that the DHCP servers have been configured properly. Select the Devices tab
and review the DHCP server configuration settings. Values for Ping Timeout and Lease Length
correspond to default values which were not altered. The Domain Name is set to hdo.trpm,
with values that were set for the primary and secondary DNS servers. Below the DNS server
settings, a Server tab displays the DHCP address pool that corresponds to each security zone.
Under the Interface heading, one should view each security zone label that aligns to the
assigned Address Pool and review that the Enable DHCP Server setting appears as a green check
mark.
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RO Devices

Overview Analysis

Objects

AMP Intelligence

Deploy

Secondary DNS Server

m Advanced

Umbrella-DNS-2

v @

Device Management NAT VPN v QoS Platform Settings FlexConfig Certificates
Cisco Firepower Threat Defense for WMWare
Device Routing Interfaces Inline Sets m
» DHCP Server Ping Timeout 50
DHCP Relay
Lease Length
DDNS g 3600
Auto-Configuration J
Interface
Owerride Auto Configured Settings:
Domain Mame hda.trpm
Primary DNS Server Umbrella-DNS-1 W @ Primary WINS Server

Secondary WINS Server

Interface Address Pool Enable DHCP Server
Enterprise-Services 192.168.40.100-192,168.40.254 I
HIS-Services 192.168.41.100-192.168.41.254 v
Remote-Services 192.168.42.100-192,168.42.254 v
Databases 192.168.43.100-192,168.43.254 «
Clinical-Workstations 192.168.44.100-192,168.44.254 v
Configure Cisco FTD Static Route
1. From Devices > Device Management > FTD-TRPM > DHCP, click Routing.
2. Click Static Route.
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Policies Il Objects | AMP Intelligence

Overview Analysis

Device Management NAT VPN v QoS Platform Settings FlexConfig

FTD-TRPM

Cisco Firepower Threat Defense for VMWare

m Interfaces Inline Sets DHCP

* OSPF

OSPFv3 D Process 1
RIP
- (IBGP
E] Process 2

Static Route
- ) Multicast Routing

Redistribution InterArea Filter Rule

OSPF... Area ... Area... Netw... Optio... |

Click Add Route.

Intelligence Deploy , System Helpv adminv

Overview Analysis Policies geEWUT-ER Objects | AMP
QoS Platform Settings FlexConfig Certificates

Device Management MNAT VPN *
You have unsaved changes i._E_Save | i_.-_é_Eanccl

FTD-TRPM

Cisco Firepower Threat Defense for VMWare

Device Routing Interfaces Inline Sets DHCP
& Add Route

OSPF

OSPFv3

RIP

i ecp
Static Route
i_; Multicast Routing ¥ IPVG Routes

¥ IPv4 Routes

-

4. The Add Static Route Configuration popup window appears. Fill out the following information:

a. Interface: WAN

b. Selected Network: any-ipv4

61

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem



715

716

717

718

719

DRAFT

5. Click the plus symbol next to Gateway.
Add Static Route Configuration X
Type: ® 1pvda O IPve
Interface* WAN o
Available Network €% (3] Selected Network
| 4, Search | éany—ipvﬂr a
-5-;1 any-ipv4 -
9 Cisco-FMC
& Cisco-SFC
&8 Cisco-SMC
5-;1 Clinical-Workstations
5-;1 Databases
5-_;1 Enterprise-Services
-__1-;1 HDO-Domain-Controller
w
Gateway* v ©
Metric: 1
Tunneled: (] (Used only for default Route)
Route Tracking: v ©
| oK | | Cancel
6. The New Network Object popup window appears. Fill out the following information:
a. Name: HDO-Upstream-Gateway
b. Network (Host): 192.168.4.1
7. Click Save.
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New Network Object ? X
Name | HDO-Upstream-Gateway
Description
Network (@ Host () Range () Network () FQDN
192.168.4.1 |
Allow Overrides |
Save ] [ Cancel
8. Click OK.
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9.

Add Static Route Configuration

Type: ® 1Pvda O 1PV

Interface* WAN

Available Network ¢ O

| , Search |

== any-ipv4

=2 Cisco-FMC

= Cisco-5FC

= Cisco-SMC

I=2 Clinical-Workstations
&= Databases

== Enterprise-Services

&2 HDO-Domain-Controller
= HDO-Upstream-Gateway

w

Route Tracking:

Gateway* HDO-Upstream-Gateway
Metric: 1
Tunneled: U (Used only for default Route)

Selected Network

== any-ipv4

OK

| | Cancel

Click Save.

10. Click Deploy. Verify that the static route has been set correctly. From Devices, selecting the
Routing tab, the Static Route will indicate the network routing settings. The screen displays the
static route settings in a table format that includes values for Network, Interface, Gateway,
Tunneled and Metric. The static route applies to the IP addressing that has been specified,
where network traffic traverses the interface. Note the Gateway value. The Tunneled and

Metric values display the default value.
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Overview Analysis Policies rEUIE8 Objects AMP Intelligence oy , System Helpv admin v

Device Management NAT VPN ¥ Qos Platform Settings FlexConfig Certificates

FTD-TRPM O Concel |

Clsco Firepower Threat Defense for VMWare

Device Routing Interfaces Inline Sets DHCP

OSPF & Add Route
OSPFv3 N
Network Interface Galeway Tunneled Metric Tra...
RIP =
1 v
(] BGP IPv4 Routes
* Static Route any-ipv4 WanN HDO-Upstream-Gateway false 1 @

(! Multicast Routing =
IPvG Routcs

728 Configure Cisco FTD Network Address Translation (NAT)

729 1. Click Devices > NAT.

730 2. Click New Policy > Threat Defense NAT.

Overview Analysis Policies g0 Objects | AMP Intellige

Device Management NAT VPN v QoS Platform Settings Flex

[ =2 New Policy ]

Firepower NAT

‘ NAT Policy ‘ Device Type ‘ Status
, Threat Defense NAT
TOnRA RAT Tlwmnt Cof Targeting
731 3. The New Policy popup window appears. Fill out the following information:
732 a. Name: TRPM NAT
733 b. Selected Devices: FTD-TRPM
734 4. Click Save.
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New Policy ? X

Name: | TRPM NAT

Description:

Targeted Devices

Select devices to which you want to apply this policy.

Available Devices Selected Devices
2, Search by name or value b—;dFI’D—TRPM [_:j

== FTD-TRPM

Add to Policy

Save ] [ Cancel ]

735 5. Click the edit symbol for TRPM NAT.

Overview Analysis Policies JeENIL-ER Objects | AMP Intelligence Deploy , System Help v admin ¥

Device Management NAT VPN v QoS Platform Settings FlexCaonfig Certificates

Targeting 1 devices E|_] l
Up-to-date on all targeted devices

TRPM NAT Threat Defense

736 6. Click Add Rule.
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Overview Analysis Policies eE\YI<-C0 Objects | AMP Intelligence System Help ¥ admin v
Device Management NAT VPN ¥ QoS Platform Settings FlexConfig Certificates Q
TRPM NA
Enter Description

|_—‘ Policy Assignments (1)

E8 Filter by Device | O Add Rule
737 7. The Edit NAT Rule popup window appears. Under Interface Objects, fill out the following
738 information:
739 a. NAT Rule: Auto NAT Rule
740 b. Type: Dynamic
741 c. Source Interface Objects: Enterprise-Services
742 d. Destination Interface Objects: WAN
743 8. Click Translation.
Edit NAT Rule ? X
NAT Rule: Auto NAT Rule M
Type: Dynamic v ‘
Translation ~ PAT Pool  Advanced
Available Interface Objects & Source Interface Objects (1) Destination Interface Objects (1)
§, Search by name | +aw Enterprise-Services B saw WAN @

saw Clinical-workstations
.o Databases

<o Enterprise-Services
saw HIS-Services

aw Remote-Services

iow Security-Services

san WAN
| 0K || Cancel
744 9. Under Translation, fill out the following information:
745 a. Original Source: Enterprise-Services
746 b. Translated Source: Destination Interface IP
747 10. Click OK.
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Edit NAT Rule ? X
NAT Rule: Auto NAT Rule N
Type: Dynamic hd |
Interface Objects 'ﬂam PAT Pool  Advanced
Original Packet Translated Packet
Original Source:* Enterprise-Services v @ Translated Source: Destination Interface IP v
) The values selected for Destination Interface
Objects in 'Interface Objects' tab will be used
Original Port: TCP v
oK Cancel

11. Create addition rules following the same pattern described above, populating the respective
information for each rule. Values for each rule are described below:

a. HIS-Services

i. NAT Rule: Auto NAT Rule

i. Type: Dynamic

iii. Source Interface Objects: HIS-Services

iv. Destination Interface Objects: WAN

v. Original Source: HIS-Services

vi. Translated Source: Destination Interface IP
b. Remote-Services

i. NAT Rule: Auto NAT Rule

i. Type: Dynamic

iii. Source Interface Objects: Remote-Services
iv. Destination Interface Objects: WAN

v. Original Source: Remote-Services

vi. Translated Source: Destination Interface IP
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c. Databases

iv.

V.

vi.

NAT Rule: Auto NAT Rule

Type: Dynamic

Source Interface Objects: Databases
Destination Interface Objects: WAN
Original Source: Databases

Translated Source: Destination Interface IP

d. Clinical-Workstations

iv.

V.

vi.

NAT Rule: Auto NAT Rule

Type: Dynamic

Source Interface Objects: Clinical-Workstations
Destination Interface Objects: WAN

Original Source: Clinical-Workstations

Translated Source: Destination Interface IP

e. Security-Services

iv.

V.

vi.

12. Click Save.

NAT Rule: Auto NAT Rule

Type: Dynamic

Source Interface Objects: Security-Services
Destination Interface Objects: WAN
Original Source: Security-Services

Translated Source: Destination Interface IP

13. Click Deploy. Verify the NAT settings through the Devices screen. The NAT rules are displayed in
a table format. The table includes values for Direction of the NAT displayed as a directional
arrow, the NAT Type, the Source Interface Objects (i.e. the security zone IP networks), the
Destination Interface Objects, the Original Sources (i.e. these addresses correspond to the IP
network from where the network traffic originates), the Translated Sources, and Options. The
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settings indicate that IP addresses from the configured security zones are translated behind the

Interface IP address.

Policies QeEUISER Objects | AMP  Intelligence l, System Help v

admin

Device Management NAT VPN Y Qos Platform Settings FlexConfig Certificates
TRPM NAT | ESAUE !i 0 Cancel |
|¥l Policy Assignments (1}
88 Fiter by Device o Akl Rude
(_Driuilml Packet r— Translated Packet e
#  Direction Type Source Original 0.. 0. Translated  T.. T.. Options
Interface Objects Sources D.. 5. Sources D.. 5.
¥ NAT Rules Before
¥ Auto NAT Rules
# - Dynamic a3 Enterprise-Services o WAN &g Enterprise-Services ) Interface &} Ons:false 7§
s - Dynamic iva HiS-Services o WAN g HiS-Services & Interface @ Onsifalse 7
s » Dynamic aen REMOtE-Services sun AN & Remote-Services o} Interface &} Ons:false 7
= » Dynamic oxy Databases ion WAN 2 Databases o Interface ) Ons:false 7
# » Dynamic +oa Clinical-Workstations = WanN & Clinical-Workstations o Interface &} Ons:false a8
s - Dynamic o WAN & Security-Services ) Interface o Dns:false 7
¥ NAT Rules After

Configure Cisco FTD Access Control Policy

1. Click Polices > Access Control > Access Control.

2. Click the edit symbol for Default-TRPM.

Overview Analysis QECISEER Devices Objects | AMP Intelligence Deploy , System Help ¥

admin v

Access Control » Access Control Metwork Discovery Application Detectors Correlation Actions v

Object Management Intrusion Network Analysis Pollcy DNS Import/Export

[ © Newpolicy |

 Last Modified i |
i Targeting 1 devices 2020-08-19 10:50:23 G I= -
Default-TREM Up-to-date on all targeted devices Maodified by "admin” - ] « O

3. Click Add Category.

Overview Analysis JEGUISEEE Devices Objects | AMP  Intelligence , System Help v admin v
Access Control » Access Control Network Discovery Application Detectors Correlation Actions v

Default-TRPM You have unsaved changes | Analyze Hit Counts | [=] save ]| 3 cancel J
Prefilter Policy: Default Prefilter Pallcy, SSL Policy: None :;{’;;é::

Security Intelligence  HTTP Responses  Logging  Advanced

-E Inheritance Settings | [¥] Policy Assignments (1)

#8 Filter by Device |_I'Show Rule Conflicts & & Add Catagory | ) Add Rule | Search Rules
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797 4. Fill out the following information:
798 a. Name: Security Services
799 b. Insert: into Mandatory
800 5. Click OK.
Add Category X
Name: Security-Serviced
Insert: into Mandatory V |
OK I | Cancel
801 6. Repeat the previous steps of Add Category section for each network segment in the
802 architecture.
803 7. Click Add Rule.
Overview Analysis JEGUISEEE Devices Objects | AMP  Intelligence ,, System Helpv adminv
Access Control » Access Control Network Discovery Application Detectors Correlation Actions v
Default-TRPM You have unsaved changes | Analyze Hit Counts | | [=] save || €3 cancel :J
Prefilter Policy: Default Prefilter Pollcy SSL Policy: None ::‘::T:é:
'g Inheritance Settings | [¥] Policy Assignments (1)
Security Intelligence  HTTP Responses  Logging  Advanced
@ Filter by Device _| Show Rule Conflicts & &) Add Category | ) Add Rule
804 8. The Add Rule screen appears, fill out the following information:
805 a. Name: Nessus-Tenable
806 b. Action: Allow
807 c. Insert: into Category, Security Services
808 d. Under Networks, click the plus symbol next to Available Networks, and select Add
809 Object.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 71



810
811
812

813

814

815

Add Rule

Name |Messus-Tenable 3 Enabled Insert |into Category ¥ | |Security-Services

Action | & Allow ¥ I

VLAN Tags .. Users Applications Ports URLs SGT/ISE Attributes

Inspection  Logging

Comments

Available Networks & Q

Source Networks (0) Destination Networks (0)
| 4 Search by name or value & Add Object m Original Client
e TR LT

B any -

=8 any-ipva

2 any-ipvi

& Clsco-FMC

2 Clsco-SFC

& Cisco-5MC

2 Clinical-Workstations

&8 Databases

&8 Enterprise-Services v Eniter an 1P address | l add_| |Lntf.-r an 1P address

[ A |

9. The New Network Object pop-up window appears, fill out the following information:

a. Name: Tenable.sc

b. Network (Host): 192.168.45.101

10. Click Save.

New Network Object

Name Tenable.sc
Description |
Network ® Host (0 Range (O Network ) FQDN

1192.168.45.101

Allow Overrides [ ]

[ Save ] l Cancel ]

11. In the Add Rule screen, under the Networks tab, set Destination Networks to Tenable.sc.

12. Click Ports.
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Add Rule

Name | Nessus-Tenable Enabled

Action |« Allow b A

Insert |into Category ¥ | |Security-Services b

m VLAN Tags .. Users Applications Ports URLs SGT/ISE Attributes Inspection Logging Comments

Available Networks & @ Source Networks (0) Destination Networks (1)

| 4 Search by name or value | m Original Client = Tenable.sc

Geolocation
= IPve-Link-Local -

= 1Pvo-Frivate-Unigue-Local-Addresses Add To |
Source
3 1Pvi-to-1Pvd-Relay-Anycast MNetworks

&8 RDP-Jumpbox

3 Remate-Services
2 Security-Services
2 Tenable sc

2l Umbrella-DNS-1

[¥]

&8 Umbrella-DNS-2 - Enter an IP address | | Add | | Enter an 1P address

[ ada

J|_ cancer |

13. In the Add Rule screen, under the Ports tab, set Selected Destination Ports to 8834.
14. Click Add.

Add Rule

Name  MNessus-Tenable & Enabled Insert | inte Category ¥ | | Security-Services

Action |« Allow v o8

Zones  MNetworks VLAN Tags .. Users Applications URLs  SGT/ISE Attributes Inspection Logging Comments

Available Ports & Q Selected Source Ports (0) Selected Destination Ports (1)
| 4, Search by name or value |

o All:Ba3d

#° noL =
);‘ Bittorrent

#” DNS_over_TCP

#° DNS_over_UDP

Pl

Fa

#° HTTPS

&° map

& Loap

& NFSD-TCP - Protacol v | Port

| Add

| | Cancel ]

15. Repeat the previous steps for any network requirement rules if necessary.

16. Click Save.

17. Click Deploy.

2.2.3 Security Continuous Monitoring

This practice guide implemented a set of tools that include Cisco Stealthwatch, Cisco Umbrella, and
LogRhythm to address security continuous monitoring. This practice guide uses Cisco Stealthwatch for
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NetFlow analysis. Cisco Umbrella is a service used for DNS-layer monitoring. The LogRhythm tools
aggregate log file information from across the HDO infrastructure and allow behavioral analytics.

2.2.3.1 Cisco Stealthwatch

Cisco Stealthwatch provides network visibility and analysis through network telemetry. This project
integrates Cisco Stealthwatch with Cisco Firepower, sending NetFlow directly from the Cisco FTD
appliance to a Stealthwatch Flow Collector (SFC) for analysis.

Cisco Stealthwatch Management Center (SMC) Appliance Information

CPU: 4

RAM: 16 GB

Storage: 200 GB (Thick Provision)
Network Adapter 1: VLAN 1348
Operating System: Linux

Cisco SMC Appliance Installation Guide

Install the appliance according to the instructions detailed in the Cisco Stealthwatch Installation and
Configuration Guide 7.1 [8].

Cisco SFC Appliance Information

CPU: 4

RAM: 16 GB

Storage: 300 GB (Thick Provision)
Network Adapter 1: VLAN 1348
Operating System: Linux

Cisco SFC Appliance Installation Guide

Install the appliance according to the instructions detailed in the Cisco Stealthwatch Installation and
Configuration Guide 7.1 [8].

Accept the default port value 2055 for NetFlow.

Configure Cisco FTD NetFlow for Cisco SFC

1. Click Objects > Object Management > FlexConfig > Text Object.
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2. Inthe search box, type netflow.

3. Click the edit symbol for netflow_Destination.

Overview Analysis Policies Devices EsISISEN | AMP Intelligence ,, System Helpv admin v
Object Management Intrusion Rules
£ ) Add Text Object y netflow
Text Object Lo fect | |
Text objects define free-form lext strings that you use as variables in a FlexConfig object. These objects can have single values or be a list of multiple values,
& SUnanIy L L B T I 7 — = ;
4 £] istinguished Name ~ Name ~ Value Type - Override il

[T1 Individual Dbjects

k Gbjack Graups netflow_Destination System Defined (] &
.ml)ﬁs Server Group
T netflow_Event_Types all System Defined [~] &
4 % FlexConfig . 1 ] ) 2
S FlaxConflg Object netfllow_Paramelers go System Defined [~] o

- Text Object

El Geolocatlon

4. The Edit Text Object popup window appears, fill out the following information:
a. Count:3
b. 1:Security Services
c. 2:192.168.45.31
d. 3:2055
e. Allow Overrides: Checked

5. Click Save.
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Edit Text Object

-
X

2. destination
3. port <1-65535> UDP port number

Variable Type | Multiple w Count %

Name: netflow_Destination
Description: [This variable defines a single NetFlow export destination.
1. interface

1 Security-Services
2 192.168.45.31
3 2055

Allow Overrides

860 6. Click the edit symbol for netflow_Event_Types.
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Overview Analysis Policies Devices EsISISEN | AMP Intelligence [ L, System Help v admin v

Object Management Intrusion Rules

[ (o Add Text Object ] | 4 netflow

Text Object

Text objects define free-form lext strings that you use as variables in a FlexConfig object. These objects can have single values or be a list of multiple values,

Sl UL s

(A Text Object
@ Geolocatlon

-
4 «f:i Distinquished Name
[T1 Individual Dbjects Securlty-Services
" tflow_Destinati 192.168.45.31 System Defined - e
:‘I:.: nhTPFf Gfﬂl]nﬁ netiiow_Uestination S5 3. Y m Defines @ o
-@I)NH Server Group ~
Flle List netflow_Event_Types all System Defined [-] &
- '_yl lexConfig b § @
netflow_Parameters 4] System Defined i &
s FlexConflg Object 10

7. The Edit Text Object popup window appears, fill out the following information:
a. Count:1
b. 1:All
c. Allow Overrides: Checked

8. Click Save.
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Edit Text Object

Name:

Description:

Count 1

<>

Variable Type Multiple v

1 all

Allow Overrides

Override (0)

Save

| I Cancel

9. Click Devices > FlexConfig.

10. Click New Policy.

Policies JIEYI[=-l Objects | AMP Intelligence

Overview Analysis

System Help v

Device Management NAT VPN v QoS Platform Settings FlexConfig

Certificates

[

&) New Policy ]

11. The New Policy screen appears, fill out the following information:
a. Name: FTD-FlexConfig
b. Selected Devices: FTD-TRPM

12. Click Save.
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New Policy ? X

Name: FTD-FlexConfig
Description:

Targeted Devices

Select devices to which you want to apply this policy.

Available Devices Selected Devices

4, Search by name or value EFTDfTRPM |

Add to Policy

Save | | Cancel

872 13. Click the edit symbol for FTD-FlexConfig.

Overview Analysis Policies SIS Objects | AMP Intelligence System Help v admin v

Device Management NAT VPN v QoS Platform Settings FlexConfig Certificates Q
— 2

[ \J) New Policy ]

' _

- T ti 1 devi 2020-06-09 09:54:04 . =

FTD-FlexConfig Ua[:ﬂifggte or?\;lﬁingeted devices Modified by "admin” E—J ¢ 4
873 14. Under the Devices tab, select Netflow_Add_Destination and Netflow_Set_Parameters.
874 15. Click the right-arrow symbol to move the selections to the Selected Append FlexConfigs

875 section.
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Overview Analysis Policies JsEUICN Objects = AMP Intelligence Deploy ,, System Help ¥ admin ¥

Device Management MNAT VPN ¥ Qos Platform Settings FlexConfig Certificates

FTD-FlexConfig vou nave nsaved changes. (_preview Confi ) (B save ] (@ cancel

®| Policy Assignments (1)

Available FlexConfig ¢ | ) FlexConfig Object _: ™ sSelected Prepend FlexConfigs
x . Name Description

T Inspect_IPv6_UnContigure -
[71 1515_Configure

[71 1515_Interface_Configuration

™ 1515_Unconfigure

= ISIS_Unconfigure_All

[.] Netflow_Add_Destination

-t' netflow_Clear_Parameters

-‘ Metflow_Delete_Destination

[.] Netflow_Set_Parameters
- 5

o
] N PN LT | | Selected Append FlexConfigs
[21 Policy_Based_Routing

-~ #. Name Description
| Policy_Based_Routing_Clear

[2] Sysopt_AAA_radius

™ Sysopt_AAA_radius_negate
876 16. Click Save.
877 17. Click Deploy. From the Devices screen, verify the FlexConfig settings. Select the FlexConfig tab.
878 The NetFlow configurations appear in the lower right of the screen as a table. Under Selected
879 Append FlexConfigs, the table includes columns labelled # which corresponds to the number of
880 configurations that have been made, Name and Description.
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Overview Analysis Policies Objects = AMP Intelligence ¢ , System Help v admin v

Device Management NAT VFN ¥ Qos Platform Settings FlexConfig Certificates

FTD-FlexConfig preview Config_| [ [ save |[ @ cancel |

Enter Description

If] Policy Assignments (1)

Available FlexcConfig € ™| Selected Prepend FlexConfigs

x

T| Inspect_IPve_UnContigure al
[ 1515_Configure
[l 1515_Interface_Configuration
n ISIS_Unconfigure
) 1515_Unconfigure_All
L_—]_. Netflow_Add_Destination
U Metflow_Clear_Parameters
) Nettiow_Delete_Destination
ietflow_Set Parameters
[ Policy_Based_Routing
™| policy_Based_Routing_Clear
L_| Sysopt_AAA_radius

[ Selected Append FlexConfigs

1. Netflow_Set_Parameters Set global parameters for .. 408

ﬂ Sysopt_AAA_radius_negate 2 Netflow_Add_Destination Create and configure a Net... 4 [j
[L] Sysopt_basic 3

881 Creating a Custom Policy Management Rule

882 1. Click Configure > Policy Management.

N
il steatwatr 000

Dashboards Monitor Analyze Jobs Configure Deploy

Metwork Classification

Security Insight Dashboard | Ins
Host Group Management

Alarming Hosts @ Applications -
Policy Management
Concern Index Target Index Recon C&C Exploitation DDOS SOUMA ey Exfillration Policy Violati.. Anomaly
883 2. Click Create New Policy > Role Policy.
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]
cisco Stealthwatch

Dashboards Monitor Analyze

Policy Management

Search for a host or s...

Search

Custom Events (5) Relationship Events (352)

Core Events (437) ©®

e @ e Desktop Client

Configure Deploy

Create New Policy

Custom Security Event

Relationship Policy

EVENT EVENTTY... POLICYNAME POLICYTYPE@  HOSTS WHEN HC _
Role Policy
Ex. Anom... ~» Ex. C... ~ Ex. Outsi... Ex. On +,
Single Host Policy
addr Scanften Seruritv Firewyallg MAT Gat
3. Give the policy a name and description.
4. Under Host Groups, click the plus symbol.
Policy Management m
Actions
NAME # DESCRIPTION
Qutside Recon Raise alarm if selected hosts perform recon-like behavior
HOST GROUPS IP ADDRESS OR RANGE
+
5. Under Outside Hosts, select Eastern Asia and Eastern Europe.
6. Click Apply.
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v Outside Hosts
[ 3 Authorized External DNS Servers
Content Networks

v Countries
Africa
Americas
v Asia
[ 3 Central Asia
» @ Eastern Asia
[ 3 South-Eastern Asia
| 2 Southern Asia
[ 3 Western Asia

v Europe
@ Eastern Europe

v

Europe Proxy
Northern Europe
Southern Europe
Western Europe
Oceania
Other

Custom Reputation List

) Trusted Internet Hosts
o
888 7. Under Core Events, click Select Events.
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Policy Management | Role Policy

NAME *

Qutside Recon

HOST GROUPS

¥ —

Core Events (0)

DESCRIPTION

Raise alarm if selected hosts perform recon-like behavior

IP ADDRESS OR RANGE

Select Events

You must select at least one event before saving this policy. Click here to select events.

8. Select Recon.
9. Click Apply.
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[] Anomaly

[[] Command & Control

[[] Data Exfiltration

[[] Data Hoarding

[] Exploitation

[[] High Concern Index

[[] High DDoS Source Index
[[] High DDoS Target Index
[[] High Target Index

[[] Policy Violation

Recon
poy
891 10. Under Core Events > Recon > When Host is Source, select On + Alarm.
892 11. Click the expand arrow next to Recon.

EVENT EVENT TYPE WHEN HOST IS SOURCE WHEN HOST IS TARGET ACTIONS

Ex. Anomaly e Ex. Category  ~~ Ex. On + Alarm v Ex. On + Alarm

Recon Category of o NA ( Delete 1
off
On

893 12. Select Behavioral and Threshold.
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Core Events (1)

(+) Behavioral and Threshold

EVENT EVENT TYPE
Ex. Anomaly o Ex. Category o
Recon Category

Select Events

WHEN HOST IS SOURCE WHEN HOST IS TARGET ACTIONS
Ex. On + Alarm AV Ex. On + Alarm R
On + Alarm ~ NA

This is a category event made up of the following security events: @

Addr_Scan/tcp, Addr_Scan/udp, Bad_Flag_ACK, Bad_Flag_All, Bad_Flag_NoFlg, Bad_Flag_RST, Bad_Flag_Rsrvd,
Bad_Flag_SYN_FIN, Bad_Flag_URG, Flow_Denied, High SMB Peers, ICMP_Comm_Admin, ICMP_Dest_Host_Admin,
ICMP_Dest_Host_Unk, ICMP_Dest_Net_Admin, ICMP_Dest_Net_Unk, ICMP_Host_Unreach, ICMP_Net_Unreach,
ICMP_Port_Unreach, ICMP_Src_Host_lIsclated More(12)

() Threshold Only
Tolerance 95 /100
Never trigger alarm when less than: 32K points in 24 hours
Always trigger alarm when greater than: 1 G points in 24 hours
13. Click Save.
Policy Management | Role Policy Save
Actions »
NAME * DESCRIPTION

Qutside Recon

HOST GROUPS

-

Core Events (1)

EVENT EVENT TYPE
Ex. Anomaly eve Ex. Category
Recon Category

Raise alarm if selected hosts perform recon-like behavior

IP ADDRESS OR RANGE

Select Events

WHEN HOST IS SOURCE WHEN HOST IS TARGET ACTIONS
Ex. On + Alarm W Ex. On + Alarm ~
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2.2.3.2 Cisco Umbrella

Cisco Umbrella is a cloud service that provides protection through DNS-layer security. Engineers
deployed two Umbrella virtual appliances in the HDO to provide DNS routing and protection from

malicious web services.

Cisco Umbrella Forwarder Appliance Information

CPU: 1

RAM: 0.5 GB

Storage: 6.5 GB (Thick Provision)
Network Adapter 1: VLAN 1327
Operating System: Linux

Cisco Umbrella Forwarder Appliance Installation Guide

Install the appliance according to the instructions detailed in Cisco’s Deploy VAs in VMware guidance [9].

Create an Umbrella Site

1. Click Deployments > Configuration > Sites and Active Directory.

2. Click Settings.

"l"frf- :_.\'.I oyments [ Configu I
© ‘tics’ Sites and Active Directory e

4

< —~
(\ (@)

= FILTERS Q

e w mal |
forwarder-1 192.168.40.30 Default Site Virtual Appliance
forwarder-2 192.168.40.31 Default Site Virtual Appliance

Page:: 1 ~w

Search Sites and Active Directory

Status

@ Imported: 5 months ago

@ Imported: 5 months ago

1
Resuits Per Page: 10 ~~

Want to set up Active Directory integration or deploy Virtual Appliances? Click Download above to get started.

283

283

1-20f 2

3. Click Add New Site.
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© ‘die’ Sites and Active Directory @

® ©

®

Settings Add DC Downiload
Want to set up Active Directory integration or deploy Virtual Appliances? Click Download above to get started.
< BACK TO SITES AND ACTIVE DIRECTORY
Sites Auto-Updates © Add New Site
Name
Defauit Site
4. Inthe Add New Site popup window, set Name to HDO.
5. Click Save.
Add New Site
Site Name
HDO |
6. Click Deployments > Configuration > Sites and Active Directory.
7. Click the edit symbol for the Site of forwarder-1.
8. Under Site, select HDO.
9. Click Save.
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Name w Internal IP Version

Site

forwarder-1 192.168.40.3C HDO v I : 5 months ago 2.8.3

Need to add a site? View Settings

forwarder-2 192.168.40.31 : 5 months ago 283

age: 1-20of 2 < >

10. Repeat the previous steps for forwarder-2.

Name w Internal IP Site Type Status Version
forwarder-1 192.168.40.30 HDO Virtual Appliance ° Imported: 5 months ago 2.8.3
forwarder-2 192.168.40.31 HDO Virtual Appliance ° Imported: 5 months ago 2.8.3

Page: Results Per Page: 10 ~~/ 1-2 of 2 4

Configure an Umbrella Policy

1. Click Policies > Management > All Policies.

2. Click Add.

e

e

e ®

e A” PO“Cl("}S o Add Palicy Tester

Policies dictate the security protection, category settings, and individual destination lists you can apply to some or all of
your identities. Policies also control log levels and how block pages are displayed. Policies are enforced in a descending
order, so your top policy will be applied before the second if they share the same identity. To change the priority of your
policies, simply drag and drop the policy in the order you'd like, More policy info can be found in this article,

3. Expand the Sites identity.
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What would you like to protect?

Select Identities
Search |dentities

All Identities

[] u AD Groups

[] L AD Users

[] @ AD Computers

) & Networks

) = Roaming Computers

[ @ Sites 2
[] & Network Devices

(] O Mobile Devices

M &= Chramahanlbe L e e e e e e e mmmmmmmmmmmmmm————m— e —————————

CANCEL NEXT

922 4. Select HDO.

923 5. Click Next.
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6.

What would you like to protect?

Select Identities

| Search ldentities ' 1 Selected REMOVE ALL ‘
All Identities [ Sites | 9 HDO
9 HDO

[ 9 Default Site 5

CANCEL NEXT

Click Next.

What should this policy do”

Choaose the policy components that you'd like to enable.

Enforce Security at the DNS Layer
Ensure domains are blocked when they host malware, command and control, phishing, and more.

Inspect Files
Selectively inspect files for malicious content using antivirus signatures and Cisco Advanced
Malware Protection.

Limit Content Access
Block or allow sites based on their content, such as file sharing, gambling, or blogging.

Control Applications
Block or allow applications and application groups for identities using this policy.

Apply Destination Lists
Lists of destinations that can be explicitly blocked or allowed for any identities using this policy.

» Advanced Settings

CANCEL PREVIOUS NEXT
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7. Click Next.

U

Categories To Block EDIT

Security Settings

Ensure identities using this policy are protected by selecting or creating a security setting. Click Edit Setting to make
changes to any existing settings, or select Add New Setting from the dropdown menu.

Select Setting

Default Settings M

Malware

Websites and other servers that host malicious software, drive-by downloads/exploits, mobile threats and more.

Newly Seen Domains
Domains that have become active very recently. These are often used in new attacks.

Command and Control Callbacks
Prevent compromised devices from communicating with attackers' infrastructure.

Phishing Attacks
Fraudulent websites that aim to trick users into handing over personal or financial information.

Dynamic DNS
Block sites that are hosting dynamic DNS content.

Potentially Harmful Domains
Domains that exhibit suspicious behavior and may be part of an attack.

DNS Tunneling VPN

VPN services that allow users to disguise their traffic by tunneling it through the DNS protocol. These can be used to

bypass corporate policies regarding access and data transfer.

Cryptomining
Cryptomining allows organizations to control cryptominer access to mining pools and web miners.

CANCEL PREVIOUS NEXT

8. Select Moderate.

9. Click Next.
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Limit Content Access
Access to these sites will be restricted based on the type of content served by the pages of the site. For more
information about categories, click here
O Categories To Block -Moderate
Adware Alcohol
Dating Drugs
@ Gambling German Youth Protection
Hate / Discrimination Internet Watch Foundation
Lingerie / Bikini Nudity
Pornography Proxy / Anonymizer
Sexuality Tasteless
Terrorism Weapons
O Low ?
ocks pornography
O Custom
Create a custom grouping a Des
928 10. Under Application Settings, use the drop-down menu to select Create New Setting.

Control Applications

Application Settings

Default Settings v

Default Settings

CREATE NEW SETTING

— n

Select applications or application categories you'd like to block or allow for the users in your organization

929 11. Under the Control Applications screen, fill out the following information:
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a. Name: HDO Application Control

b. Applications to Control: Cloud Storage

12. Click Save.

Control Applications

Give Your Setting a Name

‘ HDO Application Control

Applications To Control

‘ Search for an application

(> Ad Publishing
D > Anonymizer

D > Application Development and
Testing

C] » Backup & Recovery
D > Business Intelligence

> Cloud Storage

Select applications or application categories you'd like to block or allow for the users in your organization

13. Click Next.
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Control Applications

Select applications or application categories you'd like to block or allow for the users in your organization

Application Settings

‘ HDO Application Control v

Applications To Control

‘ Search for an application ’

(> Ad Publishing
D > Anonymizer

D > Application Development and
Testing

D > Backup & Recovery
D » Business Intelligence

» Cloud Storage

CANCEL PREVIOUS NEXT

14. Click Next.
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Apply Destination Lists

Search for and apply the appropriate block or allow Destination Lists for this policy. Click Add New List to create a
Destination List.

Q Search . ’ 1 Allow Lists Applied

Select All Showing: All Lists ¥ 2 Total @ Global Allow List 0

All Destination Lists 1 Block Lists Applied
© Global Allow List 0> © Global Block List 0

@ Global Block List 0>

CANCEL PREVIOUS NEXT

15. Click Next.

File Analysis

Inspect files for malicious behaviors using a combination of static and dynamic analysis methods, in addition to file
reputation and advanced heuristics.

.@ File Inspection
Inspect files for malware using signatures, heuristics and file reputation (powered by Cisco Advanced Malware
Protection).

CANCEL PREVIOUS NEXT

16. Click Next.
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Set Block Page Settings

Define the appearance and bypass options for your block pages.

@ Use Umbrella’s Default Appearance

Preview Block Page »

O Use a Custom Appearance

Choose an existing appearance M

BYPASS USERS

BYPASS CODES
CANCEL NEXT
937 17. In the Policy Summary screen, set the Name to HDO Site Policy.
938 18. Click Save.
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Policy Summary

Policy Name

HDO Site Policy

U 1Identity Affected U
Edit

U Security Setting Applied: Default Settings
Edit Disable

U Content Setting Applied: Moderate

Edit Disable

U Application Setting Applied: HDO Application
Control

Edit Disable

» Advanced Settings

2 Destination Lists Enforced
Edit

File Analysis Enabled

Edit

Umbrella Default Block Page Applied
Edit Preview Block Page

CANCEL PREVIOUS m

Configure Windows Domain Controller as the Local DNS Provider

1. Click Deployments > Configuration > Domain Management.

2. Click Add.
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©

Deployments [ Configuration

asco Domain Management e

°

#
8

Want to route certain domains to your local resolver? You've come to the right place. Click " Add" above to get started.

Domain Name 4 Description Applies To

Page:i 1 s | Results Per Page.| 10 ~~ ‘ 1-20f2

Add New Bypass Domain or Server popup window appears, fill out the following information:

a. Domain: hdo.trpm

b. Applies To: All Sites, All Devices

Click Save. Verify the rule for the hdo.trpm has been added.
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Add New Bypass Domain or Server

will also be treated as an internal domain.

Domaln Type

@® Internal Domains

Domain

When you add a domain, all of its subdomains will inherit the setting.
If ‘example.com’ is on the internal domains list, "www_example.com’

hdo_trpm

Descriptlon

All HDO domains|

Applles To
All Sites X || All Devices % v |
Domain Name 4 Description Applies To
= ed or

REC-1018 All Sites, All Devices
| 1 Al C 15 All Sites, All Devices

All Sites, All
hdo_trpm All HDO domains %

Devices

Page:‘ 1 ~ ‘ Results Per Page‘.‘ 10 ~~ ‘ 1-30f3 4 >

2.2.3.3 LogRhythm XDR (Extended Detection and Response)

LogRhythm XDR is a SIEM system that receives log and machine data from multiple end points and
evaluates the data to determine when cybersecurity events occur. The project utilizes LogRhythm XDR in
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the HDO environment to enable a continuous view of business operations and detect cyber threats on
assets.

System Requirements

CPU: 20 virtual central processing unit (vCPU)
Memory: 96 GB RAM

Storage:

= hard drive C: 220 GB
= hard drive D: 1 terabyte (TB)
= hard drive L: 150 GB

Operating System: Microsoft Windows Server 2016 X64 Standard Edition
Network Adapter: VLAN 1348

LogRhythm XDR Installation

This section describes LogRhythm installation processes.

Download Installation Packages

1. Acquire the installation packages from LogRhythm, Inc.

2. Prepare avirtual Windows Server per the system requirements.

3. Create three new drives.

4. Create a new folder from C:\ on the Platform Manager server and name the folder LogRhythm.

5. Extract the provided Database Installer tool and LogRhythm XDR Wizard from the installation
package in C:\LogRhythm.

Install Database

1. Open LogRhythmDatabaselnstallTool folder.

2. Double-click LogRhythmDatabaselnstallTool application file.

3. Click Run.

4. A LogRhythm Database Setup window will appear. Provide the following information:
a. Which setup is this for?: PM

b. Disk Usage:

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 101



976
977
978

979

980

981

982

983

984

985

986

987

988
989

990

DRAFT

5.

6.

Data: E:\
Logs: L:\
Temp: T:\

s3% LogRhythm Database Setup x

:*LogRhythm

The Security Intelligence Company

Select and Configure the LogRhythm Database

Which setup is this for? Disk Usage
Drive Usage: Drve Letter:  Drive Size: Free Space: Wil Use:
O ¥M
Data EM 95 GB 95 GB 76 |5 GB
® PM Logs Ly 43 GB 43 GB 10 |5 GB
Temp TN v 43 GB 48 GB 4 | GB
Systemn Memory: 64 GB Reserve for SGL: 15 |5 GB

Flease zee LogRhythm
documentation on the Support Portal
or call LogRhythm Support if you
have any questions

Change Default SQL Password

View Logs

The remaining fields will automatically populate with the appropriate values. Click Install.

Click Done to close the LogRhythm Database Setup window.

Install LogRhythm XDR

1.

2.

Navigate to C:\ and open LogRhythm XDR Wizard folder.
Double-click the LogRhythminstallerWizard application file.
The LogRhythm Install Wizard 7.4.8 window will appear.

Click Next.

A LogRhythm Install Wizard Confirmation window will appear.
Click Yes to continue.

Check the box beside I accept the terms in the license agreement to accept the License
Agreement.

Click Next.
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9. Inthe Selected Applications window, select the following attributes:
a. Configuration: Select the XM radio button.
b. Optional Applications: Check both Al Engine and Web Console boxes.

10. Click Install.

:*LogRhythmr

Configuration Selected Applications
OB
O PM
) DPX {upgrade only)
O op
) Client Conscle
) Web Consale
O AIE
O D

Optional Applications
Al Engine
Web Consale

22* LogRhythm Install Wizard 7.4.8 X

11. A LogRhythm Deployment Tool window displays.

12. Click Configure New Deployment.
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:* LogRhythm Deployment Tool - O :

:#*LogRhythm™ LogRhythm Deployment Tool

Welcome to the 7.4.8 LogRhythm Deployment Tool

Configure New Deployment Configure a new 7.4.8 LogRhythm Deploym
Upgrade an existing LogRhythm deploymei
Add or remove hosts from your current Log

Check the status of hosts in your deployme
configuration.
Installation Instructions

997 13. In the Deployment Properties window, keep the default configurations and click Ok.
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+:% LogRhythm Deployment Toal B O X

Deployment Properties

Does your deployment include a Web Console?

@ Yes
® No

Cancel

998 14. Click +Add Host IP in the bottom right corner of the screen, and provide the following
999 information:

1000 a. IP Address: 192.168.45.20

1001 b. Nickname: XM

1002 15. Click Save.
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Add Host

Enter the host's IP address and optional nickname:

IP Address
192.168.45.20

(Optional) Nickname
XM|

Cancel

1003 16. Click Create Deployment Package in the bottom right corner of the screen.
1004 17. A Create Deployment Package window displays.
1005 18. Click Create Deployment Package.

3% LogRhythm Deployment Tool

Create Deployment Package
You are about to create a Deployment Package for the Following hosts.

Ensure that the list below contains all the hosts of your LogRhythm Deployment.

IP Addres: Nickname

192.168.45.103 XM

Cancel %X Create Deployment Package

1006 19. A Select Folder window appears.
1007 20. Navigate to C:\LogRhythm.
1008 21. Click Select Folder.
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v & » ThisPC > Local Disk (C) v & | Searchlocsl Disk (C
Organize « Mew folder
~ -
~ [ This PC Name Date modified
[ Desktop inetpub
LogRhythm
Logs
Perflogs

Program Files

File folder
File folder
File folder
File folder
File folder

Program Files (x86) g/ M File folder
B videos ProgramData g 08 PM File folder

| Documents
4 Downloads
J’! Music

| Pictures

) hosts.

i, Local Disk (C:) tmp 9 BELVINTEEEE ) b cployment.
s Data (E) Users 9 1217PM  File folder

DD Drive (F) N Windows g AN File folder

Mew Volume (H:

Log Files (L) =

Folder: | Local Disk (C:)

Select Folder

=, Create Deployment Package

1009 22. Click Next Step.

+%% LogRhythm Deployment Tool - = .

Create Deployment Package

Your Deployment Package was exported to:

C:\LogRhythm

The next step explains how to use the Deployment Package to install certain necessary
components on each host in your LogRhythm Deployment.

Open in Explorer NextStep

1010 23. Click Run Host Installer on this Host.
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23% LogRhythm Deployment Tool _ - ~

ogRhythm™ LogRhythm Deployment Tool

Next Steps

On the PM (the current Host), run the Host Installer.

Note: This step starts the deployment process. After you click this, your LogRhythm Deployment will be down until you successfully
complete the rest of the LogRhythm deployment installation process.

Run Host Installer on This Host

1011 24. After the Host Installer has finished, click Verify Status.

2% LogRhythm Deployment Tool _ o »

LogRhythm" LogRhythm Deployment Tool

successfully complete the rest of the LogRhythm deployment installation process.
Host Install Successful!

- T e ey
2020-09-15T16:21:05.883-04: [INFO] Cleaning up any existing ServiceRegistry data
05.807-04:00 [INFO] Successfully verified no old Serwvice Req y data is left on
907-04:00 [INFO] Installing Common Components
[INFO] Starting service LogRhythm Service Regi
[INFO] Started service LogRhythm Service Reg:
)-09-15T16:21:=09.56 = [INFO] Restoring KV store
09-15T1 -047-04:00 [INFO] Local install completed successfully

Run the tool to confirm that all LogRhythm Host Installers have completed successfully.
Choose to modify your deployment configuration.

Verify Status

Add/Remove Hosts

Show Console Log

1012 25. Click Exit to Install Wizard.
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Deployment Status Verification

Current Status:

IP Address Nickname Status

19216845103 XM Active

D Refresh Status £ Add/Remove Hosts @ Exit to Install Wizard

This table only indicates the health of LogRhythm Common Components across
the deployment, it does not perform version checking. Make sure that the latest

version of the Deployment Package has been run on each host.

Show Console Log

1013 26. A notification window displays stating the installation could take up to 30 minutes. Click OK.
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3* LogRhythm Install Wizard 7.4.8

::*LogRhythmr

[Infrastructure Installer 5
(Al Engine 5
[Alarming Manager 5
Authentig=somm—te—s n
Adminie| LOGRNythm Install Wizard Information

Client Cof

Jab Man complete.

Mediator

@ Installing Client Console prerequisites may take 30 minutes to

Conﬁguldll UTT TWTaTTageErT

27. After the Install Wizard has successfully installed the services, click Exit.

+2+ LogRhythm Install Wizard 7.4.8

:*LogRhythmr

[Infra structure Installer
(AI Engine
[:Alarming Manager

[Authenticaﬁun Services
[:Administratl'cn AP
[:CIient Console

[Data Indexer

[:Job Manager
[Medfator Server Service
(System Manitor Service
[:Web Consale
[Conﬁguraticm Manager

il lvilvlvilv wv
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LogRhythm XDR Configuration

The LogRhythm XDR configuration includes multiple related components:

= System Monitor

= LogRhythm Artificial Intelligence (Al) Engine
= Mediator Server

= Job Manager

=  LogRhythm Console

Configure System Monitor

1. Open File Explorer and navigate to C:\Program Files\LogRhythm.
2. Navigate to LogRhythm System Monitor.

3. Double-click the Irconfig application file.

4. In the LogRhythm System Monitor Local Configuration Manager window, provide the following

information and leave the remaining fields as their default values:
a. Data Processor Address: 192.168.45.20
b. System Monitor IP Address/Index: 192.168.45.20

5. Click Apply, and then click OK.
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:2* LogRhythm System Monitor Local Config... O X

General  Windows Service  Log File

System Monitor Agent

Specify the System Monitor Agent configuration settings.

Data Processor Connection Settings

Data Processor Address Port
[192.168.45.20 | 443 2
System Monitor IP Address / Index Port
|192.168.45.20] | |0 :

Host Entity 1D (Zero for system assigned 1D}
0 =

-

Systemn Monitar High Awailability (HA Only) Folders

For High Availability {HA) deployments, the Configuration and State paths can be
modified from their default locations.

WARMIMNG: Changing these values could impact your deployment. Ensure you
understand the impacts before making changes.

Corfiguration File Parent Directory
C:M\Program Files“LogRhythm“LogRhythm System Monitar', |

QK Cancel Apply

Configure LogRhythm Al Engine

1.

2.

Open File Explorer and navigate to C:\Program Files\LogRhythm.
Navigate to LogRhythm Al Engine.
Double-click the Irconfig application file.

In the LogRhythm Al Engine Local Configuration Manager window, provide the following
information, and leave the remaining fields as their default values:

a. Server: 192.168.45.20
b. Password: *******%xx

Click Test Connection, then follow the instruction of the alert window to complete the test
connection.

Click Apply, and then click OK.
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+** LogRhythm Al Engine Local Configurat.. — O

Al Engine

Specify the Al Engine configuration setktings.

Platform Manager Connection Settings

Server:  [192.168.45.20)

Database: |LogRhythmEMDB

] Login with Windows accourt

UserID:  |LogRhythmAIE

Password: |

Encrypt all communications Test Connection

Al Engine High Availability (HA anby) Folders

For High Awailability (HA) deployments, the Corfiguration and State paths can be
modified from their default locations.

WARNING: Changing these values could impact your deployment. Ensure you
understand the impacts before making changes.

Generzl | Windows Sewioe] Al Engine Log File ] Comm Mar Log File

Cancel

Configure Mediator Server

1.

2.

Open File Explorer and navigate to C:\Program Files\LogRhythm.
Navigate to Mediator Server.

Double-click Irconfig application file.

In the LogRhythm Data Processor Local Configuration Manager window, provide the following

information, and leave the remaining fields as their default values:
a. Server:192.168.45.20

b Password. 3k sk ko k sk sk k ok ok
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1051 5. Click Test Connection, then follow the instruction of the alert window to complete the test
1052 connection.
1053 6. Click Apply, and then click OK.

+2* LogRhythm Data Processor Local Confi.. — O e

Data Processor

Specify the Data Processor configuration settings..

Platform Manager Connection Settings

Server:  |192.168.45.20] |

Database: |LogRhythmEMDE |
[] Login with Windows account

UserID:  |LogRhythmLM |

Password: |

[] Encrypt all communications Test Connection

Data Processaor High Availability (HA onby) Folders

For High Awvailability (HA) deployments, the Configuration and State paths can be
modified from their default locations.

WARMNING: Changing these values could impact your deployment. Ensure you
understand the impacts before making changes.

Corfiguration File Parent Directony

C:"Program Files*LogRhythm*LogRhythm Mediator Servert.
State File Parent Directory

C:\Program Files*LogRhythm*LogRhythm Mediator Servert.

General | Windows Sewioel Log File]

Concat | [ oo

1054  Configure Job Manager
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1. Open File Explorer and navigate to C:\Program Files\LogRhythm.
2. Navigate to Job Manager.
3. Double-click the Irconfig application file.

4. In the LogRhythm Platform Manager Local Configuration Manager window, provide the
following information, and leave the remaining fields as their default values:

a. Server: 192.168.45.20
b. Password: *****kkxkx

5. Click Test Connection, then follow the instruction of the alert window to complete the test
connection.

6. Click Apply, and then click OK.
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+*% LogRhythm Platform Manager Local C.. — O X

Job Manager

Specify the Job Manager configuration settings.

o

Platform Manager Connection Settings

Server.  |192.168.45.20] |

Database: |LogRhythmEMDB |

] Login with Windows accourt

User ID: | LogRhythmJaobMar |

Password: |

[] Encrypt all communications Test Connection

Job Manager High Availability (HA only) Folders

For High Awailability (HA) deployments, the Configuration and State paths can be
madified from their default locations.

WARMNING: Changing these values could impact your deployment. Ensure you
understand the impacts before making changes.

Corfiguration File Parert Directory

C:"Program Files*LogRhythm"LogRhythm Job Managert,
State File Parent Directony

C:Program Files*LogRhythm*LogRhythm Job Manager,

Job Manager | Alarming and Response Manager I Windows Sewicel Job Mz 4

Concat | [ oo

7. Navigate to the Alarming and Response Manager tab in the bottom menu ribbon.

8. Inthe Alarming and Response Manager window, provide the following information, and leave

the remaining fields as their default values:

a. Server:192.168.45.20
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b. Password: ****%*%x*x

9. Click Test Connection, then follow the instruction of the alert window to complete the test
connection.

10. Click Apply, and then click OK.
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+2+ LogRhythm Platform Manager Local C.. — O X

Alarming and Response Manager

Specify the ARM configuration settings.

Platform Manager Connection Settings

Server:  |192.168.45.2( |

Database: |LogRhythmEMDE |

[] Login with Windows account

UseriD:  |LogRhythmARM |

Password: |

[] Encrypt all communications Test Connection

ARM High Availability (HA only) Folders

For High Awailability (HA) deployments, the Corfiguration and State paths can be
modified from their default locations.

WARMNING: Changing these values could impact your deployment . Ensure you
understand the impacts before making changes.

Configuration File Parent Directory

C:M\Program Files“LogRhythm"LogRhythm Alarming and Fesponse Manag
State File Parent Directony

C:%Program Files*LogRhythm*LogRhythm Alaming and Response Manag

Job Manager Alarming and Response Manager Windows Service I Job Mz 4 P

Cancel Aoply

Configure LogRhythm Console

1. Open File Explorer and navigate to C:\Program Files\LogRhythm.

2. Navigate to LogRhythm Console.
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3. Double-click Irconfig application file.

4. In the LogRhythm Login window, provide the following information:
a. EMDB Server: 192.168.45.20
b. UserID: LogRhythmAdmin
C. Password: **#xkxkx

5. Click OK.

:*LogRhythmr

EMDB Server |192.168 4520 |

Database: |LogRhythmEMDB |

[ Login with Windows account

UserID: |LogRhythmAdmin |

Password: |

[] Encrypt all communications
[ Login automatically next time

Cancel

6. A New Platform Manager Deployment Wizard window displays. Provide the following
information:

a. Windows host name for Platform Manager: LogRhythm-XDR
b. IP Address for Platform Manager: 192.168.45.20

c. Check the box next to The Platform Manager is also a Data Processor (e.g., an XM
appliance).
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1088 d. Check the box next to The Platform Manager is also an Al Engine Server.
1089 7. Click the ellipsis button next to <Path to LogRhythm License File> and navigate to the location
1090 of the LogRhythm License File.

& New Platform Manager Deployment Wizard >

Initialize Platform Manager
Windows host name for Platform Manager

|LogRhythm-XDR |
IP Address for Platform Manager

192.168.45.20 |

The Platform Manager is also a Data Processor {e.g., an XM appliance)
The Platform Manager is also an Al Engine Server

[] LogMart DB Server Ovemide

LogRhythm License File

<Path to LogRhythm License File: | E
DK Cancel

1091 8. The New Knowledge Base Deployment Wizard window displays and shows the import progress
1092 status. Once LogRhythm has successfully imported the file, a message window will appear
1093 stating more configurations need to be made for optimum performance. Click OK to open the
1094 Platform Manager Properties window.
1095 9. Inthe Platform Manager Properties window, provide the following information:
1096 a. Email address: no_reply@logrhythm.com
1097 b. Address: 192.168.45.20
1098 10. Click the button next to Platform, enable the Custom Platform radio button, and complete the
1099 process by clicking Apply, followed by clicking OK.
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11.

12.

13.

14.

15.

& Platform Manager Properties

Host
LogRhythm-¥DR

Platfarm

|Custum

Enable Alaming Engine
[] Enable Reporting Engine

Log Level
|‘u’EH BOSE v |

Email From Address

|no_repl‘_.r@iogm1_.'thm.com

SMTP Servers
SMTP Server (Primary)

Address

|192.168.45.20

User

Password

[] Use Windows authertication

Primary Secondary Tertiary

Advanced Defaults

QK Cancel Apphy

After the Platform Manager Properties window closes, a message window displays for
configuring the Data Processor. Click OK to open the Data Processor Properties window.

Click the button next to Platform and enable the Custom Platform radio button.

Click OK.

Leave the remaining fields in the Data Processor Properties window as their default values and

click Apply.

Click OK to close the window.
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' Data Processor Properties

General Al Engine  Automatic Log Source Corfiguration

Host
LogRhythm-XDR

Platform

|Custom

Data Processor Name

| LogRhythm-XDR

Cluster Name
logrhythm -
Operating Mode
() Cffline - Data Processor is unavailable for use.

(® Online Active - Data Processor is online for active log data collection and analysis.

Message Processing Engine Settings
Enable MPE log processing

Disable MPE Evert forwarding

Advanced Defaults OK

(7) Cnline Archive - Data Processor is online for use in archive restoration and analysis.

&0 | Heartbeat Waming Interval. Value between 60 seconds and 86,400 seconds (1 day).

Apply

Set LogRhythm-XDR for System Monitor

1.

2. Navigate to System Monitors on the Deployment Manager menu ribbon.

3.

Back in the LogRhythm console, navigate to the Deployment Manager tab in the menu ribbon.

Double-click LogRhythm-XDR.
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4.

5.

6.

:53 LogRhythm Consele - [Deployment Manager] - o x
*'j File Edit View My LogRhythm Tools Window Help -8 X
@ g}‘ a | & Personal Dashboard 4 Investigate ' Tail @ ReportCenter  Z| ListManager

%3 Deployment Monitor £ Deployment Manager

Entity Platform Manager Data Processors Al Engine  Network Monitors  System Monitors  |og Sources  Log Processing Policies  Alarm Rules  People  Third Party Applications

[Mew System Monitor Agents ¥
Action Status Host Operating System Hest IP Address Resclved Known Hest Agent Name Vi?:irgn Agent GUID
(=] = = = = = = =
Fiterby | [ s e [=] [E || 5Tme | ] O3 ok e
Action Hest Entity HostName Type L A L ! bled MetflowEnabled R DatelUpdated LicenseType
3 W Primary Site ] tem Monitor.
O Primary Site ClinicalWs ClinicalwW's O O 7192020 11:2.  System Monitor.

< >
Showing 2 of 2

Service Requests

g Search For  Alarm ~ Value In the past Minute{s) * Include All ~ Options~ - Go

In the System Monitor Agent Properties window, navigate to Syslog and Flow Settings.
Click the checkbox beside Enable Syslog Server.

Click OK to close the System Monitor Agent Properties window.

.. System Monitor Agent Properties Y

Agent Settings  Data Processor Settings  Syslog and Flow Seftings  SNMP Trap Receiver  Endpoint Monitoring — Additional Information

Enable Syslog Server
Syslog Relay Hosts (one host |P addr per ine) Syslog Relay Regular Expressions (one regex per line)

"o <prionty="d{1,3})=\s"(F<message =(F<month > [az A-Z){31) s (Paday>hd {1, 21N P<hoursd {1,23):(?
<minute=d{1,2}):{?<seconds:\d{1 2})'s*Message forwarded from (?<hostidentifiers'.5+): %)
“o(Peprionty>\d{1, 31> s F<message > Pamonth: [az A-ZH3Ns " Faday>\d {1 2 (P<hour>d {1, 23):(7
<minute=d{1, 2} P<seconds = \d{1 2s (S s")

"o <prionty="d{1,3})=\s"(F<message = (F<month > [az A-Z){31) s (Paday=td {1, 21N P<hoursd {1,23):(?
<minute=\d{1,2}):{?<seconds:\d{1 2})\s*(P<hostidentifier:S+)\s* %)
“o(Peprionty=\d{1,3})x\s"(T<messages.)

“(P<message>(?<month>fa-zA-ZH3H s ?<day= d{1.2})\s"(P<hour=\d {1, 21):( P«minute>'d{1,2}):(P<seconds >
a1, 21hs " F<hostidentfier="5+'s*%)

[ ] Enable Load Balancing
] Enable IPFIX/Netflow/J-Flow Server
[] Enable sFlow Server

Log sFlow Courters

Log Message Sources Collected by this Agent
Showing 11 of 11

| Advanced | | Defauts | oK [ Cancel | Appty |

Use the LogRhythm Web Console

1.

Open a web browser and navigate to https://localhost:8443.
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2. Enter the Username: logrhythmadmin

3. Enter the Password: **********

Sign in to LogRhythm

Logrhythmadmin

L LL A LR

2.2.3.4 LogRhythm NetworkXDR

LogRhythm NetworkXDR paired with LogRhythm XDR enables an environment to monitor network
traffic between end points and helps suggest remediation techniques for identified concerns. This
project utilizes NetworkXDR for continuous visibility on network traffic between HDO VLANs and
incoming traffic from the telehealth platform provider.

System Requirements

CPU: 24 vCPU
Memory: 64 GB RAM

Storage:
= QOperating System Hard Drive: 220 GB
= Data Hard Drive: 3TB
= QOperating System: CentOS 7

Network Adapter: VLAN 1348

LogRhythm NetworkXDR Installation

LogRhythm provides an International Organization for Standardization (.iso) disk image to simplify
installation of NetMon. The .iso is a bootable image that installs CentOS 7.7 Minimal and NetMon. Note:
Because this is an installation on a Linux box, there is no need to capture the screenshots.
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Download the Installation Software

8.

9.

10.

Open a new tab in the web browser and navigate to https://community.logrhythm.com.

Log in using the appropriate credentials.
Click LogRhythm Community.

Navigate to Documentation & Downloads.
Register a Username.

Click Accept.

Click Submit.

Navigate to NetMon.

Click downloads: netmon4.0.2.

Select NetMon ISO under Installation Files.

Create a New Firewall Rule

NetMon communicates over TCP 443. The lab environment was configured to allow network sessions
connecting to the LogRhythm agent.

Install LogRhythm NetworkXDR

1.

2.

In the host server, mount the .iso for the installation.

Start the VM with the mounted .iso.

When the welcome screen loads, select Install LogRhythm Network Monitor.
The installer completes the installation, and the system reboots.

When the system reboots, log in to the console by using logrhythm as the login and ****** 35
the password.

Then change the password by typing the command passwd, type the default password, and then
type and verify the new password.

LogRhythm NetworkXDR Configuration

1.

2.

Data Process Address: 192.168.45.20

Click Apply.
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+2% LogRhythm System Monitor Local Config...

General  Windows Service Log File

System Monitor Agent

Specify the System Monitor Agent configuration settings

Data Processor Connection Settings

Diata Processor Address

Port
192.168.45.20 | [443 5
System Monitor IP Address / Index Fort
152.168.45.20 | [3333 :

Host Entity |10 (Zero for system assigned 10}
0 =

-

Systemn Manitor High Availability (HA Only) Folders

For High Awvailability (HA) deployments, the Configuration and State paths can be
modified from their default locations.

WARNING: Changing these values could impact your deployment. Ensure you
understand the impacts before making changes.

Configuration File Parent Directony

|C:"-.F‘n:|g|am Files*LogRhythm*LogRhythm System Monitar®, |

State File Parent Directony

|C:"-.F‘n:|g|am Files*LogRhythm*LogRhythm System Monitar®, |

0K Cancel Applhy
1163 3. Click the Windows Service tab.
1164 4. Change the Service Type to Automatic.
1165 5. Click Apply.
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a3t LogRhythm System Monitor Local Config... O X

General Windows Service  Log File

Windows Service

Specify the Windows Service configuration settings.

LogRhythm System Monitor Service

Startup Type
|;’-‘-.|.rh:|mati|: w

Start Service Status:  Stopped

Log On
(® Local System Accourt
() This Account:  LocalSystem

Password:
QK Cancel Apply
1166 6. Click the Log File tab.
1167 7. Click Refresh to ensure NetworkXDR log collection.
1168 8. Click OK to exit the Local Configuration Manager.
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+¢+ LogRhythm System Monitor Local Config... O =

General Windows Service Log File

File Location: Refresh
C:MProgram Files“LogRhythm*LogRhythm System Monitor'Logs*scsm log

0K Cancel Apphy

2.2.3.5 LogRhythm System Monitor Agent

LogRhythm System Monitor Agent is a component of LogRhythm XDR that receives end-point log files
and machine data in an IT infrastructure. The system monitor transmits ingested data to LogRhythm XDR
where a web-based dashboard displays any identified cyber threats. This project deploys LogRhythm’s
System Monitor Agents on end points in each identified VLAN.

Install the LogRhythm System Monitor Agent on one of the end points (e.g., Clinical Workstation) in the
HDO environment so that the LogRhythm XDR can monitor the logs, such as syslog and eventlog, of this
workstation.

System Monitor Agent Installation
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This section describes installation of the system monitor agent.

Download Installation Packages

1.

2.

7.

8.

Using a Clinical Workstation, open a web browser.

Navigate to https://community.logrhythm.com.

Log in using the credentials made when installing and configuring LogRhythm XDR.

Navigate to LogRhythm Community.

Click Documents & Downloads.
Click SysMon.

Click SysMon - 7.4.10.

Click Windows System Monitor Agents and save to the Downloads folder on the Workstation.

Install System Monitor Agent

1.

2.

On the Workstation, navigate to Downloads folder.

Click LRWindowsSystemMonitorAgents.

Click LRSystemMonitor_64_7.

On the Welcome page, follow the Wizard, and click Next...

jﬂ LogRhythm System Monitor Service

:*LogRhythmr

s

Welcome to the Install Wizard for LogRhythm
System Monitor Service

The Install Wizard will allow you to modify or repair LogRhythm
System Monitor Service. To continue, dick Mext.
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1193 5. Onthe ready to begin installation page, click Install.

#2 LogRhythm System Monitor Service b

Ready to Upgrade LogRhythm System Monitor Service
The wizard is ready to begin installation.

Click Install to begin the installation.

Instalshield
< Badk Cancel
1194 6. Click Finish.
12 LogRhythm System Monitor Service X

Install Wizard Completed

:*LogRhythmr
The Install Wizard has successfully installed LogRthythm System
Manitor Service, Clids Finish to exit the wizard.

Launch System Monitor Configuration Manager

1195 System Monitor Agent Configuration

1196 1. After exiting the LogRhythm System Monitor Service Install Wizard, a LogRhythm System
1197 Monitor Local Configuration window displays. Under the General tab, provide the following
1198 information:
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1199 a. Data Process Address: 192.168.45.20

1200 b. System Monitor IP Address/Index: 192.168.45.20

1201 2. Click Apply.

+2% LogRhythm System Monitor Local Config...

General  Windows Service  Log File

System Monitor Agent

Specify the System Monitor Agent configuration settings

Data Processor Connection Settings
Diata Processor Address

Port
192.168.45.20

|443 =

System Monitor IP Address / Index

Port
192.168.45.20

| 3333 =

Host Entity |10 (Zero for system assigned 10}
0 =

-

Systemn Manitor High Availability (HA Only) Folders

For High Awailability (HA) deployments, the Configuration and State paths can be
modified from their default locations.

WARNING: Changing these values could impact your deployment. Ensure you
understand the impacts before making changes.

Corfiguration File Parent Directony

|C:"-.F‘n:|g|am Files*LogRhythm*LogRhythm System Monitar®, |

State File Parent Directory

|C:"-.F‘n:|g|am Files*LogRhythm*LogRhythm System Monitar®, |

QK Cancel Apphy

1202 3. Click the Windows Service tab.

1203 4. Change the Service Type to Automatic.

1204 5. Click Apply.
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a3t LogRhythm System Monitor Local Config... O X

General Windows Service  Log File

Windows Service

Specify the Windows Service configuration settings.

LogRhythm System Monitor Service

Startup Type
|;’-‘-.|.rh:|mati|: w

Start Service Status:  Stopped

Log On
(® Local System Accourt
() This Account:  LocalSystem

Password:
QK Cancel Apply
1205 6. Click the Log File tab.
1206 7. Click Refresh to ensure NetworkXDR log collection.
1207 8. Click OK to exit the Local Configuration Manager.
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+¢+ LogRhythm System Monitor Local Config... O =

General Windows Service Log File

File Location: Refresh
C:MProgram Files“LogRhythm*LogRhythm System Monitor'Logs*scsm log

0K Cancel Apphy

Add Workstation for System Monitor

Engineers added Clinical Workstation for System Monitor and Set Its Message Source Types in the
LogRhythm Deployment Manager.

1. Login to the LogRhythm Console.
a. User ID: LogRhythmAdmin

b Password. k 3k sk ok sk sk k k ok ok
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EMDB Server:

Database:

UserlD:

Password:

192 168 45.20

\LogRhythmEMDB

[ Login with Windows account

LogRhythmAdmin

[] Encrypt all communications
[ Login automatically next time

:*LogRhythmr

Cancel

2. Navigate to the Deployment Manager in the menu ribbon.

3. Under the Entity tab on the Deployment Manager menu ribbon.

4. Click New to open the Host pop-up window, and enter the following under the Basic

Information tab:

a. Name: ClinicalWS

b. Host Zone: Internal
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a Host

Mame

Basic Information  |dertifiers  Host Roles

X

Threat Level Additional Information

|Clinical W5

Host fone

Operating System

|"Mndaws

Host Location

® Intemal O DMZ O EBdemal

Operating System Yersion

Windows 10 e

Brief Description

Host Risk Level

|u None o risk)

Windows Event Log Credentials

[] Use specified credentials

Usemame ([domain‘wusemame)

Fasgword

Confirm Password

Cancel

5. Navigate to the Identifiers tab, provide the following information in the appropriate fields, and

click Add.

a. IP Address: 192.168.44.251

b. Windows Name: clinicalws (Windows Name)
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B Host

Basic Information  |dentfiers  Host Roles

Threat Level Additional Information

IP Address

192.168.44.251 | Add
DMNS Mame

| [
Windows Name
|dinicalw5 (Windows Name)| | Add
Identifiers

clinicalws (Windows Name)

152 168 44 251

Delete

Cancel

6. Add the Clinical WS as a new system monitor agent by navigating to the System Monitors tab,
right-clicking in the empty space, and selecting New.

7. Inthe System Monitor Agent Properties window, click the button next to Host Agent is Installed

on, and select Primary Site: ClinicalWS.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem

136



1228

1229

1230
1231

1232
1233

1234

1235

DRAFT

10.

11.

12.

13.

+33 LogRhythm Console - [Deployment Manager] - O 'S
£ File Edit View My LogRhythm Tools Window Help -8 X

@ © | @ | & PersonalDashboard 4 Investigate ' Tail | @ ReportCenter | S| ListManager | ®g Deployment Moniter © Deployment Manager

Entity Platform Manager Data Processors Al Engine  Metwork Monitors ~ System Monitors  |og Sources  Log Processing Policies  Alarm Rules  People  Third Party Applications
||New System Monitor Agents el |

Drag a column header here to group by that column

Action Status Host Operating System Host IP Address Resolved Known Host Agent Hame V:E;"u‘n Agent GUID

O] £, System Monitor Agent Properties ] X @ =

ude Retied Clear

Filter by I: Agent Settings  Data Processor Settings  Syslog and Flow Settings  SNMP Trap Receiver Endpoint Monitoring  Additional Information
er

Host Agent is Installed on
Primary Site : Clinical WS
System Monitor Agent Name

Drag a column header he

Action Hast Entity ‘ rdStatus DatelUpdated LicenseType
I - = o
O Primary Site | Corfiguration Palicy - SO 38 Sysiem Maritar.

» No Palicy i " :Syslem Monitor}

Host 05 Type

@ Windows (O L O Solais O AIX (O HP-UX

04 days | 00100 (& Heartbeat Waming Interval. Value between 1 minute and 30 days.

< >
Showing 2of 2 Aheartbeat has yet to ocour.
Service Requests

Search For  Alarm

—
- i - - “

Go to System Monitors.

Double-click ClinicalWS.

Under LogSource of the System Monitor Agent Property window, right-click in the empty space,
and select New. The Log Message Source Property window will open.

Under the Log Message Source Property window, click the button associated with Log Message
Source Type. It will open the Log Source Selector window.

In the text box to the right of the Log Source Selector window, type XML, and click Apply.

Select the Log Source Type and click OK.
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EX System Monitor Agent Properties x
~ WV g P Agent
Agent Settings  Data Processor Settings  Syslog and Flow Settings  SNMP Trap Receiver  Endpoint Monitoring ~ Additional Information
Host Agent is Installed on
Clinical WS 3
System Monitor Agert Name
[cinicaiws Log Message Source Properties X
Configuration Poli
| guratien Falcy Basic Configuration  Additional Settings  Log Source Vitualization  Flat File Settings  UDLA Settings  Additional Info
No Policy
Host 05 T Log Source Host
° Pe Clinical'W's
H Windows Linuoe Solaris
Collection Agent 05 Type.
e days [001:00 |2 HeatbeatVW [CinicalWs |
b Log Message Source Type
™ The last heartbeat occumed on Saturday, Septeml ‘ ‘
Br
Log Message Source Name
4 ‘ 18+ Log Source Type Selector ] s
Filter by ‘ | ‘ Brief Description File Edit
Record Type Filter Text Filter
IDragacnIumn header here to group by that * Al tems — WML |
Action Log Entity Log H 5 fustem
[m] [=] Log Message Processing Settings i, System UEiEmei e
Log Message Processing Mode ® Keyword O Regex Clear
O Frimary Site Clinical\w's ‘ MPE Processing Enabled. Event Forwarding Enabled
O Frimany Site Cliniel\/s Log Message Frocessing Engine (MPE) Folicy ng SEIEE IEE
O Primary Site Clinicalws ‘(No Policy Assigned> %,System MS Windows Event Logging XML - Applicat. )
O Primary Site ClinicalWs o1, System : MS Windows Event Logging XML - Forward
| Primary Site Clinicalws Forward Logs to LogRhythm LogMart %‘System MS Windows Event Logging XML - Generic
O] Primary Site Clinicaivis %‘System S Windows Evert Logging XML - LR Tracer
O Frimary Site Climicaiinis %‘System MS Windows Event Logging XML - Microso...
e - a s Advanced 1, System : MS Windows Event Logging XML - Security
[ nimary sie mes! 2 System : MS Windows Event Logging XML - Sysmon
;%,‘System MS Windows Event Logging XML - Sysmon...
E.,System MS Windows Event Logging XML - System
< ;%,‘System MS Windows Event Loaging XML - Unisys
Showing G of 9 g%.‘System Syslog - MS Windows Event Logging XML -...
2 System - Syslog - MS Windows Event Logging XML -
2, System : Syslog - MS Windows Event Logaing XML ... v
3 ot
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AD

CPU
DHCP
DNS
FMC
FTD

URL
vCPU
VLAN
VM
XDR

Active Directory

Central Processing Unit

Dynamic Host Configuration Protocol

Domain Name Service

Firepower Management Center

Firepower Threat Defense

Gigabyte

Healthcare Delivery Organization

Internet Protocol

International Organization for Standardization
Information Technology

Network Address Translation

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
Open Virtual Appliance or Application

Picture Archiving and Communication System
Random Access Memory

Remote Patient Monitoring

Stealthwatch Flow Collector

Security Incident Event Management
Stealthwatch Management Center

Special Publication

Terabyte

Uniform Resource Locator

Virtual Central Processing Unit

Virtual Local Area Network

Virtual Machine

Extended Detection and Response

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem

139



DRAFT

1237

1238 [1] J. Cawthra et al., Securing Picture Archiving and Communication System (PACS), National

1239 Institute of Standards and Technology (NIST) Special Publication (SP) 1800-24, NIST,

1240 Gaithersburg, Md., Sep. 2019. Available:

1241 https://www.nccoe.nist.gov/sites/default/files/library/sp1800/hit-pacs-nist-sp1800-24-

1242 draft.pdf.

1243 [2] Framework for Improving Critical Infrastructure Cybersecurity, Version 1.1, NIST, Gaithersburg,
1244 Md., Apr. 16, 2018. Available:

1245 https://nvipubs.nist.gov/nistpubs/CSWP/NIST.CSWP.04162018.pdf.

1246 [3] Tenable. Managed by Tenable.sc. [Online]. Available:
1247 https://docs.tenable.com/nessus/8 10/Content/ManagedbyTenablesc.htm.

1248 [4] Microsoft. “Install Active Directory Domain Services (Level 100). [Online]. Available:
1249 https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/install-active-
1250 directory-domain-services--level-100-#to-install-ad-ds-by-using-server-manager.

1251 [5] Cisco. Cisco Firepower Management Center Virtual Getting Started Guide. [Online]. Available:
1252 https://www.cisco.com/c/en/us/td/docs/security/firepower/quick start/fmcv/fpmc-
1253 virtual/fpmc-virtual-vmware.html.

1254  [6] Cisco. Cisco Firepower Threat Defense Virtual for VMware Getting Started Guide: Deploy the

1255 Firepower Threat Defense Virtual. [Online]. Available:
1256 https://www.cisco.com/c/en/us/td/docs/security/firepower/quick start/vmware/ftdv/ftdv-
1257 vmware-gsg/ftdv-vmware-deploy.html.

1258 [7] Cisco. Cisco Firepower Threat Defense Virtual for VMware Getting Started Guide: Managing the

1259 Firepower Threat Defense Virtual with the Firepower Management Center. [Online]. Available:
1260 https://www.cisco.com/c/en/us/td/docs/security/firepower/quick start/vmware/ftdv/ftdv-
1261 vmware-gsg/ftdv-vmware-fmc.html.

1262 [8] Cisco. Cisco Stealthwatch Installation and Configuration Guide 7.1. [Online]. Available:
1263 https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system installation config
1264 uration/SW 7 1 Installation and Configuration Guide DV 1 0.pdf.

1265 [9] Cisco. Deploy VAs in VMware. [Online]. Available: https://docs.umbrella.com/deployment-
1266 umbrella/docs/deploy-vas-in-vmware.

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 140


https://www.nccoe.nist.gov/sites/default/files/library/sp1800/hit-pacs-nist-sp1800-24-draft.pdf
https://www.nccoe.nist.gov/sites/default/files/library/sp1800/hit-pacs-nist-sp1800-24-draft.pdf
https://nvlpubs.nist.gov/nistpubs/CSWP/NIST.CSWP.04162018.pdf
https://docs.tenable.com/nessus/8_10/Content/ManagedbyTenablesc.htm
https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/install-active-directory-domain-services--level-100-#to-install-ad-ds-by-using-server-manager
https://docs.microsoft.com/en-us/windows-server/identity/ad-ds/deploy/install-active-directory-domain-services--level-100-#to-install-ad-ds-by-using-server-manager
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/fmcv/fpmc-virtual/fpmc-virtual-vmware.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/fmcv/fpmc-virtual/fpmc-virtual-vmware.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/vmware/ftdv/ftdv-vmware-gsg/ftdv-vmware-deploy.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/vmware/ftdv/ftdv-vmware-gsg/ftdv-vmware-deploy.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/vmware/ftdv/ftdv-vmware-gsg/ftdv-vmware-fmc.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/quick_start/vmware/ftdv/ftdv-vmware-gsg/ftdv-vmware-fmc.html
https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system_installation_configuration/SW_7_1_Installation_and_Configuration_Guide_DV_1_0.pdf
https://www.cisco.com/c/dam/en/us/td/docs/security/stealthwatch/system_installation_configuration/SW_7_1_Installation_and_Configuration_Guide_DV_1_0.pdf
https://docs.umbrella.com/deployment-umbrella/docs/deploy-vas-in-vmware
https://docs.umbrella.com/deployment-umbrella/docs/deploy-vas-in-vmware

	rpm-nist-sp1800-30-covers-draft
	rpm-nist-sp1800-30a-draft
	rpm-nist-sp1800-30-covers-draft
	rpm-nist-sp1800-30a-draft
	Executive Summary
	WHY WE WROTE THIS GUIDE
	CHALLENGE
	SOLUTION
	HOW TO USE THIS GUIDE
	SHARE YOUR FEEDBACK
	COLLABORATORS


	rpm-nist-sp1800-30b-draft
	rpm-nist-sp1800-30-covers-draft
	rpm-nist-sp1800-30b-draft
	1 Summary
	1.1 Challenge
	1.2 Solution
	1.3 Benefits

	2 How to Use This Guide
	2.1 Typographic Conventions

	3 Approach
	3.1 Audience
	3.2 Scope
	3.3 Assumptions
	3.4 Risk Assessment
	3.4.1 Threats 
	3.4.2 Vulnerabilities
	3.4.3 Problematic Data Actions for Privacy
	3.4.4 Risk
	3.4.5  Mitigating Risk

	3.5 Security Control Map
	3.6 Technologies

	4 Architecture
	4.1 Layering the Architecture
	4.2 High-Level Architecture Communications Pathways
	4.2.1 Cellular Data Pathways
	4.2.2 Broadband Pathways

	4.3 Data and Process Flows
	4.4 Security Capabilities
	4.4.1 Telehealth Platform Provider
	4.4.2 Risk Assessment Controls
	4.4.3 Identity Management, Authentication, and Access Control
	4.4.4 Data Security
	4.4.5 Anomalies and Events and Security Continuous Monitoring

	4.5 Final Architecture

	5 Security and Privacy Characteristic Analysis
	5.1 Assumptions and Limitations
	5.2 Pervasive Controls
	5.3 Telehealth Platform Providers
	5.4 Risk Assessment (ID.RA and ID.RA-P)
	5.5 Identity Management, Authentication, and Access Control (PR.AC and PR.AC-P) Protective Technology (PR.PT-P)
	5.6 Data Security (PR.DS and PR.DS-P)
	5.7 Anomalies and Events, Security Continuous Monitoring (DE.AE, DE.CM) and Data Processing Management (CT.DM-P)

	6 Functional Evaluation
	6.1 RPM Functional Test Plan
	6.1.1 RPM Functional Evaluation
	6.1.2 Test Case: RPM-1
	6.1.3 Test Case: RPM-2
	6.1.4 Test Case: RPM-3
	6.1.5 Test Case: RPM-4
	6.1.6 Test Case: RPM-5
	6.1.7 Test Case: RPM-6
	6.1.8 Test Case: RPM-7
	6.1.9 Test Case: RPM-8
	6.1.10 Test Case: RPM-9


	7 Future Build Considerations
	Appendix A List of Acronyms
	Appendix B References
	Appendix C Threats and Risks 
	C-1 Discussion on the Risk Management Framework
	C-2 Information and Information System Categorization
	C-3 Risk Context
	C-4 Threats
	C-5 Threat Sources
	C-5.1 Business Processes

	C-6 Vulnerabilities
	C-7 Threat Modeling
	C-7.1 Modeling Threats to the Patient Home
	C-7.2 Linking Threats to Adverse Actions
	Appendix D Problematic Data Actions and Risks


	D-1 Privacy Risk Assessment Methodology (PRAM)
	D-2 Problematic Data Actions and Mitigations
	D-2.1 Privacy Risk 1: Unauthorized individuals may access data on devices
	D-2.2 Privacy Risk 2: Biometric device types can indicate patient health problems that individuals would prefer not to disclose beyond their healthcare provider
	D-2.3 Privacy Risk 3: Incorrect data capture of readings by devices may impact quality of patient care
	D-2.4 Privacy Risk 4: Aggregated data may expose patient information 
	D-2.5 Privacy Risk 5: Exposure of patient information through multiple providers of system components

	D-3 Mitigations Applicable Across Various Data Actions
	Appendix E Appendix E Future Consideration: Applying Micro-Segmentation Solutions for RPM Solutions  


	Word Bookmarks
	RTF5f546f633432343535363830
	Access_DLD_Policy_Manager
	ref9



	rpm-nist-sp1800-30c-draft
	rpm-nist-sp1800-30-covers-draft
	rpm-nist-sp1800-30c-draft
	1 Introduction
	1.1 How to Use this Guide
	1.2 Build Overview
	1.3 Typographic Conventions
	1.4 Logical Architecture Summary

	2 Product Installation Guides
	2.1 Telehealth Platform Provider
	2.1.1 Accuhealth
	2.1.1.1 Patient
	2.1.1.2 HDO

	2.1.2 Vivify Health
	2.1.2.1 Patient
	2.1.2.2 HDO


	2.2 Security Capabilities
	2.2.1 Risk Assessment Controls
	2.2.1.1 Tenable.sc
	2.2.1.2 Nessus

	2.2.2 Identity Management, Authentication, and Access Control
	2.2.2.1 Domain Controller
	2.2.2.2 Cisco Firepower

	2.2.3 Security Continuous Monitoring
	2.2.3.1 Cisco Stealthwatch
	2.2.3.2 Cisco Umbrella
	2.2.3.3 LogRhythm XDR (Extended Detection and Response)
	2.2.3.4 LogRhythm NetworkXDR
	2.2.3.5 LogRhythm System Monitor Agent
	Appendix A List of Acronyms
	Appendix B References




	Word Bookmarks
	RTF5f546f633432343535363830






